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About This Manual

Conventions

This manual contains information about the purpose of control design and
the control design process. This manual also describes how to develop a
control design system using the LabVIEW Control Design and Simulation
Module.

This manual requires that you have a basic understanding of the LabVIEW
environment. If you are unfamiliar with LabVIEW, refer to the Getting
Started with LabVIEW manual before reading this manual.

This manual refers to control design and deployment concepts only. For
information about using the Control Design and Simulation Module to
simulate the behavior of dynamic systems, refer to the LabVIEW Help,
available by selecting Help»Search the LabVIEW Help.

»

@

=

5

bold
italic

monospace

The following conventions appear in this manual:

The » symbol leads you through nested menu items and dialog box options
to a final action. The sequence File»Page Setup»Options directs you to
pull down the File menu, select the Page Setup item, and select Options
from the last dialog box.

This icon denotes a tip, which alerts you to advisory information.
This icon denotes a note, which alerts you to important information.

Bold text denotes items that you must select or click in the software, such
as menu items and dialog box options. Bold text also denotes parameter
names.

Italic text denotes variables, emphasis, a cross-reference, or an introduction
to a key concept. Italic text also denotes text that is a placeholder for a word
or value that you must supply.

Text in this font denotes text or characters that you should enter from the
keyboard, sections of code, programming examples, and syntax examples.
This font is also used for the proper names of disk drives, paths, directories,
programs, subprograms, subroutines, device names, functions, operations,
variables, filenames, and extensions.
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monospace bold

Bold text in this font denotes the messages and responses that the computer
automatically prints to the screen. This font also emphasizes lines of code
that are different from the other examples.

Related Documentation

The following documents contain information that you might find helpful
as you use the Control Design and Simulation Module.

LabVIEW Help, available by selecting Help»Search the LabVIEW
Help

LabVIEW Real-Time Module documentation
LabVIEW PID Control Toolkit User Manual

Example VIs, located in the 1abview\examples\Control Design
and Simulation directory. You also can access these VIs by
selecting Help»Find Examples and selecting Toolkits and Modules»
Control and Simulation in the NI Example Finder window.

@ Note The following resources offer useful background information on the general
concepts discussed in this documentation. These resources are provided for general
informational purposes only and are not affiliated, sponsored, or endorsed by National
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Introduction to Control Design

Control design is a process that involves developing mathematical models
that describe a physical system, analyzing the models to learn about their
dynamic characteristics, and creating a controller to achieve certain
dynamic characteristics. Control systems contain components that direct,
command, and regulate the physical system, also known as the plant. In this
manual, the control system refers to the sensors, the controller, and the
actuators. The reference input refers to a condition of the system that you
specify.

The dynamic system, shown in Figure 1-1, refers to the combination of the
control system and the plant.

Control System

Reference
4>®—> Controller > Actuators

Physical System
o (Plant)

Sensors <

Figure 1-1. Dynamic System

The dynamic system in Figure 1-1 represents a closed-loop system, also
known as a feedback system. In closed-loop systems, the control system
monitors the outputs of the plant and adjusts the inputs to the plant to make
the actual response closer to the input that you designate.

One example of a closed-loop system is a system that regulates room
temperature. In this example, the reference input is the temperature at
which you want the room to stay. The thermometer senses the actual
temperature of the room. Based on the reference input, the thermostat
activates the heater or the air conditioner. In this example, the room is the
plant, the thermometer is the sensor, the thermostat is the controller, and the
heater or air conditioner is the actuator.
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Chapter 1 Introduction to Control Design

Other common examples of control systems include the following
applications:

*  Automobile cruise control systems

e Robots in manufacturing

e Refrigerator temperature control systems

e Hard drive head control systems

This chapter provides an overview of model-based control design and

describes how you can use the LabVIEW Control Design and Simulation
Module to design a controller.

Model-Based Control Design
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Model-based control design involves the following four phases:
developing and analyzing a model to describe a plant, designing and
analyzing a controller for the dynamic system, simulating the dynamic
system, and deploying the controller. Because model-based control design
involves many iterations, you might need to repeat one or more of these
phases before the design is complete. Figure 1-2 shows how National
Instruments provides solutions for each of these phases.

Plant Modeling Control Design Deployment
and Analysis and Simulation
LabVIEW System |qp LabVIEW <> LabVIEW
Identification Control Design and Real-Time
Toolkit Simulation Module Module
LabVIEW

Figure 1-2. Using LabVIEW in Model-Based Control Design

National Instruments also provides products for I/O and signal
conditioning that you can use to gather and process data. Using these tools,
which are built on the LabVIEW platform, you can experiment with
different approaches at each phase in model-based control design and
quickly identify the optimal design solution for a control system.
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Chapter 1 Introduction to Control Design

Developing a Plant Model

The first phase of model-based control design involves developing and
analyzing a mathematical model of the plant you want to control. You can
use a process called system identification to obtain and analyze this model.
The system identification process involves acquiring data from a plant and
then numerically analyzing stimulus and response data to estimate the
parameters and order of the model.

The system identification process requires a combination of the following
components:

»  Signal generation and data acquisition—National Instruments
provides software and hardware that you can use to stimulate and
measure the response of the plant.

e Mathematical tools to model a dynamic system—The LabVIEW
System Identification Toolkit contains VIs to help you estimate and
create accurate mathematical models of dynamic systems. You can use
this toolkit to create discrete linear models of systems based on
measured stimulus and response data.

@ Note This manual does not provide a comprehensive discussion of system identification.
Refer to the resources listed in the Related Documentation section of this manual for more
information about developing a plant model.

Designing a Controller

The second phase of model-based control design involves two steps.
The first step is analyzing the plant model obtained during the system
identification process. The second step is designing a controller based on
that analysis. You can use the Control Design VIs and tools to complete
these steps. These VIs and tools use both classical and state-space
techniques.

Figure 1-3 shows the typical steps involved in designing a controller.

Determine
Specifications

Create Analyze Synthesize
» Mathematical i q y
Model System Controller

Figure 1-3. Control Design Process
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You often iterate these steps to achieve an acceptable design that is
physically realizable and meets specific performance criteria.

Simulating the Dynamic System

The third phase of model-based control design involves validating the
controller design obtained in the previous phase. You perform this
validation by simulating the dynamic system. For example, simulating a jet
engine saves time, labor, and money compared to building and testing an
actual jet engine.

You can use the Control Design and Simulation Module to simulate linear
time-invariant systems. This module also provides a variety of numerical
integration schemes for simulating more elaborate systems, such as
nonlinear systems. You also can use this module to determine how a system
responds to complex, time-varying inputs.

Deploying the Controller

The fourth phase of model-based control design involves deploying the
controller to a real-time (RT) target. LabVIEW and the LabVIEW
Real-Time Module provide a common platform that you can use to
implement the control system.

Refer to the National Instruments Web site at ni . com for information about
the National Instruments products mentioned in this section.

Overview of LabVIEW Control Design

The Control Design and Simulation Module provides an interactive
Control Design Assistant, a library of VIs, and a library of MathScript
functions for designing a controller based on a model of a plant. You can
use all these tools to complete the entire control design process from
creating a model of the controller to synthesizing the controller on an
RT target.

Control Design Assistant
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You can use the Control Design Assistant to synthesize and analyze a
controller for a user-defined model without knowing how to program in
LabVIEW. You access the Control Design Assistant through the LabVIEW
SignalExpress environment. LabVIEW SignalExpress is a framework that
can host multiple interactive National Instruments tools and assistants.
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Chapter 1 Introduction to Control Design

You also can use the Control Design Assistant to create a project. In one
project, you can load or create a model of a plant into the Control Design
Assistant, analyze the time or frequency response, and then calculate the
controller parameters. With the Control Design Assistant, you immediately
can see the mathematical equation and graphical representation that
describe the model. You also can view the response data and the
configuration of the controller.

Using the Control Design Assistant, you can convert a project to a
LabVIEW block diagram and customize that block diagram in LabVIEW.
You then can use LabVIEW to enhance and extend the capabilities of the
application. Refer to the LabVIEW SignalExpress Help for more
information about using the Control Design Assistant to analyze models
that describe a physical system and design controllers to achieve specified
dynamic characteristics.

Control Design Vls

The Control Design and Simulation Module also provides VIs that you can
use to create and develop control design applications in LabVIEW. You
can use these VIs to develop mathematical models of a dynamic system,
analyze the models to learn about their dynamic characteristics, and create
controllers to achieve specified dynamic characteristics. You use these VIs
to customize a LabVIEW block diagram to achieve specific goals. You also
can use other LabVIEW VIs and functions to enhance the functionality of
the application. Refer to the LabVIEW Help, available by selecting Help»
Search the LabVIEW Help, for information about the Control Design
VIs.

Unlike creating a project with the Control Design Assistant, creating a
LabVIEW application using the Control Design VIs requires basic
knowledge about programming in LabVIEW. Refer to the LabVIEW Help
for more information about the LabVIEW programming environment.

Control Design MathScript Functions

The Control Design and Simulation Module also includes numerous
functions that extend the functionality of the LabVIEW MathScript
window. Use these functions to design and analyze controller models in a
text-based environment. You generally can use the LabVIEW MathScript
engine to execute scripts you have previously written using The
MathWorks, Inc. MATLAB® application software. However, the
MathScript engine is not intended to support all functions supported by the
MATLAB application software.
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Constructing Dynamic System
Models

Model-based control design relies upon the concept of a dynamic system
model. A dynamic system model is a mathematical representation of the
dynamics between the inputs and outputs of a dynamic system. You
generally represent dynamic system models with differential equations or
difference equations.

Obtaining a model of the dynamic system you want to control is the first
step in model-based control design. You analyze this model to anticipate
the outputs of the model when given a set of inputs. Using this analysis, you
then can design a controller that affects the outputs of the dynamic system
in a manner that you specify.

For example, consider the temperature-regulation example in the
introduction of Chapter 1, Introduction to Control Design. You can analyze
the open-loop dynamics of the plant to design an effective controller for this
closed-loop dynamic system. A model for this closed-loop dynamic system
describes the input to the plant as the air flow from the vent. The output of
the plant is the temperature of the room. By analyzing the relationship
between the inputs and output of the plant, you can predict how the plant
reacts when given certain inputs. Based on this analysis, you then can
design a controller for this dynamic system.

This chapter provides information about using the LabVIEW Control
Design and Simulation Module to create dynamic system models. This
chapter also describes the different forms that you can use to represent a
dynamic system model.

@ Note Refer to the labview\examples\Control and Simulation\Control
Design\Model Construction directory for example VIs that demonstrate the concepts
explained in this chapter.
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Constructing Accurate Models
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To create a model of a system, think of the system as a black box that
continuously accepts inputs and continuously generates outputs. Figure 2-1
shows the basic black-box model of a dynamic system.

Input —»>| H(s) ——» Output

Figure 2-1. Black-Box Model of a Dynamic System

You refer to this model as a black-box model because you often do not
know the relationship between the inputs and outputs of a dynamic system.
The model you create, therefore, has errors that you must account for when
designing a controller.

An accurate model perfectly describes the dynamic system that it
represents. Real-world dynamic systems, however, are subject to a variety
of non-deterministic fluctuating conditions and interacting components
that prevent you from making a perfect model. You must consider many
external factors, such as random interactions and parameter variations. You
also must consider internal interacting structures and their fundamental
descriptions.

Because designing a perfectly accurate model is impossible, you must
design a controller that accounts for these inaccuracies. A robust controller
is one that functions as expected despite some differences between the
dynamic system and the model of the dynamic system. A controller that is
not robust might fail when such differences are present.

The more accurate a model is, the more complex the mathematical
relationship between inputs and outputs. At times, however, increasing the
complexity of the model does not provide any more benefits. For example,
if you want to control the interacting forces and friction of a mechanical
dynamic system, you might not need to include the thermodynamic effects
of the system. These effects are complicated features of the system that do
not affect the friction enough to impact the robustness of the controller.

A model that incorporates these effects can become unnecessarily
complicated.
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Chapter 2 Constructing Dynamic System Models

Model Representation

You can represent a dynamic system using several types of dynamic system
models. You also can represent each type of dynamic system model using
three different forms. The following sections provide information about the
different types and forms of dynamic system models that you can construct
with the Control Design and Simulation Module.

Model Types

You base the type of dynamic system model on the properties of the
dynamic system that the model represents. The following sections provide
information about the different types of models you can create with the
Control Design and Simulation Module.

Linear versus Nonlinear Models

Dynamic system models are either linear or nonlinear. A linear model
obeys the principle of superposition. The following equations are true for
linear models.

1 =fxp)
Y2 = fxp)
Y=f(x+x)=y,+¥

Conversely, nonlinear models do not obey the principle of superposition.
Nonlinear effects in real-world systems include saturation, dead-zone,
friction, backlash, and quantization effects; relays; switches; and rate
limiters. Many real-world systems are nonlinear, though you can linearize
the model to simplify a design or analysis procedure. You can use the
Trim & Linearize VIs to perform this linearization task.

The Control Design and Simulation Module supports both linear and
nonlinear models.
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Time-Variant versus Time-Invariant Models

Dynamic system models are either time-variant or time-invariant. The
parameters of a time-variant model change with time. For example, you can
use a time-variant model to describe the mass of an automobile. As fuel
burns, the mass of the vehicle changes with time.

Conversely, the parameters of a time-invariant model do not change with
time. For an example of a time-invariant model, consider a simple robot.
Generally, the dynamic characteristics of robots do not change over short
periods of time.

The Control Design and Simulation Module supports time-invariant
models only.

Continuous versus Discrete Models

Dynamic system models are either continuous or discrete. Both continuous
and discrete system models can be linear or nonlinear and time-invariant or
time-variant. Continuous models describe how the behavior of a system
varies continuously with time, which means you can obtain the properties
of a system at any certain moment from the continuous model. Discrete
models describe the behavior of a system at separate time instants, which
means you cannot obtain the behavior of the system between any two
sampling points.

Continuous system models are analog. You derive continuous models of a
physical system from differential equations of the system. The coefficients
of continuous models have clear physical meanings. For example, you can
derive the continuous transfer function of a resistor-capacitor (RC) circuit
if you know the details of the circuit. The coefficients of the continuous
transfer function are the functions of R and C in the circuit. You use
continuous models if you need to match the coefficients of a model to some
physical components in the system.

Discrete system models are digital. You derive discrete models of a
physical system from difference equations or by converting continuous
models to discrete models. In computer-based applications, signals and
operations are digital. Therefore, you can use discrete models to implement
a digital controller or to simulate the behavior of a physical system at
discrete instants. You also can use discrete models in the accurate
model-based design of a discrete controller for a plant.

The Control Design and Simulation Module supports continuous and
discrete models.
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Chapter 2

Constructing Dynamic System Models

You can use the Control Design and Simulation Module to represent
dynamic system models in the following three forms: transfer function,
zero-pole-gain, and state-space. Refer to the Constructing Transfer
Function Models section, the Constructing Zero-Pole-Gain Models
section, and the Constructing State-Space Models section of this chapter
for information about creating and manipulating these system models.

Table 2-1 shows the equations for the different forms of dynamic system

models.

Table 2-1. Definitions of Continuous and Discrete Systems

Model
Form Continuous Discrete
Transfer m—1 m m—1 m
Function H(s) =b0+b1s+...+bm_1s 1+bms Hz) =b0+blz+...+bm_lz 1+bmz
ag+ays+..+a, s +a,s" ag+az+...+a, z'  +a,z"
n= ] n= ]
Zero-Pole-
Gain Hs) = k(s—z)(s—2zy)...(s—z,) H(z) = k(z=z\)(z-2zy)...(z-2z,,)

C (s=p)(s=py)..(s—p,)

#=

~ (z-p)(E-py)..(z-p,)

#=

State-Space

X = Ax+ Bu
Cx + Du

~
Il

x(k+1) = Ax(k) + Bu(k)
y(k) = Cx(k) + Du(k)

5

Note Continuous transfer function and zero-pole-gain models use the s variable to define
time, whereas discrete models in these forms use the z variable. Continuous state-space

models use the ¢ variable to define time, whereas discrete state-space models use the
k variable.
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You can use these forms to describe single-input single-output (SISO),
single-input multiple-output (SIMO), multiple-input single-output

(MISO), and multiple-input multiple-output (MIMO) systems. The number
of sensors and actuators determines whether a dynamic system is a SISO,
SIMO, MISO, or MIMO system.
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Chapter 2 Constructing Dynamic System Models

The following sections provide information about an example dynamic
system and how to represent this dynamic system using all three model
forms.

RLC Circuit Example

Figure 2-2 shows an example circuit consisting of a resistor R, an inductor
L, a current i(t), a capacitor C, a capacitor voltage v.(f), and an input
voltage v(1).

vi(t) C_’) c velt)

Figure 2-2. RLC Circuit

The following sections use this example to illustrate the creation of three
forms of dynamic system models.

Constructing Transfer Function Models

Transfer function models use polynomial functions to define the dynamic
relationship between inputs and outputs of a system. You analyze transfer
function models in the frequency domain. The following equations define
continuous and discrete transfer function models.

Continuous Transfer Function Model

m—1 m
H(s) = numerator(s) _ by+bis+...+b, s +b,s
denominator (s) ap+as+ ...+an71sn_1+ansn
Discrete Transfer Function Model
m—1 m
H(z) = numerator(z)  _ by+byz+...+b, 1z +b,z
denominator(z) g 41 qz4+ .. +a, 2 +a,;"
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Chapter 2 Constructing Dynamic System Models

Numerators of transfer function models describe the locations of the zeros
of the system. Denominators of transfer function models describe the
locations of the poles of the system.

Use the CD Construct Transfer Function Model VI to create continuous
SISO, SIMO, MISO, and MIMO system models in transfer function form.
This VI creates a data structure that defines the transfer function model and
contains additional information about the system, such as the sampling
time, input or output delays, and input and output names. Refer to the
Obtaining Model Information section of this chapter for information about
other properties of transfer function models.

SISO Transfer Function Models

Using the example in the RLC Circuit Example section of this chapter, you
can describe the voltage of the capacitor v, using the following second
order differential equation:

LCV.+RCV. +v, = v;
After taking the Laplace transform and rearranging terms, you then can

write the transfer function between the input voltage V; and the capacitor
voltage V. using the following equation.

1
V) IC e
Vi) 2 Rs, L

L LC

You then can use H(s) to study the dynamic properties of the RLC circuit.
The following equation defines a continuous transfer function where
R=20Q,L=50mH, and C =10 uF.

2% 10°

H(s) = :
s”+400s +2x 10
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Chapter 2 Constructing Dynamic System Models

Figure 2-3 shows how you use the CD Construct Transfer Function Model
VI to create this continuous transfer function model.

[c0 Construct Transfer Function Model vi] - [Transfer Function Modsl
0 [eeve = ezl
G(+)
5]

0 ZE+& 1400 1

Figure 2-3. Creating a Continuous Transfer Function Model

The Numerator and Denominator inputs are arrays with zero-based
indexes. The i element of the array corresponds to the i order coefficient
of the polynomial. You define the coefficients in ascending order.

@ Note The CD Construct Transfer Function Model VI does not automatically cancel
polynomial roots appearing in both the numerator and the denominator of the transfer
function. Refer to Chapter 10, Model Order Reduction, for information about cancelling
pole-zero pairs.

The CD Construct Transfer Function Model VI creates a continuous model.
You can create a discrete transfer function model in one of two ways. The
method you use depends on whether you know the coefficients of the
discrete transfer function model.

If you know the coefficients of the discrete transfer function model, you can
enter in the appropriate values for Numerator and Denominator and set

the Sampling Time (s) to a value greater than zero. Figure 2-4 shows this
process using a sampling time of 10 us.

Sampling Time (s

1EE
[cD Construct Transfer Funcion Model, vi] [Discrete Transfer Function Model]
0 |19.973207E-5  [19.986514E-5 ij 51|
")
o v
0 |||0.996003 -1,995303 1

Figure 2-4. Using Coefficients to Create a Discrete Transfer Function Model
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Chapter 2 Constructing Dynamic System Models

If you do not know the coefficients of the discrete transfer function model,
you must use the CD Convert Continuous to Discrete VI for the conversion.
Set the Sampling Time (s) parameter of this VI to a value greater than
zero. Figure 2-5 shows this process using a sampling time of 10 ps.

|CD Construct Transfer Funckion Model.vil |c|:) Convert Continuous ko Discrete.vil Discrete Transfer Function Model
0 J|ZE+6 === =1 =
2 ey
il 5412
- 1E-5 -
0 |Rere Jamo |1 5150

Figure 2-5. Using the CD Convert Continuous to Discrete VI to Create a Discrete
Transfer Function Model

Converting from a continuous model to a discrete model results in the
following equation:

_ 9.9865x 10z +9.9732x 10’
2>~ 1.9958z +0.996

H(z)

Refer to the Converting Continuous Models to Discrete Models section of
Chapter 3, Converting Models, for more information about converting
continuous models to discrete models.

SIMO, MISO, and MIMO Transfer Function Models

You can use the CD Construct Transfer Function Model VI to create
SIMO, MISO, and MIMO dynamic system models. This section uses a
MIMO dynamic system model as an example.

Consider the two-input two-output system shown in Figure 2-6.
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MIMO System
U1 E
; > Hy
: > Moy
U |
E > Hp
E > Hx

Figure 2-6. MIMO System with Two Inputs and Two Outputs

You can define the transfer function of this MIMO system by using the
following transfer function matrix H, where each element represents a
SISO transfer function.

Hll H12
H21 H22

H =

Suppose the following equations define the SISO transfer functions
between each input-output pair.

1 2
11 = - H = —_—
i s 12 s+1
s+3
H, = > H,, =4
s +45+6

Select the MIMO instance of the CD Construct Transfer Function Model
VI to create a MIMO transfer function model. You then can specify each
transfer function between the j” input and the i output as the ij™ element
of the two-dimensional Transfer Function(s) input array. Figure 2-7
shows that the numerator-denominator pair of the first row and first column
corresponds to H,, the numerator-denominator pair of the first row and
second column corresponds to H,, and so on.
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Transfer Function(s

[cD Construct Transfer Function Model,vi]

B “““"E
8o ransfer Funckion Maodel
MIMO yoei

Figure 2-7. Creating a MIMO Transfer Function Model

The elements in the Numerator and Denominator arrays correspond to
the coefficients, in ascending order, of the numerator and denominator in
the H; transfer function model. For example, the numerator of Hy; is 1,
which corresponds to the zero-order coefficient. Therefore, the first
element in the Numerator array for Hy; is 1. The denominator of Hy; is s,
which means the value 0 corresponds to the zero-order coefficient and the
value 1 corresponds to the first-order coefficient. Therefore the first
element in the Denominator array for H;; is 0 and the second element is 1.

Symbolic Transfer Function Models

Symbolic models define the transfer function using variables rather than
numerical values. If you want to change the value of R, for example, you
only need to make the change in one location instead of several locations.
Select the SISO (Symbolic) or MIMO (Symbolic) instance of the

CD Construct Transfer Function Model VI to create a SISO or MIMO
symbolic transfer function model, respectively.
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The following equation is a symbolic version of the transfer function
originally defined in the SISO Transfer Function Models section of this

chapter.
1
sTES
L LC

Specify the Symbolic Numerator and Symbolic Denominator
coefficients using the variable names R, L, and C. You then specify values
of the numerator and denominator coefficients in the variables input,

as shown in Figure 2-8.

mbohc Mumerakor

1 D Construck TransFer Funckion Model, vi ransfer Function Model
] s | = =0
"
Symbolic Denominatar

5150 (Symbalic) =]
Il,l'(L*C) Jrie |1 | |

arlables

Figure 2-8. Creating a SISO Symbolic Transfer Function Model

Constructing Zero-Pole-Gain Models

Zero-pole-gain models are rewritten transfer function models. When you
factor the polynomial functions of a transfer function model, you get a
zero-pole-gain model. This factoring process shows the gain and the
locations of the poles and zeros of the system. The locations of these poles
determine the stability of the dynamic system.

You analyze zero-pole-gain models in the frequency domain. The
following equations define continuous and discrete zero-pole-gain models,

where the numerators and denominators are products of first-order
polynomials.
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Continuous Zero-Pole-Gain Model

m

||s+z[

i=0
H(s) = k=

HS +p;

i=0

_ k(s—z))(s—2zy)...(s —z,,)
(s=p(s=py)...(s=p,)

Discrete Zero-Pole-Gain Model

m

I |Z+Zl»

i=0
Hij(z) =k p

Hz+pi

i=0

_ k(z-z)(z-2y)...(z~-z2,,)
(z-p)(z-py)...(z=p,)

In these equations, k is a scalar quantity that represents the gain, z;
represents the locations of the zeros, and p; represents the locations of the
poles of the system model.

Numerators of zero-pole-gain models describe the location of the zeros of
the system. Denominators of zero-pole-gain models describe the location
of the poles of the system.

Use the CD Construct Zero-Pole-Gain Model VI to create SISO, SIMO,
MISO, and MIMO system models in zero-pole-gain form. This VI creates
a data structure that defines the zero-pole-gain model and contains
additional information about the system, such as the sampling time, input
or output delays, and input and output names. Refer to the Obtaining Model
Information section of this chapter for information about other properties
of zero-pole-gain models.

SISO Zero-Pole-Gain Models

Using the example in the RLC Circuit Example section of this chapter,
the following equation defines a continuous zero-pole-gain model where
R=20Q,L=50mH, and C =10 uF.

2%10° _ 2%10°

H(s) = -
() (s + 200 + 14007)(s + 200 — 1400i) (s + 200 £ 14007)
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This equation defines a model with one pair of complex conjugate poles at
—200 + 1400:.

Figure 2-9 shows how you use the CD Construct Zero-Pole-Gain Model VI
to create this continuous zero-pole-gain model.

o
CD Construct Zero-Pole-Gain Model, vi] [ero-Pale-Gain Model
0 |||-z00.0-1400i e =]
-200,0 +1400§ ]
5150
Q
2E+6

Figure 2-9. Creating a Continuous Zero-Pole-Gain Model

The CD Construct Zero-Pole-Gain Model VI creates a continuous model.
You create a discrete zero-pole-gain model in the same way you create a
discrete transfer function model. Refer to the SISO Transfer Function
Models section of this chapter for more information about creating a
discrete zero-pole-gain model.

SIMO, MISO, and MIMO Zero-Pole-Gain Models

You create SIMO, MISO, and MIMO zero-pole-gain models the same way
you create SIMO, MISO, and MIMO transfer function models. Refer to the
SIMO, MISO, and MIMO Transfer Function Models section of this chapter
for information about creating these forms of system models.

Symbolic Zero-Pole-Gain Models

You create symbolic zero-pole-gain models the same way you create
symbolic transfer function models. Refer to the Symbolic Transfer
Function Models section of this chapter for information about creating a
symbolic system model.

Constructing State-Space Models

Control Design User Manual

Continuous state-space models use first-order differential equations to
describe the system. Discrete state-space models use difference equations
to describe the system. You analyze state-space models in the time domain.
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Chapter 2 Constructing Dynamic System Models

@ Note State-space models can be either deterministic or stochastic. Deterministic models
do not account for noise, whereas stochastic models do. This chapter provides information
about deterministic state-space models. Refer to Chapter 16, Using Stochastic System
Models, for information about stochastic state-space models.

The following equations define a continuous and a discrete state-space
model.
Continuous State-Space Model

X = Ax+ Bu
y = Cx+Du

Discrete State-Space Model

x(k+1) = Ax(k) + Bu(k)
y(k) = Cx(k) + Du(k)

Table 2-2 describes the dimensions of the vectors and matrices of a
state-space model.

Table 2-2. Dimensions and Names of State-Space Model Variables

Variable Dimension Name
k — Discrete time
n — Number of states
m — Number of inputs
r — Number of outputs
A n X n matrix State matrix
B n X m matrix Input matrix
C r X n matrix Output matrix
D r X m matrix Direct transmission matrix
X n-vector State vector
u m-vector Input vector
y r-vector Output vector
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Chapter 2 Constructing Dynamic System Models

Use the CD Construct State-Space Model VI to create SISO, SIMO, MISO,
and MIMO system models in state-space form. This VI creates a data
structure that uses matrices to define the state-space model. The matrices
are zero-based two-dimensional arrays of numbers where the ij" element of
the array corresponds to the ij element of matrices in a state-space model.
You can assume that an n* order system with m inputs and r outputs has
state, input, and output vectors as defined in the following equations:

X0 Uy Yo
X u
Xn_1 Uy 1 Y1

State-space models also contain additional information about the system,
such as the sampling time, input or output delays, and input and output
names. Refer to the Obtaining Model Information section of this chapter for
information about other properties that state-space models contain.

SISO State-Space Models

Control Design User Manual

Using the example in the RLC Circuit Example section of this chapter,
the following equations define a continuous state-space model.

s o 1|L] |o
X=19=1 1 Rl|.]*]1|%

Ve Lc LY |LcC
vC

y=v.=[10]|+[o]v
VC

In these equations, y equals the voltage of the capacitor v., and u equals the
input voltage v;.

v
x equals the voltage of the capacitor and the derivative of that voltage

Ve
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The following matrices define a state-space model where R = 20 €,
L=50mH, and C=10 pF.

- 0 Llg_| ©
—2x10° —400 2x10°

¢=[1o 2=

When you plug these matrices into the equations for a continuous
state-space model defined in the Constructing State-Space Models section
of this chapter, you get the following equations:

. 0 I ||ve 0
X = ] I+ o Vi
-2x10" -400| |v, 2x10

Figure 2-10 shows how you use the CD Construct State-Space Model VI to
create this continuous state-space model.

CD Canstruct State-Space Madel,vi] Etate-Space Model
— =

EQ
121
Mumeric *

Figure 2-10. Creating a Continuous State-Space Model

@ Note Although B is a column vector, C is arow vector, and D is a scalar, you must use the
2D array data type when connecting these inputs to the VI.
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The CD Construct State-Space Model VI creates a continuous model. You
create a discrete state-space model in the same way you create a discrete
transfer function model. Refer to the SISO Transfer Function Models
section of this chapter for more information about creating a discrete
state-space model.

SIMO, MIS0, and MIMO State-Space Models

You construct a SIMO, MISO, or MIMO state-space model by ensuring the
output matrix C and the input matrix B have the appropriate dimensions.
For a SIMO system, construct an output matrix C with more than one row.
For a MISO system, construct an input matrix B with more than one
column. For a MIMO system, construct matrices C and B with more than
one row and column, respectively.

When you create a SIMO, MISO, or MIMO system, ensure that the direct
transmission matrix D has the appropriate dimensions. If you leave D
empty or unwired, the Control Design and Simulation Module replaces the
missing values with zeros.

Symbolic State-Space Models

You create symbolic state-space models the same way you create a
symbolic transfer function model. Refer to the Symbolic Transfer Function
Models section of this chapter for more information about creating a
symbolic system model.

Obtaining Model Information

Each of the Model Construction VIs creates not only a data structure that
defines the model, but also a set of properties that provide information
about the system. These properties are common in all three model forms.
Table 2-3 lists the properties and their corresponding data types.

Table 2-3. Model Properties

Property Data Type Description
Model Name String Assigns a name to a specific model.
Input Names 1D array of strings The i element of the array defines the

name of the i input to the model.

Output Names

1D array of strings The i element of the array defines the
name of the i output of the model.

Control Design User Manual
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Table 2-3. Model Properties (Continued)

Property Data Type Description

Input Delays 1D array of double-precision, The i element of the array defines the time
floating-point numeric values delay of the i input of the model.

Output Delays 1D array of double-precision, The i element of the array defines the time
floating-point numeric values delay of the i”* output of the model.

Transport Delay 1D array of double-precision, The ij™ element of the array defines the time
floating-point numeric values delay between the i output and j* input of

the model.
Notes String A string for storing additional data. The

string can contain comments or other
information that you want to store with the
model.

Sampling Time

Double-precision,
floating-point numeric value

Represents the sampling time, in seconds,
of the system. If a model represents a
continuous system, the value of Sampling
Time is zero. For discrete system models,
the value must be greater than zero.

State Names

Array of strings

The i element of the array defines the
name of the i state of the model. This
property is available with state-space
models only.

You can use these data structures with every VI in the Control Design and
Simulation Module that accepts a system model as an input.

@ Note Delay information exists in the model properties and not in the mathematical model.
Any analysis, such as time- or frequency-domain analysis, you perform on the model does
not account for delay present in the model. If you want the analysis to account for delay
present in the model, you must incorporate the delay into the model itself. Refer to
Chapter 6, Working with Delay Information, for more information about accounting for
model delay.

© National Instruments Corporation

You can use the Model Information VIs to get and set various properties
of the model. Refer to the LabVIEW Help, available by selecting Help»
Search the LabVIEW Help, for more information about using the Model
Information VIs to view and change the properties of a system model.
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Converting Models

Model conversion involves changing the representation of dynamic system
models. For example, you can convert a zero-pole-gain model to a
state-space model. You also can convert a model between continuous and
discrete types.

This chapter provides information about using the LabVIEW Control
Design and Simulation Module to convert between model forms and to
convert between continuous and discrete models.

@ Note Refer to the labview\examples\Control and Simulation\Control

Design\Model Conversion directory for example VIs that demonstrate the concepts
explained in this chapter.

Converting between Model Forms

You can use three different model forms—transfer function,
zero-pole-gain, and state-space—to describe the same dynamic system.
Refer to Chapter 2, Constructing Dynamic System Models, for more
information about these model forms. You can use the Control Design and
Simulation Module to convert from one form to another.

Converting between model forms is important because each form provides
different information about the system. For example, state-space models
use the states of a system to show physical information about the system.
Thus, observing physical information about a dynamic system is less
complicated when the model for that dynamic system is in state-space
form.

You also can use different analysis and synthesis techniques depending on
the form of the model. For example, if a model for a system is in transfer
function form, you can synthesize a controller for that system using
classical control design techniques such as the root locus technique. If the
model is in state-space form, you can design a controller using state-space
control design techniques such as the pole placement technique. Refer to
Chapter 11, Designing Classical Controllers, and Chapter 12, Designing
State-Space Controllers, for more information about classical and
state-space control design techniques.
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The following sections discuss the Model Conversion VIs you can use to
convert between model forms.

Converting Models to Transfer Function Models

Use the CD Convert to Transfer Function Model VI to convert a
zero-pole-gain or state-space model to a transfer function model. This
section uses a state-space model as an example.

@ Note Because transfer function models do not include state information, you lose the state
vector x when you convert a state-space model to a transfer function model. Additionally,
the Control Design and Simulation Module might not be able to recover the same states if
you convert the model back to state-space form.

Consider the continuous state-space model defined in the Constructing
State-Space Models section of Chapter 2, Constructing Dynamic System
Models.

X = Ax+ Bu
y = Cx+Du

For continuous systems, you can use the Laplace transform to convert from
the time domain to the Laplace domain model representation.

@ Note The equations in this section convert model forms within both the continuous and
discrete domains. Refer to the Converting between Continuous and Discrete Models
section of this chapter for information about converting between continuous and discrete

domains.

Applying the Laplace transform to the state-space model results in the
following equation:

Y(s) = [C(Is—A)"' B + D1U(s)

In this equation, s is the Laplace variable, and I is the identity matrix with
the same dimensions as A.
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The ratio between the output Y(s) and input U(s) defines the following
matrix transfer function model H(s).

H(s) = % = C(Is—A)'B+D

For example, consider the following second-order MISO state-space

system model.
=712 (1O
0 -1 01

v =[10}x+[oofu

Using the Laplace transform, you obtain the transfer function matrix H(s).

1 2
H(s) = | =5 5———
S+ 425+1

Converting Models to Zero-Pole-Gain Models

Use the CD Convert to Zero-Pole-Gain Model VI to convert a transfer
function or state-space model to a zero-pole-gain model. This section uses
a transfer function model as an example.

@ Note When you convert a state-space model to a zero-pole-gain model, the CD Convert
to Zero-Pole-Gain Model VI converts the state-space model to a transfer function model
first.

To convert the transfer function matrix H(s) to the zero-pole-gain form,
the Control Design and Simulation Module calculates the numerator and
denominator polynomial roots and the gain of each SISO transfer function
in H(s).
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When you convert the transfer function matrix from the Converting Models
to Transfer Function Models section of this chapter, you obtain the
following zero-pole-gain model:

[ 2
H(s) = LJFI (S+1)2}

This zero-pole-gain model is numerically identical to the transfer function
model. The zero-pole-gain form, however, shows the locations of the zeros
and poles of a system.

Converting Models to State-Space Models

Use the CD Convert to State-Space Model VI to convert a zero-pole-gain
or transfer function model to a state-space model. This section uses a
zero-pole-gain model as an example.

@ Note When you convert a zero-pole-gain model to a state-space model, the CD Convert
to State-Space Model VI converts the zero-pole-gain model to a transfer function model

first.

Control Design User Manual

When converting a transfer function or zero-pole-gain model, you can
specify whether you want the resulting state-space model to be full or
minimal. A full state-space model does not reduce the number of states
determined by a least common denominator calculation. A minimal
state-space model reduces the number of states and produces a minimal
representation of the original model. Use the Realization Type parameter
of the CD Convert to State-Space Model VI to specify if you want the
resulting model to be full or minimal. Refer to the Obtaining the Minimal
Realization of Models section of Chapter 10, Model Order Reduction,

for more information about minimizing state-space realizations.

Using the example in the Converting Models to Transfer Function Models
section of this chapter, the following equation gives the minimal realization
when converting a zero-pole-gain model to a state-space model.

o |033 094( . |-041 0 |,
-047 -1.67) | 029 -0.87

y = [-2.45 o|x+[o0 o]u
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This model numerically differs from the initial state-space model. From the
input-output model perspective, however, the state-space models are
identical.

Refer to the LabVIEW Help, available by selecting Help»Search the
LabVIEW Help, for more information about the Model Conversion VIs.

Converting hetween Continuous and Discrete Models

Continuous models are analog and operate using physical components.
Discrete models are digital and operate on a computer or real-time (RT)
target. To determine how an analog model performs on a digital target, you
can convert the continuous model to a discrete model. You also can convert
a discrete model to a continuous model.

Additionally, you can resample a discrete model. Resampling involves
converting a discrete model to a discrete model with a different sampling
time. Resampling is useful when the sampling time of a model does not
match the sampling time of the target on which that model operates. In this
situation, you resample the model to use the sampling time of the target.

The Model Conversion VIs provide a number of mathematical methods that
perform these conversions. Table 3-1 summarizes these methods, which are
substitutions between the continuous Laplace-transform operator and the
discrete z-transform operator.

Table 3-1. Mapping Methods for Converting between Continuous and Discrete

Method of Approximation Continuous to Discrete Discrete to Continuous
Forward Rectangular -1 2> 1+sT
Method s T
Backward Rectangular z-1 1
Method s =T Z_>1_ST
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Converting Models

Table 3-1. Mapping Methods for Converting between Continuous and Discrete (Continued)

Method of Approximation Continuous to Discrete Discrete to Continuous
Tustin’ -
ustin’s Method 2(z-1) 1457
T(z+1) 2
z—
15T
2
Prewarp Method z(z-1) 1+sT*
T*(z+1) 1-sT*
2 tan(w ; T) Ztan(w X T)
T * = T * = 2
w w

In these equations, T represents the sample time and w represents the
prewarp frequency. T* is a modified sample time that the Prewarp method
uses in converting between continuous and discrete models.

The following sections provide information about the methods that you can
use to perform continuous to discrete conversions, discrete to continuous
conversions, and discrete to discrete conversions.

Converting Continuous Models to Discrete Models

Control Design User Manual

To convert a continuous model to a discrete one, first approximate the
value of the derivative in the continuous equation over each change in time.
Then find the area of the geometric region having width df and height equal
to the derivative.

For example, consider the following first-order continuous differential
equation:

y =/
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To convert this continuous model to a discrete model, evaluate the
derivative function f(¢) at different points to approximate y at time .
Figure 3-1 illustrates the function f(¢) between ¢ and ¢ + 7, where T is the
sampling time.

f()

\/

Figure 3-1. Discretizing a Differential Equation

Integrating between time ¢ and ¢ + T results in the following difference
equation:

t+T t+T

[3dv = ya+1)-y0) = [ s
t t
Integrating f(1) for T = to ¢ + T represents the area under the curve.

The CD Convert Continuous to Discrete VI provides the following
mathematical methods to approximate this area.

*  Forward Rectangular

*  Backward Rectangular
*  Tustin’s

e Prewarp

*  Zero-Order-Hold

*  First-Order-Hold

*  Z-Transform

*  Matched Pole-Zero

The following sections provide information about each of these methods.
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Forward Rectangular Method

The Forward Rectangular method considers f(T) constant and equal to
f(t + T) along the integration range. This consideration results in the
following equation:

ya+T) =y)+ft+THT

This method considers the incremental area term between sampling times ¢
and 7 + T as a rectangle of width T and height equal to f(t + T'), as shown
in Figure 3-2.

Forward

\

t t+ T

Figure 3-2. Forward Rectangular Method

Figure 3-2 shows that, for this example, the Forward Rectangular method
overestimates the area under the curve. To minimize this overestimation,

use a small sampling interval. Depending on the direction and size of the
curve you are measuring, this overestimation might not occur.

Backward Rectangular Method

The Backward Rectangular method considers f(t) constant and equal to
f(?) along the integration range. This consideration results in the following
equation:

y(a+T) =y +f(OT
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This method considers the incremental area term between sampling times ¢
and 7 + T as a rectangle of width T and height equal to f(), as shown in
Figure 3-3.

Backward

fit+T)

fi9)

v

t t+ T

Figure 3-3. Backward Rectangular Method

Figure 3-3 shows that, for this example, the Backward Rectangular method
underestimates the area under the curve. To minimize this underestimation,
use a small sampling interval. Depending on the direction and size of the
curve you are measuring, this underestimation might not occur.

Tustin’s Method

Tustin’s method, also known as the trapezoid method, uses trapezoids

to provide a balance between the Forward Rectangular and Backward
Rectangular methods. Tustin’s method takes the average of the rectangles
defined by the Forward and Backward Rectangular methods and uses the
average value as the incremental area to approximate the area under the
curve.

Tustin’s method considers f(T) constant and equal to the average between

f(#) and f(¢t + T) along the integration range, which results in the following
equation:

_ () +f+T)]
y(t+T) =y(t)+ 7 T
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The last term in this equation is identical to the area of a trapezoid of height
T and bases f(¢) and f(t + T). Figure 3-4 shows the area under a curve using
Tustin’s method.

Tustin

\

t t+ T

Figure 3-4. Tustin’s Method

Figure 3-4 shows that, for this example, Tustin’s method provides a balance
between the overestimation of the Forward Rectangular and the
underestimation of the Backward Rectangular method.

Prewarp Method

The Prewarp method is a trapezoidal type of transformation that uses the
prewarp frequency o to adjust the sampling time 7. This adjustment results
in a separate sampling time 7. This adjustment also compensates for errors
introduced in the discretizing process.

This method also considers f(T) constant and equal to the average between
f(©) and f(t + T™) along the integration range, which results in the
following equation:

_ /@O +f+TH]
y(t+T) = y(t)+ > T

Control Design User Manual 3-10 ni.com



Chapter 3 Converting Models

The last term in this equation is identical to the area of a trapezoid of
height T and bases f(f) and f(t + T™). Figure 3-5 shows the area under a
curve using the Prewarp method.

Prewarp

\

t t+ T t+T*

Figure 3-5. Prewarp Method

Figure 3-5 shows that, for this example, the Prewarp method compensates
for the integration error by adjusting the sampling time to 7*. The area
between 7 + T and ¢ + T* is roughly equal to the integration error, which is
represented by the unshaded portion of the area under the curve.

Use a particular conversion method based on the model that you are
converting and the requirements of the application for which you are
designing a control system.

Zero-Order-Hold and First-Order-Hold Methods

The Zero-Order-Hold and First-Order-Hold methods assume properties of
the continuous differential equation y = f(¢) . The Zero-Order-Hold
method assumes that f(¢) consists of an input that you can hold constant
during the integration period between sampling times ¢ and ¢ + 7. The
First-Order-Hold method assumes that you can increase this input over
time during this same period. These methods also integrate the remaining
terms of f(¢) not related to the input because these terms refer to the internal
state dynamics.
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You obtain the following equation after integrating a linear time-invariant
system between sampling times 7 and ¢ + T.

t+T
x(t+T) = & Tx(n) + I ATV Bty d

y(t) = Cx(t) + Du(t)

In this equation, u(¢) is the input to the system and is not necessarily
constant between sampling times 7 and ¢ + 7. The following equation shows
the Zero-Order-Hold method approximating the input to a constant value
u(t) during the integration time.

t+T
x(1+T) = ' Tx(n) + j AT BT u(r)

t

Conversely, the following equation shows the First-Order-Hold method
ramping the input values with a constant slope [u(t + T) — u(#)]/T during
integration time.

t+T

x(t+7) = ex(t)+ j- eA(t+T”)B{u(t)+ [u(t+T)—u(t)](~—-T;t)}dr

t

Refer to Digital Control of Dynamic Systems, as listed in the Related
Documentation section of this manual, for more information about the
Zero-Order-Hold and First-Order-Hold methods.

Z-Transform Method

The Z-Transform method is defined such that the continuous and discrete
impulse responses maintain major similarities. You calculate the impulse
response of the discrete transfer function by multiplying the inverse
Laplace transform of the continuous transfer function by the sampling
time 7.

Refer to Discrete-Time Control Systems, as listed in the Related
Documentation section of this manual, for more information about the
Z-Transform method.
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Matched Pole-Zero Method

The Matched Pole-Zero method uses the following relationship between
the continuous s and discrete z frequency domains.

sT
zZ =e

In this equation, 7 is the sampling time used for the discrete system. The
Matched Pole-Zero method maps continuous-time poles and finite zeros to
the z-plane using this relation. This method also maps zeros at infinity to
z =0, so these zeros do not affect the frequency response.

After the algorithm maps the poles and zeros, the algorithm then attempts
to make sure the system gains are equivalent at some critical frequency. If
the systems have no poles or zeros at s = 0 or z = 1, the Matched Pole-Zero
method selects a discrete-time gain such that the system gains match at
these locations.

Alternatively, if the systems have no poles or zeros at s = p(i/T) or z = -1,
where p is the location of a pole, this method equalizes the gains at that
frequency. If the Matched Pole-Zero method cannot match either of these
gains, the algorithm does not choose a gain.

Refer to Digital Control of Dynamic Systems, as listed in the Related
Documentation section of this manual, for more information about the
Matched Pole-Zero method.

Converting Discrete Models to Continuous Models

Use the CD Convert Discrete to Continuous VI to convert a discrete model
to a continuous model. This VI supports the following conversion methods:
Forward Rectangular, Backward Rectangular, Tustin’s, Prewarp,
Z-Transform, and Zero-Order-Hold. This VI does not support the
First-Order-Hold or Matched Pole-Zero methods. Refer to Table 3-1 for
the equations for each mapping method.

The Z-Transform method also is a reverse calculation to map a model in the
z-plane to the s-plane. You calculate the impulse response of the continuous
transfer function by dividing the inverse z-transform of the discrete transfer
function by the sampling time 7.
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Resampling a Discrete Model

Use the CD Convert Discrete to Discrete VI to resample a discrete model.
This VI converts the discrete model to a continuous model and then
converts the continuous model back to a discrete model. The first
conversion uses the initial sampling time 7. The second conversion uses
the final sampling time 7.

The CD Convert Discrete to Discrete VI supports the following conversion
methods: Forward Rectangular, Backward Rectangular, Tustin’s, Prewarp,
Zero-Order-Hold, and Z-Transform. This VI does not support the
First-Order-Hold or Matched Pole-Zero methods.
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You typically create a dynamic system model by connecting many models,
or subsystems, together. Connecting many models together makes
developing a model of a complicated dynamic system less complicated
because you can describe the dynamics of individual pieces.

You can connect continuous models only to other continuous models. To
connect discrete models together, each model must have the same sampling
time. Connected models might, however, be of any form. For example,
you can connect a transfer function model to a state-space model or a
state-space model to a zero-pole-gain model.

Furthermore, you can make connections between single-input
single-output (SISO), single-input multiple-output (SIMO), multiple-input
single-output (MISO), and multiple-input multiple-output (MIMO)
systems.

This chapter provides information about using the LabVIEW Control
Design and Simulation Module to connect models in the following four
ways: in series, by appending, in parallel, and with feedback.

@ Note Refer to the labview\examples\Control and Simulation\Control
Design\Model Connection directory for example VIs that demonstrate the concepts
explained in this chapter.

Connecting Models in Series

A series connection joins the outputs of the first model to the inputs of a
second model. Use the CD Series VI to connect two models in series.

@ Note When connecting models of different forms, the Series Model output returns a
model based on the following hierarchy: state-space>transfer function>zero-pole-gain.
For example, if you connect a zero-pole-gain model to a state-space model, Series Model
returns a state-space model.

The following sections provide information about the kinds of connections
you can make with the CD Series VI.
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Connecting Models

Connecting SISO Systems in Series
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Consider a valve that controls the flow rate of water into a tank. Figure 4-1
represents this system.

I(s): Input Signal j

; Q(s): Flow Rate
E

Hy(s)

L(s): Level

Figure 4-1. Flow of Water into a Tank

If you assume that the incoming water pressure to the valve is constant,
only the valve input signal affects the level of the water in the tank. You can
model the flow rate of water into the tank using the following transfer
functions, where H,(s) is a model of the valve and H/(s) is a model of the
tank.

_00) _ K, L(s) _
H H =
TS T At T00) TS

I(s), Q(s), and L(s) represent the Laplace transform of the input signal, the
flow rate, and the level of water in the tank, respectively. The constants K,
T, {, and K, are parameters of the models that describe the valve and tank.
To obtain the effect of the input signal on the water level, place the two
systems in series and multiply their transfer functions.

L) _ gy o) ) = g

H(s)=
(= 1(s) rs2+2C’cs+1 S
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This equation represents the output of H,(s) connecting to the input of
H(s). Figure 4-2 illustrates this relationship.

I(s) Q(s) L(s)
— H/s) = Q(s)/[(s) P Hi(s) = L(s)/Q(s) ——»

I(s) L(s)
7 Bl H(s) = HUs)*Hi(s) = L(s)/I(S)———p»

Figure 4-2. Valve Model and Tank Model in Series

The resulting SISO system H(s) now represents the relationship between
the input signal I(s) and the level of water L(s) in the tank.

Creating a SIMO System in Series

You can create a SIMO system by connecting two or more SISO systems
with a SIMO subsystem. For example, adding another valve and tank to the
example in the Connecting SISO Systems in Series section of this chapter
results in a SIMO system that divides the flow rate between two different
tanks. Figure 4-3 shows this system.

; IE 3 : Q(s): Flow Rate

Ht1(s) @ Hio(s) @

L4(s): Level Tank 1 Lo(s): Level Tank 2

Figure 4-3. Dividing the Flow of Water between Two Tanks
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H ,»(s) is a SIMO transfer function matrix that represents the relationship of
the flow rates. By connecting H,,(s) to H,;(s) and Q(s), the entire system

becomes SIMO. The total flow rate Q(s) is equal to the sum of the parts

Q1(s) and Oy(s).
0(s) = 0y(s) + Oy(s) = AQ(s) + (1 = M) O(s)

The constant A represents the fraction of flow sent to the first tank, whereas
(1 - A) is the remaining fraction of flow sent to the second tank.

HVZ(S) = |:1 7\'7;|

When you connect these models in series, the output of the first system
H ,,(s) connects to the input of the second system H ,(s). Figure 4-4

illustrates this relationship.
. HO=2AO ol pais) = Lasyane)| 1
i
O ]ty = (o) | 2 ) 00
Qo(s) = (1 - 1)Q(s) B Lo(s)
P Hio(s) = Lo(s)/Qo(s) ——

Figure 4-4. Two Valve Models and Two Tank Models in Series

This combined system, which now is a SIMO system, has one input /(s) and
two outputs L;(s) and L,(s). Figure 4-5 is a LabVIEW block diagram that

illustrates this system.

alve 1

[E=uk
E [ Series.vi| [CD Series. v
I%B'Z T | O | |
G o o
[Tanks
[S=uk

Figure 4-5. Block Diagram of the Two Valves and Tanks in Series
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Chapter 4 Connecting Models

Connecting MIMO Systems in Series

When connecting MIMO systems, you can connect any output of the first
model to any input(s) of the second model. Figure 4-6 shows an example
of two MIMO system models connected in series.

LU 20
> - ,

5 t 2z : z4 :
E— > —>
_Eu—2> Model 1 Z_2>I “|I‘, . E
L. o« o . :
L. . N . ;
Lo e Lon :
oy Z Lo z ;
R > —>
: R Yo

i ———P —>
E : vovy iz E

! L —
; " | Model2 | Y2
. : .
' ° ° ° E
E . . L
Vk Vi |

Figure 4-6. MIMO System Models in Series

Figure 4-6 shows how the outputs of Model 1 that are connected to the
inputs of Model 2 do not appear as outputs of the resulting series model.
For example, because z, connects to the Model 2 inputs v; and v,, zyis no
longer an output of the resulting series model. Similarly, because z,
connects to vy, 7, is no longer an output of the resulting series model.
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This same principle applies to the inputs of Model 2. Inputs of Model 2 that
are connected to an output of Model 1 no longer appear as inputs of the
resulting series model. Because the input vy of Model 2 is connected to the
output of z, of Model 1, neither vy nor z, appear in the resulting series
model.

You define the connections between two models using the Connections
control of the CD Series VI. Figure 4-7 shows the settings this control used
to connect the models in Figure 4-6.

F
\'JID Qukput Input Cutput Inpuk Cutput Inpuk

Connections

Model 1 Model 2 Model 1 Model 2 Model 1 Model 2

" - " - 2 o

Figure 4-7. Connection Definitions for Models in Series

The control in Figure 4-7 indicates that the Model 1 output z, connects to
the Model 2 inputs v; and v,. You also can see how the Model 1 output z,
connects to the Model 2 input vy,

Appending Models

Control Design User Manual

You can append models together to compare the time or frequency
response of two models in the same plot. Use the CD Append VI to produce
an augmented model from connections between two models. This
augmented model contains all inputs and outputs of both models. With
state-space models, states of the first model are combined with states of the
second model.
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Figure 4-8 shows two appended system models.

Up E)
— —:—»
LUy z |
P ———

— Model 1 L= >

Uj Z;
— > —>
) Yo !
—» —>
L v o
LV Yo -
— Model 2 EELEEENG
' ° ° '
Ce o
L. o
E Vk Yi '
—> —

Figure 4-8. Appended Models

For example, consider the two tanks from the Creating a SIMO System in
Series section of this chapter. The following equations define the transfer
functions of the tanks.

K K
Hy@) == Hpls) = =

K, and K, are the gains of their respective transfer functions. Appending
H,(s) and H(s) results in the following appended matrix transfer
function H,.

H,(s) 0
0 Hpy(s)

H =

t
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Chapter 4 Connecting Models

Figure 4-9 uses the block diagram from Figure 4-5 but replaces the Tanks
input with H,. As in Figure 4-5, the two valves are connected in series with
each other. In Figure 4-9, however, the two tanks now are appended to each
other.

==t :

alve 2 D Series vi| [CD Series.vi]
= 0 E= |
L=tk o= o=

El [s] Ap end.vi sppended Model

[ St boaey < =

7.7 J’E

Figure 4-9. Appending the Two Tanks

Connecting Models in Parallel

Control Design User Manual

A parallel connection creates a single model from two separate systems that
share common inputs. You also can use a parallel connection to add or
subtract outputs of two subsystems and represent them as a single output.
Use the CD Parallel VI to connect systems in parallel.

For example, consider the circuit system in Figure 4-10.

) Ry Ry
1 h Ip
v

L L,

Figure 4-10. Circuit System
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Chapter 4 Connecting Models

The input of this system is the voltage v. The output of this system is the
total current i, which is the sum of currents i; and i,. R, and R, are resistors,
and L; and L, are inductors. The following equations describe the
individual currents for the circuit system in Figure 4-10.

di )
Ll‘c'it-+Rlll—v =0

diz .
L2E+R212—V =0

The following equations give the resulting transfer functions for each
circuit loop.

_Lis) _ 1
) =505 = I5+r,
Hy(s) = M = L

V(s) L,s+R,

In Figure 4-11, H,(s) and H,(s) represent the transfer functions defined in
the previous equations, and /;(s) and I,(s) are the respective outputs of these
transfer functions. V(s) is the transfer function of the voltage input v that
both circuit loops share.

V(s) —P] Hy(s) —» l(s)

Figure 4-11. Each Circuit Loop in the Circuit System

© National Instruments Corporation 4-9 Control Design User Manual
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Figure 4-12 illustrates the relationship between the voltage input v and total
current i by placing both models together in one larger system model. When
the two models are in parallel, both models share the same input V(s) and
provide a total output I(s), as shown in Figure 4-12.

.................................

Figure 4-12. Entire Circuit System as a Parallel Model

The following equations describe the resulting transfer function as a
second-order system.

I(s) = I)(s) + L,(s) = V(s)[H(s) + Hy(s)]

H(s) = % = H,(s) + Hy(s)

Control Design User Manual 4-10 ni.com



Chapter 4 Connecting Models

Figure 4-13 illustrates how some inputs from Model 1 and Model 2 share
the same inputs. The outputs of Model 1 are added to or subtracted from the
outputs of Model 2 to provide one combined parallel model.

Uo 20
o > —>
E Uy :
Do > — > Z
I 2z E

Up o > Model 1 R . °
Do Do .

° E 1 H | °

. . 1 i

SR .

Yj - > - > 7
LoV Yo ol
boopee-e- —>+Q——> X
. (O)y——F» x
A _ !

I R > > > Vi

L 7 5

wy ol @ -2-p| Model2 | 2 .

° L]

° L]

°

Vk > > » Vi

Figure 4-13. MIMO Models in Parallel
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Chapter 4 Connecting Models

Use the CD Parallel VI to define the relationship between the inputs and
outputs of the models. Figure 4-14 displays the Input Connections and
Output Connections controls that define the parallel interconnections
shown in Figure 4-13.

Crommm C e C o C e C

o foamm  COEEE O oamm

Figure 4-14. Connection Definitions for Models in Parallel

These controls indicate that the input for u, of Model 1 is the same as the
input for v, of Model 2, the input for u; of Model 1 is the same as the input
for vy of Model 2, and so on. You can see how the y, output of Model 2

is subtracted from the z, output of Model 1. You also can see how the

2z, output of Model 1 is added to the y, output of Model 2. You define
addition and subtraction by specifying the output as a Positive (+) or
Negative () connection.

In Figure 4-13, notice that any common inputs from the original models are
replaced by a new input w,, in the resulting model. Likewise, any combined
outputs of the original models are replaced by a new output x,, in the
resulting model.

Placing Models in a Closed-Loop Configuration

Control Design User Manual

Use the CD Feedback VI to place one or two models in a closed-loop
configuration. The Feedback Connections and Output Connections
parameters define the connections between the outputs of a model to the
inputs of the same model or a second model. If the models have an unequal
number of inputs and outputs, the CD Feedback VI establishes a number
of connections equal to the smaller number of inputs or outputs. The
remaining inputs or outputs remain unmodified.
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For example, a model with m inputs and r outputs, where m < r, has m
number of reference inputs. Similarly, a model with m inputs and r outputs,
where m > r, has r number of reference inputs. All original y, outputs
remain in the resulting model.

The following sections provide information about how the CD Feedback VI
configures the closed-loop feedback when you have one or two models in
the closed-loop configuration. The following sections also describe the
behavior of this VI when you leave connections undefined.

Single Model in a Closed-Loop Configuration

When you only have one model in a closed-loop configuration, the

CD Feedback VI connects the outputs to the inputs of the same model.
You define these connections using the Feedback Connections and the
Feedback Sign parameters.

The following sections provide information about the configuration of the
model when you define and do not define connections.

Feedback Connections Undefined

If you do not define Feedback Connections, all outputs from Model 1 are
fed back to the inputs of Model 1. Additionally, the Feedback Sign input
determines if these outputs are fed back negatively or positively. The
resulting model, shown in Figure 4-15, contains new reference inputs r
and r; for each feedback connection you specify.

Feedback
Connections . > Yo
+ uy
o O [T =
=" + Model 1 %* Y1
r : > ro
Uo u E »

Figure 4-15. One Model with No Connections Defined
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Feedback Connections Defined

If you define Feedback Connections, each specified output in Model 1 is
fed back to each specified input of Model 1. You also define whether the
connection is positive or negative. In this situation, the CD Feedback VI
ignores the Feedback Sign input. The resulting model, shown in

Figure 4-16, contains a new reference input r, for each feedback
connection you specify.

U » » o

Feedback uy

Connections I—V
T Model 1 T » V1
¢ O -

U2 ' »
"

Figure 4-16. One Model with Connections Defined

Two Models in a Closed-Loop Configuration

Control Design User Manual

When you have two models in a closed-loop configuration, the first model
is always in the open-loop path, and the second model is always in the
feedback path. You have the option to define feedback connections, output
connections, both types of connections, or no types of connections.

Within the CD Feedback VI, Feedback Connections defines the
connection between the outputs of Model 2 and the inputs of Model 1.
Output Connections defines the connection between the outputs of
Model 1 and the inputs of Model 2. By default, the CD Feedback VI
connects the models with negative feedback.

The resulting model differs depending on the number of connections you
define. The following sections provide information about the configuration
of the models when you define or do not define connections.
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Feedback and Output Connections Undefined

If you do not define Feedback Connections or Output Connections,
the CD Feedback VI tries to connect all the outputs of Model 1 to the
corresponding inputs of Model 2. The CD Feedback VI also tries to
connect all the outputs of Model 2 to the corresponding inputs of Model 1.
The Feedback Sign input determines if these outputs are fed back
negatively or positively. By default, the CD Feedback VI connects the
models with negative feedback.

The resulting model, shown in Figure 4-17, contains new reference inputs
ro and ry for each feedback connection.

o

r

Uy

Vo

Feedback
Connections >V
U E P J0
+ Uy H
> > ]
- A " Model 1 — > Vi
D~ .
7 .
: > L
' LV 20
| Output g :
; Connections| i | v, z '
P teb-- 9 Model2 |-
: E » . E
1 1 Ll 1

Figure 4-17. Two Models with No Connections Defined
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Feedback Connections Undefined, OQutput
Connections Defined

If you do not define Feedback Connections but define Output
Connections, the CD Feedback VI connects the specified outputs for
Model 1 to the specified inputs for Model 2. You define whether each
connection is positive or negative. Because you have not defined Feedback
Connections, the CD Feedback VI connects all outputs of Model 2 to the
corresponding inputs in Model 1 based on the Feedback Sign.

@ Note All outputs of Model 1, whether they are connected to Model 2 outputs or not,
remain as outputs in the resulting model. Conversely, Model 2 outputs do not remain in the
resulting model when fed back to Model 1 inputs.

The resulting model, shown in Figure 4-18, contains new reference inputs
ro and ry for each feedback connection.

Feedback
Connections
+
o ) Yoy, > Yo
\.i Y uy
f (O
T A Model 1 ; > Vi
Up > ,
I ' : 2
Yo p > | P SRR .
: : - :
E E OUtPUt +é. - _Vj ’ MOdeI 2 .%1. - E
, : Connections |_ .
Vo > i :
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Figure 4-18. Two Models with Output Connections Defined
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Feedback Connections Defined, Output Connections
Undefined

If you define Feedback Connections but not Output Connections,

the CD Feedback VI feeds the outputs specified for Model 2 back to

the specified inputs for Model 1. You define whether the feedback
connection is positive or negative. Because you have not defined Output
Connections, the CD Feedback VI tries to connect all outputs of Model 1
positively to the inputs in Model 2.

The resulting model, shown in Figure 4-19, contains a new reference input
ro for each feedback connection you have defined.

o > » Jo
+ u !
I Ay :
0 T—> .
Feedback _4 Model 1 I > Vi
Connections | ' I
U . o
5 ' : Yo
: 1 1-- P | ZO
, Output :
: nnections |1 |V z
| Connections | |.... - Model 2
Vo >

Figure 4-19. Two Models with Feedback Connections Defined
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Both Feedback and Output Connections Defined

If you specify connections in both Feedback Connections and in
Output Connections, you define all connections. Based on the
connections you specified in Output Connections, the outputs specified
for Model 1 are connected to the inputs specified for Model 2. You define
whether the connection is positive or negative.

Based on the connections you specified in Feedback Connections, the
outputs specified for Model 2 are fed back to the inputs specified for
Model 1. You also define whether the feedback connection is positive or
negative. Outputs of Model 2 not specified in Feedback Connections
are removed from the resulting model. Again, because you specified
connections using the Feedback Connections, the CD Feedback VI
ignores the Feedback Sign input.

In the resulting model, shown in Figure 4-20, you can see how the
CD Feedback VI creates a new reference input r,, for each feedback
connection you specified.

! > » Yo
+ u
I N\ 1 -
0 \/ >
Feedback =4 Model 1 : .
Connections | .
U :" > E
Vo >
: ) 4
i Output |* Vi z
. ! 1l Mogels |2\,
' Connections _O Model 2 :
Vo >
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Figure 4-20. Two Models with Feedback and Output Connections Defined
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Time Response Analysis

The time response of a dynamic system provides information about how
the system responds to certain inputs. You analyze the time response to
determine the stability of the system and the performance of the controller.

Obtaining the time response of a system involves numerically integrating
the system model in time. The LabVIEW Control Design and Simulation
Module provides VIs to help you find these time-domain solutions. You can
use these Time Response VIs to analyze the response of a system to step
and impulse inputs. You can apply initial conditions to both of these
responses. You also can use the Time Response VIs to simulate the
response of the system to an arbitrary input.

This chapter provides information about using the Control Design and
Simulation Module to measure and analyze the time response of a system.
This chapter also provides information about solving the time-domain
equations and simulating arbitrary inputs.

@ Note Refer to the labview\examples\Control and Simulation\Control
Design\Time Analysis directory for example VIs that demonstrate the concepts
explained in this chapter.

Calculating the Time-Domain Solution

The following equation represents the time-domain solution for a
continuous state-space model.

t

Alxo + J‘eA(t%)Bu(T)d‘c

x(t) = e

0

X, represents any initial conditions of the states in the model. eA’x,
represents the solution of the model at the initial conditions. This solution
is known as the free response.
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t

IeA(FT)B u(7)dt represents the state response for stable systems over

0
time as the inputs #(7) drive the dynamic system from time ¢ = ¢, to ¢. This

solution is the forced response.

The following equation represents the time-domain solution for a discrete
state-space model.

k-1
x(k) = A'%(0)+ 3 47" Bu())

j=0
In this equation, Akx(O) denotes the discrete free response.

k-1
ZAk_j ~'Bu (j) denotes the discrete forced response.

Jj=0

@ Note The VIs discussed in this chapter automatically convert transfer function and
zero-pole-gain models to state-space form before calculating the time-domain solution.

Spring-Mass Damper Example

Control Design User Manual

To illustrate the different time responses you can obtain from a model,
consider the following example of a spring-mass damper, shown in
Figure 5-1.
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o

a=y
ReE

Figure 5-1. Spring-Mass Damper System

In this example, k is the spring constant, u is a force, m is the mass, and b
is the damper coefficient. x is the displacement, which is the distance from
the normal state of the spring to the current position of the spring. You can
represent this spring-mass damper system with the following state-space
model:

1

0
x = Ax+ Bu = k
m

SIS
=
+
I o
<

y = Cx+ Du

[ g g =

For this example, consider the following values:

k=50 = 100kg b= 10HS
cm cm

The following equations define the state-space model.

X = 0 1 X+ 0 u
-0.5 -0.1 0.01

v=[10x+oJu=x
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The following sections show how this system responds to different inputs.

Analyzing a Step Response

The step response of a dynamic system measures how the dynamic system
responds to a step input signal. The following equations define a unit step
input signal.

u(t) =0 when t<0
u(t) =1 when t=20

The Control Design and Simulation Module contains two VIs to help you
measure the step response of a system and then analyze that response. The
CD Step Response VI returns a graph of the step response. The CD
Parametric Time Response VI returns the following response data that
helps you analyze the step response.

Rise time (f,)—The time required for the dynamic system response to
rise from a lower threshold to an upper threshold. The default values
are 10% for the lower threshold and 90% for the upper threshold.

Maximum overshoot (M,)—The dynamic system response value that
most exceeds unity, expressed as a percent.

Peak time (#,)—The time required for the dynamic system response to
reach the peak value of the first overshoot.

Settling time (¢£,)—The time required for the dynamic system
response to reach and stay within a threshold of the final value. The
default threshold is 1%.

Steady state gain—The final value around which the dynamic system
response settles to a step input.

Peak value (yp)—The value at which the maximum absolute value of
the time response occurs.

@ Note You can modify the default values for the rise time thresholds and the settling time
threshold using the Rise Time Thresholds (%) and Settling Time Threshold (%)
parameters of the CD Parametric Time Response VI.

Control Design User Manual
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Figure 5-2 shows a sample step response graph and the locations of the
parametric response data.

A
Yp Mp
t
p »
> v l
4 A e T _____
1%
0 >
t, t
z‘S
t=0
Figure 5-2. Step Response Graph and Associated Parametric Response Data
For example, consider the system described in the Spring-Mass Damper
Example section of this chapter. Figure 5-3 shows how you determine the
step response and associated parametric response data of this system.
Evmboalic & D Construck State-Space Model. vi
B
renasansnal " [A1E] CD Step Response.vi| [5tep Response Graph]
Symbalic = == (5
1&1

eerinbralic C
[k (CD Pararmetric Tirne Response.vi| [Time Response Parametric Data|

=T —

Th
SEmboIic 5] —fﬁ?
[alu:l g v

ariables
[sas

Figure 5-3. Step Response Block Diagram of the Spring-Mass Damper System
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Figure 5-4 shows the Step Response Graph resulting from this block

diagram.

0.04 -
= 0.03-
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=
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Figure 5-4. Step Response Graph of the Spring-Mass Damper System

You can see that the step input causes this system to settle at a steady-state
value of 0.02 cm.

When you use the CD Parametric Time Response VI to analyze the step
response of this system, you obtain the following response data:

¢ Rise time (f,)—1.42 seconds

*  Maximum overshoot (M,)—79.90%

¢ Peak time (#,)—4.54 seconds

¢ Settling time (£,)—89.89 seconds

e Steady state gain—0.02 cm

¢ Peak value (y,)—0.04 cm
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Figure 5-5 shows the output of the CD Parametric Time Response VI.

Om L
o o

O m Cm
o o

o b
o £

Figure 5-5. Parametric Data of the Spring-Mass Damper System

Analyzing an Impulse Response

The impulse response of a dynamic system measures how the system
responds to an impulse input signal. You define an impulse input signal in
the following manner:

¢ Continuous systems—Also known as the Dirac delta function,
a continuous impulse input is a unit-area signal with an infinite
amplitude and infinitely small duration occurring at a specified time.
At all other times, the input signal value is zero.

¢ Discrete systems—Also known as the Kronecker delta function,
a discrete impulse input is a physical pulse that has unit amplitude
at the first sample period and zero amplitude for all other times.

Use the CD Impulse Response VI to calculate the impulse response of a
dynamic system to a standard impulse input. Because the impulse signal
excites all frequencies and the duration of this signal is infinitely small,
the impulse response is the natural response of the system.
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For example, consider the system described in the Spring-Mass Damper
Example section of this chapter. Figure 5-6 shows how you determine the
impulse response of this system.

Eernbolic & =D Construck State-Space Model.vi] [0 Impulse Response.vi] [[mpulse Response Graph|

[abe]H _‘_‘D" T .ﬂl
et b,
SEmboIic E Symbolic * 55

[1b c]phanannas

SEmboIic C

[.lbc

SEmboIic u]

[1be

ariables

(R

Figure 5-6. Impulse Response Block Diagram of the Spring-Mass Damper System

Figure 5-7 shows the Impulse Response Graph resulting from this block

diagram.
0.0z -
= 0.01 -
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=
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Figure 5-7. Impulse Response Graph of the Spring-Mass Damper System

Analyzing an Initial Response

The initial response of a dynamic system measures how the system
responds to a set of non-zero initial conditions. Use the CD Initial
Response VI to determine the initial response of a dynamic system.
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@ Note The CD Step Response VI and the CD Impulse Response VI support initial
conditions. Use the Initial Conditions parameter of these VIs to see how a set of initial
conditions affects the step and/or impulse responses.

For example, consider the system described in the Spring-Mass Damper
Example section of this chapter. Figure 5-8 shows how you determine the
response of this system to an initial condition of 0.3 cm.

Brnbalic & oD Construck State-Space Modelwi]  |CD Initial Response.vi|  [initial Response Graph|

T+ T —
o o [ 5EH|
feke [
Gymbolk E] |symbolc *| [ Conditions 5]

0 o3

arisbles

[GERL e

Figure 5-8. Initial Response Block Diagram of the Spring-Mass Damper System

Figure 5-9 shows the Initial Response Graph resulting from this block
diagram.

Displacerment {cm)
=
|
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Figure 5-9. Initial Response Graph of the Spring-Mass Damper System

Notice that the displacement begins at the initial condition of 0.3 cm.
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Analyzing a General Time-Domain Simulation

A general time-domain simulation of a system involves input signals that
are more general than step, impulse, or initial input signals. Refer to the
Calculating the Time-Domain Solution section of this chapter for equations
representing the time response of continuous and discrete systems. Use the
CD Linear Simulation VI to solve these equations in response to an
arbitrary input signal # into a system. This VI determines the response by
numerically integrating these equations at the specified time steps. You can
define the time steps with the Delta t input.

The system model can be continuous or discrete, but the CD Linear
Simulation VI converts continuous models to discrete models using either
the exponential Zero-Order-Hold or the First-Order-Hold method. Refer to
the Converting Continuous Models to Discrete Models section of
Chapter 3, Converting Models, for more information about these methods.

If this conversion is necessary, you must specify Delta t, which becomes
the sampling time. If no conversion is necessary, Delta t must be equal to
the sampling time of the output data u(?) .

@ Note For accurate results, use a sampling interval that is small enough to minimize the
effects of converting a continuous system to a discrete one. Select this sampling time based
on the location of the poles of the system. Refer to Chapter 8, Analyzing Dynamic
Characteristics, for more information about locating the poles of a system. Also, verify
that the sampling interval matches the sampling time of the output data u(%) .

Control Design User Manual

For example, consider the system described in the Spring-Mass Damper
Example section of this chapter. Figure 5-10 shows how you simulate the
response of this system to a square wave input.
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0.283552

Euild Arra:
0005
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Figure 5-10. Linear Simulation Block Diagram of the Spring-Mass Damper
System Using a Square Wave Input

Notice that the CD Linear Simulation VI converts the continuous
state-space model to a discrete model using the Zero-Order-Hold method.
This conversion uses a Delta t input of approximately 0.3. This block
diagram bundles the state-space model and the square wave as the input to
the Linear Simulation Graph.

Figure 5-11 shows the Linear Simulation Graph resulting from this block

diagram.
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Figure 5-11. Linear Simulation Graph of the Spring-Mass Damper System
Using a Square Wave Input

The scale for the square wave input is on the right-hand side of the graph,
whereas the scale for the linear simulation output is on the left-hand side of
the graph. You can specify any input and use the CD Linear Simulation VI
to observe how the system responds to that input.
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Obtaining Time Response Data

The Time Response VIs return time response data that contains information
about the time response of all input-output pairs in the model. Use the
CD Get Time Response Data VI to access this information for a specified
input-output pair, a list of input-output pairs, or all input-output pairs of the
system.

Refer to the LabVIEW Help, available by selecting Help»Search the
LabVIEW Help, for more information about the CD Get Time Response
Data VL.
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Delays in a system model account for the fact that the inputs and outputs of
a system often do not respond immediately to excitation. For example,
chemical plants transfer fluid and materials between the process
equipment, the actuators, and the sensors. This transportation process can
cause long delays in the output response of the system. To fully represent
this system, a model must incorporate this delay. If a model of this system
does not incorporate delay, you cannot predict how well a controller based
on that model performs.

A system model can have the following three types of delay:
* Input delay—The time a past input takes to affect the current output

*  Output delay—The time an output takes to respond to the current
system input

*  Transport delay—The time the dynamics of a system take to respond
to a particular excitation

The total delay of a system model is the sum of all delays between each
input-output pair. The total delay includes all input, output, and transport
delays in the system model. Another type of delay, residual delay, results
from certain operations. Refer to the Residual Delay Information section of
this chapter for more information about residual delay.

Constructing a model in the LabVIEW Control Design and Simulation
Module sets delay information but does not make that information part of
the mathematical model. The Control Design and Simulation Module
provides several VIs that you can use to transfer delay information from the
model properties into the mathematical model. After you incorporate delay
into a mathematical model, the model properties no longer contain delay
information, and the delay information appears in any analysis you perform
on the model.

This chapter provides information about using the Control Design and
Simulation Module to account for delay information in a model and to
manipulate delay information within a model.
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@ Note Refer to the labview\examples\Control and Simulation\Control
Design\Model Delay directory for example VIs that demonstrate the concepts explained
in this chapter.

Accounting for Delay Information

Accounting for delay information in a model involves the following

two steps: setting delay in the properties of a model, and transferring that
delay from the model properties to the mathematical model. The following
sections provide information about the Control Design VIs that you can use
to accomplish these tasks.

Setting Delay Information

By default, when you construct a model in the Control Design and
Simulation Module, the properties of that model have a delay of zero. Use
the CD Set Delays to Model VI to define any non-zero delays in a model.
You can use the Input Delays, Output Delays, and Transport Delays
inputs of this VI to define the input, output, and transport delays in a model.
The properties of the resulting Model Out output contain the original
model with the delay information you defined.

You also can retrieve the delay information from the properties of a model
with the CD Get Delays from Model VI. This VI returns the input, output,
and transport delays of a model in the Input Delays, Output Delays, and
Transport Delays outputs, respectively.

Incorporating Delay Information

After you define any delay information in a model, you then can make that
delay a permanent part of the model. Incorporating delay information into
a model works differently for continuous system models and discrete
system models. In both cases, you represent a common delay factor and
multiply the system model by this factor. The process by which you
determine this factor, however, varies depending on the type of system
model. With continuous system models, you apply the Laplace
transformation to the system to represent the delay as an exponential factor.
With discrete system models, you apply the shift operator to the system to
represent the delay as a factor.

The delay factor for a continuous system is e*'¢. The delay factor for a
discrete system is z™"¢. Refer to the Delay Information in Continuous
System Models section and the Delay Information in Discrete System
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Models section of this chapter for information about these delay factors and
incorporating them into system models.

@ Note These delay factors do not always have the same value in systems with more than

one input-output pair. Single-input multiple-output (SIMO), multiple-input single-output
(MISO), and multiple-input multiple-output (MIMO) system models have more than one
input-output pair, and the delay might be different between each pair. Conversely, because
single-input single-output (SISO) systems only have one input-output pair, the delay factor
in a SISO system model always has the same value. Refer to the Residual Delay
Information section of this chapter for more information about systems that do not have a
common delay factor.

Use the CD Convert Delay with Pade Approximation VI to incorporate
delay information into continuous models. Use the CD Convert Delay to
Poles at Origin VI to incorporate delay information into discrete models.
If you incorporate the delays in the model using one of these VIs, the
Dynamic Characteristics VIs and the State Feedback Design VIs account
for the delays in their results. Refer to the LabVIEW Help, available by
selecting Help»Search the LabVIEW Help, for more information about
which VIs account for delays.

The following sections provide information about using the Control Design
and Simulation Module to incorporate delay into continuous and discrete
system models.

Delay Information in Continuous System Models

Mathematically, incorporating delay into a continuous system model
involves evaluating that model at ¢, units in the past, where ¢ is the current
time. For example, consider the continuous SISO system model A(f). To
represent this model at #, units in the past, subtract , from ¢ in the evaluation
of the system model /(#). The expression h(t — t;) represents this operation.

The first step in incorporating delay into a continuous system model is
factoring a common delay out of the system model. Applying the Laplace
transformation to the system model accomplishes this step. The following
equation gives the Laplace transformation of h(f — ;).

LIh(t—1))] th(t_zd)e*‘”dt - '[h(t_td)e’s(””)d(z_td)e*”d = H(s)e™"
0 0
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This equation shows that the Laplace transform of a function delayed #,
units of time in the past is identical to the product of the Laplace transform
of the original function and the factor e™% where s is the Laplace variable.
Thus, you can incorporate delay into 4(¢) by multiplying H(s) by the delay
factor e,

For example, consider the continuous SISO transfer function H(s) with
output Y(s) and input U(s). Because e*“ represents the delay factor,
H(s)e *"" defines a system that has a transport delay.

Sty = Xs)
H(s)e UGs)

You also can represent the delay as an input delay or output delay. Applying
the delay factor e™*" to the input U(s) results in an input delay as shown in
the following equation:

H(s) = —X8)
eU(s)

Conversely, applying the delay factor to the output Y(s) results in an output
delay shown in the following equation:

sty
H(s) = &X(5)

U(s)
Figure 6-1 shows the mathematical representation of transport, input, and
output delay factors for a continuous system.

Llu]=Us) —»|  H(s)esta | —B L[y(H] = V(s)

LIu(t=tg)] = Us)e~Sld —> H(s) —> Y(s)

Uis) —» H(s) — L[Y(t+ tg)] = Y(s)eSld

L: Laplace Transform

Figure 6-1. Mathematical Representation of Transport, Input, and
Output Delay for a Continuous System
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To accommodate the delay factor, you can convert e *’* from exponential
form to a rational polynomial function. You can perform this conversion
using the Padé approximation method. Use the CD Convert Delay with
Pade Approximation VI to calculate a Padé approximation. This VI
incorporates the delay information of the input model into the
Converted Model output model. The delay becomes a part of the output
model and thus is not in the model properties. In the case of SIMO,
MISO, and MIMO system models, the CD Convert Delay with Pade
Approximation VI calculates the total delay in all the input-output pairs
before incorporating the delay into the model.

This conversion process has several benefits. First, connecting models
that contain all rational polynomial functions is less complicated than
connecting models that contain a mixture of exponential factors and
rational polynomial functions. Second, when you incorporate the delay into
the polynomial function, the controller structure, analysis operations, and
synthesis operations account for the delay.

@ Note The CD Convert Delay with Pade Approximation VI converts a state-space model
to a transfer function model before incorporating the delay information. This VI then
converts the resulting model back to a state-space model. As a result, the final states of the
model might not directly correspond to the original states. Refer to Chapter 3, Converting
Models, for more information about converting between model forms.

For example, consider a continuous SISO system with an input delay of
25 seconds. The delay factor in this system is 2%, so the following
equation represents the system:

Y(s)

H(s) = e255U(s)
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Figure 6-2 shows the step response of this system.

40-

1 1 1 1 1 1
0 25 50 75 100 125 150 175
Time (s}

Figure 6-2. Step Response with a 25-Second Delay

You can see that incorporating e~2% into the input of H(s) delays the step
response of H(s) by 25 seconds. Refer to the Analyzing a Step Response
section of Chapter 5, Time Response Analysis, for information about a step
response.

You can use the Polynomial Order input of the CD Convert Delay with
Pade Approximation VI to affect the accuracy of the approximation. A
larger Polynomial Order means a more accurate approximation but results
in a higher-order system model. A large Polynomial Order can have the
unintended side effect of making a model too complex to be useful.

Figure 6-3 shows the effects of polynomial orders on the accuracy of a Padé
approximation of H(s).

40- 40-
30— 30—
4 20- 4 20-
2 2
= =
g 10— g 10—
- -
-10-, 1 1 1 1 1 1 10 1 1 1 1 1 1 1
a 25 75 100 125 150 175 a 25 50 75 100 125 150 175
Time (s} Time (s}
Polynomial Order Input Delays Polynomial Order
A .
¥ T)IU I;‘Zs 4
I - X ]
a 2 4 & 12 14 16 18 20 a 2 4 & & 10 12 14 16 18 20
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Figure 6-3. Effect of Polynomial Orders for a Padé Approximation
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Delay Information in Discrete System Models

Mathematically, incorporating delay into a discrete system model involves
evaluating that model at n,units in the past. nyequals the delay divided by
the sampling time 7 of the system. For example, consider the discrete SISO
system model y(k). The equation y(kT — n,T') provides the output of y(k) at
ngunits in the past, where k represents the current sample. Removing the
sampling time 7 from this equation provides the simplified equation

y(k — ny). This simplified equation produces the same result as y(kT — n,T).

This equation shows the delay factor z™"¢ for a discrete system model,
where 7z represents time in the discrete domain. You use z™ to evaluate
y(k) at n; samples in the past. The following equation shows this process,
which also is known as applying the shift operator.

y(k=ng) = y(k) -z

In transfer function models and zero-pole-gain models, incorporating delay
information means adding poles at the origin. By applying z " to a transfer
function or zero-pole-gain model, you increase the order of the
denominator polynomial by adding n, poles at the origin. In state-space
models, incorporating delay information means creating n, additional
states.

Use the CD Convert Delay to Poles at Origin VI to incorporate delays into
discrete models. This VI incorporates the delay information of the input
model into the Converted Model output model. The delay becomes a part
of the output model and thus is not in the model properties. In the case of
SIMO, MISO, and MIMO system models, the CD Convert Delay to Poles
at Origin VI totals the delay in all the input-output pairs before
incorporating the delay into the model.

Figure 6-4 shows how you can create a transfer function model, define an
input delay for the model properties, and then incorporate that delay
directly into the model.

Transfer Function Model In]

[E=5H
Input Delays | (70 2ot Delays to Modelvi] [CD Convert Delay to Poles at Origin.vi]
i} 2 = =

e nLITransFer Funickion Converbed Model|
T o |

Figure 6-4. Adding Delay Information to a Discrete Transfer Function Model
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Figure 6-5 shows the resulting transfer function model. The CD Convert
Delay to Poles at Origin VI accounted for the input delay by increasing the
number of poles at the origin in the model. Accordingly, the Transfer
Function Converted Model has a larger order denominator than the
Transfer Function Model In.

Delay not in Model !—f

Delay in Model

o
o € o e

Figure 6-5. Additional Poles Accounting for the Input Delay

The Transfer Function Converted Model expresses the additional poles
at the origin with two additional zeros in the denominator.

Representing Delay Information

To illustrate how the Control Design and Simulation Module represents
delay in a system model, consider the following MIMO transfer function
equation, where U is the input transfer function matrix and Y is the output
transfer function matrix.

H=Y
U
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The following equations define this MIMO transfer function:

The following equations define the transport delay matrix T, the input
delay vector I,;, and the output delay vector O,. Refer to the Delay
Information in Continuous System Models section of this chapter for the
definition of the continuous delay factor e™*%.

=Sty =Sl —st st
_ e e _ e _ e

=Sty  —Sly
e

To incorporate this delay information into H, compute the product of the
transfer function, input, and output matrices with their respective delay
matrices or vectors. H,, shown in the following equation, represents H with
delay information included.

Y
H, =4
Ud

The following equations show the computation of these transfer functions
to incorporate delay.

H =St H —Sti; H. H —st;, =St
H, = 11¢ 12€ =H-T,=|"n"n2. e e
st st —sty st
H21€ 21 sze 22 H21 H22 e 21 e 22
U,e5h U sty
U,=|"! =U-I,=| '-|¢
Uye™ " Uy| [en
Y. et Y st,
YdE 1 = Y- Od — 1 e
Y2 et _Y2 et
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To represent the delay of each element, you can use the following matrices:

t, t t t
Td — 11 12 Id — 1 Od — a
by Iy 5 2
Because the number of rows and columns of T, are the same as the

dimension of vectors I; and O, you can represent all the delay information
of a model using the following structure:

[ 1)
t til|la
by b [T
In this delay matrix, the input delay vector I,;is on top. Each input uses

one column. The output delay vector O, is on the right-hand side. Each
output uses one row.

Manipulating Delay Information

The Control Design and Simulation Module provides two VIs to help you
manipulate the delay information of a system model. Use the CD Distribute
Delay VI to minimize the transport delay of a system model by distributing
the transport delay information to the inputs and outputs of a system model.
Use the CD Total Delay VI to distribute the input and output delay of a
model to the transport delay. The following sections provide information
about using these VIs to manipulate delay information.

Accessing Total Delay Information

Control Design User Manual

The CD Total Delay VI transfers delay information from the inputs and
outputs of a system model to the transport delay of a system model by
adding the input and output delays to the delay in the transport delay
matrix. When you use the CD Total Delay VI, other Control Design VIs can
access the total delay information of a system.
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For example, consider a model with the following delay information. Refer
to the Representing Delay Information section of this chapter for the
derivation of this matrix and these vectors.
el [
1
2

fhto| |l _ |21

fo1 Iy |1 10
The CD Total Delay VI first transfers the input delay information to the
transport delay matrix. The following equations show this process:

1-12-2]  Joo
e liRal

The CD Total Delay VI then transfers the output delay information to the
0 0

transport delay matrix. The following equations show this process:
3+1 3+1(|1-1]_1|44||0
2+2  2+2||2- 44|10

Figure 6-6 shows the output of the CD Total Delay VI.

Tatal Delay
%)'U_ 14.0000 14,0000
%)]n_ 14.0000 |4.0000

Figure 6-6. Resulting Total Delay

The input and output delay vectors are now |:0 0:| and {0}, respectively.
0
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Distributing Delay Information

The CD Distribute Delay VI calculates the total delay of a system model,
then uses a common delay factor to distribute the total delay between the
inputs and outputs. This operation minimizes the non-zero elements of
the transport delay matrix. The CD Distribute Delay VI transfers delay

information to the input delays before transferring delay information to the
output delays.

@ Note Some Control Design VIs internally distribute the delay to preserve as much delay

information as possible in the resulting model. Refer to the LabVIEW Help to determine
which VIs manipulate the transport delay matrix to preserve delay information.

For example, consider the system model described in the Accessing Total
Delay Information section of this chapter. If you apply the CD Distribute
Delay VI to this system model, you get the following equation:

o] [44]

4.4/10] _10 0|0

4 4]0 00]|0
Because 4 is the common factor among the transport delay matrix, the CD
Distribute Delay VI transferred a delay of 4 to the input delays.

Figure 6-7 shows the output of the CD Distribute Delay VI.

) Input Delays

9o Jam  Jam

. Transport Delays ) Qukput Delays
P Jow Joow | o Powo |

Figure 6-7. Resulting Delay Distribution

The input and output delay vectors are now [4 4} and H, respectively.
0
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Figure 6-8 shows how you implement this example using the Control
Design and Simulation Module.

[rransfer Function Model In]
== pmmmnunﬂ
Input Delays CD Set Delays to Model.w] [CD Tatal Delay.vi] otsl Del
1 = i; T ]
st
At Ee
Dutpuk Delays
ne TF ~ TF ~
Transpork Delays 3
D Distribute Delay . vi foutput Delays
0 211 =1
] ila .E_“;tn:l :
L
TF - 4

Figure 6-8. Totaling and Distributing the Delay Information in a Model

Residual Delay Information

Residual delay information is transport delay information that remains
when the CD Distribute Delay VI cannot distribute all of the transport delay
to the inputs or outputs. This situation most often occurs in SIMO, MISO,
and MIMO system models because each input-output pair can have
different delay information.

For example, consider a system model with the following delay
information:
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Control Design User Manual

The CD Distribute Delay VI first distributes the delay in the transport delay
matrix to the input delay vector by subtracting the minimum value from
each column in the transport delay matrix. In this case, the minimum value
in both columns is 3. This VI then distributes the delay to the output delay
vector by subtracting the minimum value from each row in the resulting
transport delay matrix. In this case, only the second row has a minimum
value other than 0.

oo [33 [33
s3lfo] [20][o] [20][0
4 4llo[=|11]|o| =0 0| |1
3500l lo2/lo] [o2]|o

Because the CD Distribute Delay VI cannot fully distribute all the delays,
the transport delay matrix contains the residual delay information.
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The frequency response of a dynamic system is the output of a system given
unit-amplitude, zero-phase, sinusoidal inputs at varying frequencies. You
can use the frequency response of a system to locate poles and zeros of a

system. Using this information, you then can design a controller to improve
unwanted parts of the frequency response.

When applied to the system, a sinusoidal input with unit amplitude, zero
phase, and frequency o produces the following sinusoidal output.

H(io) = A(w)e" "™

A is the magnitude of the response as a function of ®, and ¢ is the phase.
The magnitude and phase of the system output vary depending on the
values of the system poles, zeros, and gain.

This chapter provides information about using the LabVIEW Control
Design and Simulation Module to perform Bode frequency analysis,
Nichols frequency analysis, and Nyquist stability analysis.

@ Note Refer to the labview\examples\Control and Simulation\Control
Design\Frequency Analysis directory for example VIs that demonstrate the concepts
explained in this chapter.

Bode Frequency Analysis

Use Bode plots of system frequency responses to assess the relative
stability of a closed-loop system given the frequency response of the
open-loop system. By analyzing the frequency response, you can determine
what the open- and closed-loop frequency responses of a system imply
about the system behavior. Use the CD Bode VI to create a Bode plot.

@ Note Use the CD Evaluate at Frequency VI to determine the frequency at specified values.
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For example, consider the following transfer function that represents a
linear time-invariant system.

Applying the sinusoidal input x(¢) = sin (®?) to this previous system
produces the following equation:

y(t) = Ysin(otf+0)

Using this equation, the following equation represents the complex
frequency response.

H(i®) = A(w)e' ™

You can separate the complex frequency response equation into

two parts—the magnitude A(®) and the phase ¢p(®). You obtain the
magnitude from the absolute value of the response. You obtain the phase
value from the four-quadrant arctangent of the response. The following
equations illustrate these operations:

A(®) = |H(io)|

o(w) = LH(iw) = atan[lmagi”a”y H(ioo)}

Real H(iw)

These two equations represent the magnitude and the phase of the
frequency response, respectively. Plotting these equations results in

two subplots—the Bode magnitude plot and the Bode phase plot. The Bode
magnitude plot shows the gain plotted against the frequency. The Bode
phase plot shows the phase, in degrees, as a function of the frequency.

Use a linear scale when dealing with phase information. When using a
linear scale, you can add the individual phase elements together to
determine the phase angle.

Because you can add the magnitude and phase plots for systems in series,
you can add Bode plots of an open-loop plant and potential compensators
to determine the frequency response characteristics of the dynamic system.
Bode plots also illustrate the system bandwidth as the frequency at which
the output magnitude is reduced by three decibels or attenuated to
approximately 70.7% of its original value. You also can use the

CD Bandwidth VI to determine the system bandwidth.
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You can measure how close a system is to instability by examining the
value of the magnitude and phase at critical values. These values, gain
margin and phase margins, are important because real-life models and
controllers are prone to uncertainties. Low gain or phase margins indicate
potential instability.

The following sections provide information about gain and phase margins.

Gain Margin

The gain margin indicates how much you can increase the gain before the
closed-loop system becomes unstable. This critical gain value, which
causes instability, indicates the location of the closed-loop poles of the
system on the imaginary axis.

You often use this analysis on systems where G(s) consists of a gain K and
a dynamic model H(s) in series. For cases where increasing the gain leads
to system instability, the system is stable for a given value of K only if the
magnitude of KH(s) is less than 0 dB at any frequency where the phase of
KH(s) is —180°.

The Bode magnitude plot displays the gain margin as the number of
decibels by which the gain exceeds zero when the phase equals —180°,
as shown in Figure 7-1.

Phase Margin

The phase margin represents the amount of delay that you can add to a
system before the system becomes unstable. Mathematically, the phase
margin is the amount by which the phase exceeds —180° when the gain is
equal to 0 dB. The phase margin also indicates how close a closed-loop
system is to instability. A stable system must have a positive phase margin.
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Figure 7-1 shows Bode plots with corresponding gain and phase margins.

Figure 7-1. Gain and Phase Margins

Depending on the complexity of the system, a Bode plot might return
multiple gain and/or phase margins.

Control Design User Manual 7-4 ni.com



Chapter 7 Frequency Response Analysis

Nichols Frequency Analysis

Use Nichols frequency analysis to obtain the closed-loop frequency
response of a system from the open-loop response. Open-loop response
curves, or loci, of constant magnitude and phase often provide reference
points that help you analyze a Nichols plot. Each point on the open-loop
response curve corresponds to the response of the system at a given
frequency. You then can read the closed-loop magnitude response at that
frequency from the Nichols plot by identifying the value of the magnitude
locus at which the point on the curve intersects. Similarly, you can
determine the closed-loop phase by identifying the phase locus at which the
open-loop curve crosses.

Use the CD Nichols VI to create a Nichols plot and examine system
performance in dynamic systems. The CD Nichols VI calculates and plots
the open-loop frequency response against the gain and phase on the Nichols
plot. Different points on the plot correspond to different values of the
frequency ®. Examine the Nichols plot to determine the gain and phase
margins, bandwidth, and the effect of gain variations on the closed-loop
system behavior.

Nyquist Stability Analysis

Use Nyquist stability analysis to examine the system performance of
dynamic systems. Nyquist plots consist of the real part of the frequency
response plotted against the imaginary part of the response. Nyquist plots
indicate the stability of a closed-loop system, given an open-loop system,
which includes a gain of K. Use the CD Nyquist VI to create a Nyquist plot.

The Nyquist stability criterion relates the number of closed-loop poles of
the system to the open-loop frequency response. On the Nyquist plot, the
number of encirclements around (-1, 0) is equal to the number of unstable
closed-loop poles minus the number of unstable open-loop poles.
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You can use this criterion to determine how many encirclements the plant
requires for closed-loop stability. For example, if the plant has all
open-loop stable poles, there are no encirclements. If the plant has

one open-loop unstable pole, there is one negative, counter-clockwise
encirclement. Figure 7-2 shows a system with one unstable pole.

MWy quist Plok
1.2-
1(s+8)s+3) 1-
(s+9)s-2) 0.8-
0.6-
0.4-
0.2-
0-
-0.2-
0.4
'0.6_
0.8~
-1 -

-lz-, I 1 1 1 1
-1.5 -1 -0.5 0 0.5 1
Real Axis

Platd ™

Equation

Imaginary Axis

Figure 7-2. Nyquist Plot of One Unstable Pole

Often you want to determine a range of gain values for which the system is
stable, rather than testing the stability of the system at a specific value of K.
To determine the stability of a closed-loop system, you must determine how
arange of gain values affects the stability of the system.

Consider the following closed-loop transfer function equation with output
Y(s) and input U(s), where K is the gain.

Y(s) _  KH(s)
U(s) 1+KH(s)

The closed-loop poles are the roots of the equation 1 + KH(s) = 0. The
complex frequency response of KH(s), evaluated for s = i® in continuous
systems and ¢‘®T for discrete systems, encircles (-1, 0) in the complex
plane if 1 + KH(s) encircles (0, 0). If you examine the Nyquist plot of H(s),
you can see that an encirclement of (—1/K, 0) by H(s) is the same as an
encirclement of (—1, 0) by KH(s). Thus, you can use one Nyquist plot to
determine the stability of a system for any and all values of K.
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Obtaining Frequency Response Data

The Frequency Response VIs discussed in this chapter return frequency
response data that contains information about the frequency response of all
input-output pairs in the model. The frequency response information for the
CD Bode VI returns information about the Bode magnitude and Bode
phase. The frequency response information for the CD Nichols VI returns
information about the real and imaginary parts of the frequency response.
The frequency response information for the CD Nyquist VI returns
information about the open-loop gain and open-loop phase. Use the CD Get
Frequency Response Data VI to access this information for a specified
input-output pair, a list of input-output pairs, or all input-output pairs of the
system.

The CD Get Frequency Response Data VI uses the Frequency Response
Data input, which contains the frequency response information for all the
input-output pairs of a system model. For state-space models, the CD Get
Frequency Response Data VI returns the frequency response of the
input-state pair(s). Because transfer function and zero-pole-gain models do
not have states, the frequency response data for an input-state pair of these
forms is an empty array.

Refer to the LabVIEW Help, available by selecting Help»Search the
LabVIEW Help, for more information about using the CD Get Frequency
Response Data VI.
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Analyzing Dynamic
Characteristics

5

Any given dynamic system has numerous dynamic characteristics such as
stability, DC gain, damping ratio, natural frequency, and norm. You can
use the LabVIEW Control Design and Simulation Module to analyze a
system in terms of these characteristics.

This chapter provides information about using the Control Design and
Simulation Module to analyze the stability of a dynamic system. This
chapter also describes how to use the root locus method to analyze the
stability of a system.

Note Refer to the labview\examples\Control and Simulation\Control
Design\Dynamic Characteristic Analysis directory for example VIs that
demonstrate the concepts explained in this chapter.

Determining Stability

The stability of a system depends on the locations of the poles and zeros
within the system. To design an effective controller, you must take these
locations into account.

A continuous system is stable if all poles are on the left half of the complex
plane. A discrete system is stable if all poles are within a unit circle
centered at the origin of the complex plane. Additionally, both types of
systems are stable if they do not contain any poles.

A continuous system is unstable if it contains at least one pole in the right
half of the complex plane. A discrete system is unstable if at least one pole
is outside of the unit circle in the complex plane. Additionally, both types
of systems are unstable if they contain more than one pole at the origin.

In terms of the dynamic response associated with the poles and zeros of a
system, a pole is stable if the response of the pole decays over time. If the
response becomes larger over time, the pole is unstable. If the response
remains unchanged over time, the pole is marginally stable. To describe a
system as stable, all the closed-loop poles of a system must be stable.
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Chapter 8 Analyzing Dynamic Characteristics

Continuous and discrete systems are marginally stable if they contain only
one pole at the origin and no positive poles.

Use the CD Pole-Zero Map VI to obtain all the poles and zeros of a system
and plot their corresponding locations in the complex plane. Use the CD
Stability VI to determine if a system is stable, unstable, or marginally
stable.

Using the Root Locus Method
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The root locus method provides the closed-loop pole positions for all
possible changes in the loop gain K. Root locus plots provide an important
indication of what gain ranges you can use to keep the closed-loop system
stable. The root locus is a plot on the real-imaginary axis showing the
values of s that correspond to pole locations for all gains, starting at the
open-loop poles, K = 0 and ending at K = co.

You can rewrite the characteristic equation of a closed-loop system using
the following equation, where N(s) is the numerator and D(s) is the
denominator.

1+KH(s) = D(s)+KN(s) = 0

This equation restates the fact that the open-loop system poles, which
correspond to K = 0, are the roots of the transfer function denominator,
D(s). As K becomes larger, the roots of the previous characteristic equation
approach either the roots of N(s), the zeros of the open-loop system, or
infinity. For a closed-loop system with a non-zero, finite gain K, the
solutions to the preceding equation are given by the values of s that satisfy
both of the following conditions:

|KH(s)| = 1 ZH(s) = +2k+ )1 (k=0,1,...)

Use the CD Root Locus VI to compute and draw root locus plots for
continuous and discrete SISO models of any form. You also can use this VI
to synthesize a controller. Refer to the Root Locus Design Technique
section of Chapter 11, Designing Classical Controllers, for information
about using the CD Root Locus VI to design a controller.
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Analyzing State-Space
Characteristics

5

State-space analysis involves analyzing the state variables of a system.
State variables describe the relationship between the inputs and outputs of
a system. These variables often have physical meaning and represent some
internal state of the system under analysis. For example, consider a motor
that has power as its input and speed as its output. If you represent this
system as a state-space model, the state variables are speed and rotation
angle.

To design an effective controller, you must perform a state-space analysis
on the controller model. State-space analysis determines whether a system
is stable, controllable, observable, stabilizable, or detectable. You can use
state-space analysis to balance a system model. Balancing a system model
is useful in both analyzing and synthesizing a controller. You also can use
state-space analysis to define different representations of the same system.

Because you can choose a variety of state variables to represent a single
system, the state-space form for a given linear time-invariant multiple-input
multiple-output (MIMO) system is not unique. You must determine which
state variables are best for the analysis and design of a state-space
controller.

This chapter provides information about using the LabVIEW Control
Design and Simulation Module to perform state-space analysis.

Note Refer to the labview\examples\Control and Simulation\Control
Design\State-Space Analysis directory for example VIs that demonstrate the
concepts explained in this chapter.
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Chapter 9 Analyzing State-Space Characteristics

Determining Stability

In state-space form, the time evolution of the states determines the stability
of the system. If you have initial conditions and you eliminate all inputs to
the system, only the state matrix A governs the response of the system. You
then apply control theory to find the counterparts of poles, which you can
use in transfer function and pole-zero analysis.

The counterparts of poles are the eigenvalues of the state matrix A.

The location of these eigenvalues determines the stability of the system.
A continuous system is stable if all eigenvalues of A have negative real
parts. A discrete system is stable if these eigenvalues fall within the unit
circle.

Determining Controllability and Stabilizability
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A system is controllable if all the states that describe the system respond to
an input of the system, that is, you can influence the states of the system
independently by adjusting the inputs. A system is not controllable if the
system contains states that remain unaffected by any input.

If a system is controllable, there is an input that forces the system states, or
linear combination of states, to go from any initial condition at ¢ = 0 to zero
at any time ¢ > 0. If a system is open-loop unstable, you can adjust the input
to affect the response of the states.

You can confirm the controllability of a system by verifying that the
controllability matrix @, shown in the following equation, has full row rank
or is nonsingular.

The state matrix A and the input matrix B determine the controllability
properties of a state-space model. You use these matrices to calculate Q,
as shown in the following equation:

Q=B AB ... A" 'B]
A system is controllable if Q has full row rank or is nonsingular.
For example, if B is an n-dimensional column vector that is colinear to an

eigenvector of null eigenvalues of A, you obtain the following matrix:

Q=[B00..0]
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This matrix is row rank deficient for n > 1. The null eigenvalue represents
an uncontrollable mode of the system.

From the definition of a controllable system you can conclude that to place
the system states at zero at any time ¢ > 0 indicates that you can place all
system poles anywhere to make the closed-loop response reach zero at time
t as quickly as possible.

When you can adjust all system poles locations to a point you want, you can
calculate a full state-feedback controller gain K to arbitrarily place the
eigenvalues of the closed-loop system, A' = A — BK. Conversely, the
eigenvalues associated with modes that are not controllable cannot be
adjusted, regardless of the value you choose for K.

Stabilizability is related to controllability. A system is stabilizable if all the
unstable eigenvalues are controllable. Controllability implies
stabilizability, but stabilizability does not imply controllability.

Use the CD Controllability Matrix VI to calculate the controllability matrix
of the model and determine if the system is controllable and/or stabilizable.
Use the CD Controllability Staircase VI to transform a state-space model
into a model that you can use to identify controllable states in the system.
You also can use the CD Controllability Staircase VI to inspect the A and
B matrices of the transformed model to determine the controllable states.

Determining Observability and Detectability

A system is observable if you can estimate each state of the system by
looking only at the output response. If you can determine the states at
time 7, by observing the output from time 7y to #;, the system is observable.

Observability depends on the output matrix C and the state matrix A of the
system. You can check observability by verifying that the observability
matrix O, defined in the following equation, is full column rank or is
nonsingular for a SISO system.

CA

c4a"!
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Use a state estimator to calculate the states of any observable system with
a column-deficient matrix C. Refer to Chapter 13, Defining State Estimator
Structures, for information about state estimators.

Detectability is related to observability. A system is detectable if all the
unstable eigenvalues are observable. Observability implies detectability,
but detectability does not imply observability.

Use the CD Observability Matrix VI to calculate the observability matrix
of a model and determine if the system is observable and/or detectable. Use
the CD Observability Staircase VI to transform a state-space model into a
model that you can use to identify observable states in the system. Use the
CD Observability Staircase VI to calculate the observability matrix of the
transformed model. You also can use the CD Observability Staircase VI to
inspect the A and C matrices of the transformed model to determine the
observable states.

Analyzing Controllability and Observability Grammians
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An alternative and numerically more stable approach to assessing
controllability and observability is to compute the Grammians of the
state-space matrices. The controllability Grammian is an n X n matrix that
determines how dependent the state responses are on the different inputs of
the system. Independent state responses indicate that there always is a set
of inputs that can drive the states to zero at a certain time. In this case, the
system is controllable.

Calculate the eigenvalues of the controllability Grammian to check the
dependency of the state responses. If the controllability Grammian is
positive-definite, meaning all eigenvalues are real and greater than zero,
the chosen state-space form is controllable.

Similarly, the observability Grammian is an n X n matrix that determines
how dependent the state effects are on the different outputs of the system.
Independent state effects indicate that there always is a set of outputs that
you can use to estimate the states at time 7 = 0. In this case, the system is
observable.

Calculate the eigenvalues of the observability Grammian to check the
dependency of the responses of the states. If the observability Grammian is
positive-definite, meaning all eigenvalues are real and greater than zero, the
chosen state-space form is observable.
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Use the CD Grammians VI to calculate the controllability and observability
Grammians of a state-space model for a stable system.

Balancing Systems

A system is balanced if the controllability and observability diagonal
Grammians of that system are identical. A balanced model simplifies the
analysis and use of model order reduction. Refer to Chapter 10, Model
Order Reduction, for more information about model order reduction.

In model order reduction, balancing highlights the relative importance of
the state to the input/output performance of the system. Balancing consists
of finding a similarity transformation from the original model to generate a
state-space representation. Use the CD Balance State-Space Model
(Diagonal) VI and the CD Balance State-Space Model (Grammians) VI to
balance a state-space system.

If you use the CD Balance State-Space Model (Grammians) VI, the
Balanced Model output of this VI has equal and diagonal controllability
and observability Grammians. To use this VI, the system must be stable,
controllable, and observable.

If you use the CD Balance State-Space Model (Diagonal) VI, the balanced
state-space model has an even eigenvalue spread for the state matrix A or

the composite matrix, which contains the natural composition of A, B,
and C.
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Model Order Reduction

In most cases, different models of a dynamic system can represent the same
input-output behavior of that system. For example, you can have two
state-space models with different numbers of states that represent the same
input-output behavior at varying degrees of accuracy. Often you can
simplify, or reduce, these models to obtain a less complicated
representation of the system.

How you reduce a model depends on the representation of the model. If the
model is a state-space model, reducing the number of states reduces the
order of the model. If the model is a transfer function or zero-pole-gain
model, cancelling matching poles and zeros reduces the order of the model.
Use the Model Reduction VIs to reduce the order of a model.

This chapter provides information about the minimal realization and model
order reduction techniques you can use to simplify a model.

@ Note Refer to the labview\examples\Control and Simulation\Control
Design\Model Reduction directory for example VIs that demonstrate the concepts
explained in this chapter.

Obtaining the Minimal Realization of Models

The minimal realization of a system model involves cancelling all pairs of
poles and zeros at the same location. You refer to these pairs as pole-zero
pairs. Use the CD Minimal Realization VI to calculate the minimal
realization of a model.

For example, consider the following transfer function model H(s).

SSH6s+8 (s +2)(s+4)  _ (s+2)

H(s) = 5—— = -
s —8s =215+ 108 (+H(s-3)(s-9) (s-3)(s-9)

} Minimal Realization

This model has a pole and zero in the same location, —4. Wire this model
into the CD Minimal Realization VI to cancel this pole-zero pair. This VI
returns the minimal realization of the model in the Reduced Model output.
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This VI also returns the number of pole-zero locations removed. For
state-space models, this VI returns the number of states removed.

Minimal realizations are minimal because the only modes represented in
the model are those modes that you can infer by observing the inputs and
outputs of the system. The modes that you eliminate to obtain a minimal
transfer function or zero-pole-gain model still exist in the system, but you
cannot infer their existence by simply observing the input and outputs of
the model. For this reason, you do not want to cancel unstable pole-zero
pairs.

For example, consider the following transfer function model G(s).

Gls)e— S =25=8  __ (s+2)(s=4) _ _ (s+2)
s — 165"+ 755108 (S=H(s=3)(s=9) (s-3)(s-9)

} Minimal Realization

G(s) has the same minimal realization as H(s), but G(s) contains an unstable
pole-zero pair at 4. If you cancel this pole-zero pair, you no longer can
observe any effects the pair has on the stability of the system.

A minimal realization for a state-space model is a state-space
representation in which you remove all states that are not observable

or controllable. Use the CD Minimal State Realization VI to determine the
minimal realization for a state-space model. Refer to Chapter 9, Analyzing
State-Space Characteristics, for information about controllability and
observability.

Reducing the Order of Models

In certain situations, you might want to work with a lower-order model of
the system. The goal of model order reduction is to remove stable states that
have the smallest impact on the input-output model representation. You
might want to reduce a model order when the real part of stable system
poles differ significantly. From an input-output standpoint, you usually
ignore fast dynamic modes, which are modes that correspond to stable
eigenvalues far from the imaginary axis, because you only see the effects
of these modes over a short initial period of time. Use the CD Model Order
Reduction VI to reduce high-order models.

E Note Model order reduction applies only to a state-space model of a system.
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You can reduce the order of the model by decreasing the order of the stable
modes. Reducing stable modes of the model does not affect the unstable
modes of the model.

You have several options for reducing the order of a model. You can match
the DC gain between the reduced order model and the original model. You
also can delete the states directly.

Balancing the original state-space model can make the model order
reduction process easier. When you balance the state-space model, the
Grammian matrices are diagonal and you avoid computing the eigenvalues.

Given a state-space model, complete the following steps to reduce the
model order:

1. Balance the state-space model.
2. Compute the Grammians.

3. Remove stable states corresponding to small eigenvalues, in
proportion to the other eigenvalues, of the Grammian matrix.

4. Repeat steps 1 through 3 until the model is of the order you want.

Refer to the CDEx Model Reduction with Grammians VI, located in the
labview\examples\Control and Simulation\Control Design\
Model Reduction directory, for an example of this procedure.

Refer to the Analyzing Controllability and Observability Grammians
section and the Balancing Systems section of Chapter 9, Analyzing
State-Space Characteristics, for more information about computing
controllability and observability Grammians and balancing a model.

Selecting and Removing an Input, Output, or State

Manipulating the system representation involves ignoring certain inputs
and outputs of a model, such as those connected by a unit gain. In a
state-space model, manipulating the system representation involves
removing unwanted states from the description. Use the CD Select 1O from
Model VI and the CD Remove 10 from Model VI to reduce a model by
directly removing inputs, outputs, or states.

Manipulating a model is useful for building new models from old ones
and for quickly removing zero states from a large state-space model
representation. Zero states are states for which the state matrix A has zeros
in an input row and the corresponding output column. Use the CD Minimal
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State Realization VI to perform this operation. Figure 10-1 shows an
example of a zero-state.

0 X4
e
00 0eee0| %D
L] L]
L] L]
L] L]
0
0
N
=A

Figure 10-1. A Zero-State in A

If the matrix has no zero rows or columns, consider using another method
to reduce the model order.

@ Note When you work with transfer function and zero-pole-gain models, you generally do
not select and remove specific inputs and outputs to reduce the model order. You mainly
use this method with state-space models.
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Designing Classical Controllers

Classical control design involves creating controllers based on the
input-output behavior of a system. In classical control design, you select
one or more specific gain values to achieve one or more control objectives.
The first step in designing a controller is identifying a control objective. For
example, you might focus on the rise time, overshoot, and damping ratio of
a controller model. Based on this objective, you specify the location of the
poles of the system. You then select an appropriate set of parameters, such
as the gain, to satisfy the stated objectives. You use these parameters to
design a controller.

This chapter provides information about using the LabVIEW Control
Design and Simulation Module to implement the root locus design
technique. This chapter also describes the proportional-integral-derivative
(PID) controller and how to design a PID controller analytically.

@ Note Refer to the labview\examples\Control and Simulation\Control
Design\Classical Control Design directory for example VIs that demonstrate the
concepts explained in this chapter.

Root Locus Design Technique

Root locus is a technique that shows how the roots of a system vary with
respect to the gain K. Taking into account a control objective, you decide
on the locations of the roots of the system. From the locations of these
roots, you infer the optimal value of K. You then can use the gain K to
design a controller for a single-input single-output (SISO) system. Use the
CD Root Locus VI to apply the root locus technique to a system.

You can use the root locus technique to design SISO systems by analyzing
the variation of closed-loop pole positions for all possible changes in a
controller variable. The closed-loop zeros of a system, between any two
points in the control system, are a subset of the open-loop zeros and poles
of the feedback element. The root locus plot depicts the path that the roots
follow as you vary the gain. You use this relationship to analyze the
closed-loop behavior in terms of the value of a variable in the feedback
transfer function.
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For example, consider a system with the following open-loop transfer
function:

B 1
s+ D(s+2)(s+3)

H(s)

If a simple proportional feedback controller controls this system, the
following equation describes the characteristic equation.

K =0
(s+1)(s+2)(s+3)

1+H(s)K = 1+

Figure 11-1 illustrates the root locus plot of this system.

1.5- open loop pales .
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1- bifurcation point 5 -
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Real Axis
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Figure 11-1. Root Locus

This graph shows the locations of the closed-loop poles. The pole locations
are —1, -2, and -3.

You can use root locus design to synthesize a variety of different controller
configurations, including the following types:

* Lead compensator—Lowers the rise time and decreases the transient
overshoot.

* Lag compensator—Improves the steady-state accuracy of the system.

*  Notch compensator—Achieves stability in the system with lightly
damped flexible modes. This compensator adds a zero near the
resonance point of the flexible mode.
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*  proportional-integral-derivative (PID) controller—Forms a
controller using the most common architecture. Refer to the
Proportional-Integral-Derivative Controller Architecture section
of this chapter for more information about PID controllers.

The difference in these controller configurations is the form of the transfer
function equations you use to synthesize the controller. Different transfer
function models result in different dynamic characteristics of the controlled
system.

For example, consider a controller transfer function model D(s) defined by
the form of the following equation:

S+z
S+p

D(s) = K

If z < p, this transfer function results in a lead compensator. You typically
place this lead compensator in series with the plant H(s) in the feed-forward
path. If z > p, this transfer function results in a lag compensator.

Refer to the CDEX Interactive Root Locus VI, located in the 1abview\
examples\Control and Simulation\Control Design\Dynamic
Characteristic Analysis directory, for an example that demonstrates
root locus analysis.

You also can use other frequency domain tools, such as Bode, Nyquist, and
Nichols plots, to design a system. These plots show the specific locations
and shape of key points. You examine these locations to modify the
controller parameters iteratively to meet these specifications. The number
and nature of the controller parameters depends on the topology of the
controller.

Refer to Feedback Control of Dynamic Systems and Modern Control
Engineering, as listed in the Related Documentation section of this manual,
for more information about using the root locus technique to design
controllers.
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Proportional-Integral-Derivative Controller Architecture
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The PID controller, also known as the three-term controller, is the most
widely-used controller architecture. PID controllers compare the output
against the reference input and initiate the appropriate corrective action.
PID controllers combine proportional P, integral I, and derivative D
compensation. Use the CD Construct PID Model VI to construct a PID
controller.

The following equation defines control action for a general PID controller.

t

e(t) + %Ie(t*)dt* Py LU

u(t) = K -

c

0

In this equation, K, is the gain, T, is the derivative time constant, and T; is
the integral time constant. The following equation defines the error.

e(t) = R(t) — B(v)
In this equation, R(?) is the reference input and B(¥) is the output.

Because the control action is a function of the error, the following equation
defines the transfer function for the PID controller.

Uls) _ 1
EGs) Kc(l + s + ’L‘ds)

This transfer function is improper, which means the transfer function has
more zeros than poles. You cannot physically realize an improper transfer
function. You can place a pole at —1/at, to make the transfer function
proper. o is a small number, typically between 0.05 and 0.2, such that the
pole has a negligible effect on the system dynamics.
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The Control Design and Simulation Module supports the PID controller in
the following four forms: PID Academic, PID Parallel, PID Parallel

Discrete, and PID Serial. Table 11-1 shows the equations for each of these
forms.

Table 11-1. PID Controller Forms in the Control Design and Simulation Module

PID Controller Form Equation
PID Academic U | T
Us) _ Kc(l +—+ #)
E(s) Tis oTys+1
PID Parallel
M = Kc + Ii’ &
E(s) s oKys+1
PID Parallel Discrete iy = KT KT +2K )2 + (K"~ 2K, T- 4K )z + 2K,
z) =
2Tz(z-1)
PID Series

fo = k()G

Each PID form produces the same result but incorporates information in a
different manner. For example, you can adjust each term independently
using the PID Parallel form. The PID form you use depends on the design
decisions you make, such as how you need to manipulate the output of the
controller. Use the polymorphic VI selector of the CD Construct PID
Model VI to implement a PID controller using one of these four PID forms.

Note In some applications, you specify the gain in the PID Academic transfer function in

terms of a proportional band (PB).

PB = I%XIOO%

c

A proportional band, defined by the previous equation, is the percentage of the input range
of the controller that causes a change equal to the maximum range of the output.
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You can use the root locus and Bode design methods to determine
appropriate gain values for the PID controller. Refer to PID Controllers:
Theory, Design, and Tuning, as listed in the Related Documentation section
of this manual, for more information about these techniques. Refer to

the LabVIEW PID Control Toolkit User Manual for information about
determining controller gain parameters experimentally.

You also can determine appropriate PID gain values analytically by using
the CD Design PID for Discrete Systems VI. The following section
describes how to use this VI.

Designing PID Controllers Analytically

Finding the proper values for the PID gains is a process known as tuning
the PID controller. PID tuning typically is an ad-hoc process that involves
trial and error. However, the Control Design and Simulation Module
provides the CD Design PID for Discrete Systems VI. You can use this VI
to find tuples of stable PID gain values automatically for a given model or
family of models.

The input to this VI is one or more discrete system models in transfer
function, zero-pole-gain, or state-space form. These models must be
single-input single-output (SISO) and discrete. This VI returns the
following information:

e The boundary between the set of stable PID gain values and all
unstable gain values.

e Tuples of PID gain values within this boundary. Each tuple guarantees
closed-loop stability.

* The centroid, or average, of these tuples.

@ Note You can specify options relating to how this VI searches for tuples of stable values.
You also can specify performance criteria, in the form of minimum gain and phase margins,
that these stable values must satisfy.
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For example, consider the following discrete transfer function models H(z),
I(z), and J(z).

1
H(Z) = 2—
z7-0.25
1
I(z) = 5
z —-0.5
J(z) = T"l"""
z —-0.75

Whereas traditional tuning provides one tuple of PID gains for one model,
the CD Design PID for Discrete Systems VI provides the set of all stable
PID gains for all three models. This set is the Stable Set Interior Points
parameter of the VI.

Figure 11-2 shows an example Stable Set Interior Points output that
corresponds to these models.

Stabls Set Inkerior Points

Figure 11-2. Set of Stable PID Gain Values for the Three Specified Models

In Figure 11-2, each point on the graph represents a stable tuple of
proportional, integral, and derivative gain values. These points also satisfy
any performance criteria you specify.
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This VI also finds the centroid of these points and returns the point closest
to this centroid. This point is the Design PID Gains parameter. Figure 11-3
shows the Design PID Gains output that corresponds to the set of points in
Figure 11-2.

Design PID Gains

kp

ID.224462

Ki

IU.‘IGDIS?

kd

ID.IDBDSS

Figure 11-3. Most Stable Tuple of PID Gain Values

Therefore, the design PID gains are 0.224462, 0.460137, and
0.108035, respectively. These values guarantee simultaneous closed-loop
stability of H(z), I(z), and J(z).

You can use these design PID gains with the PID VI, included with the
LabVIEW PID Control Toolkit, to implement a PID controller on a
real-time (RT) target.

@ Note Refer to the LabVIEW Help, available by selecting Help»Search the LabVIEW
Help, for more information about the algorithms the CD Design PID for Discrete Systems
VI uses. Refer to the 1abview\examples\Control and Simulation\Control
Design\Analytical PID Design directory for examples that demonstrate the concepts
explained in this section.
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Designing State-Space
Controllers

State-space control design uses state-space models to synthesize and
analyze controllers based on the relationship between the inputs, states, and
outputs of a system. Because all states are not directly measurable, you
sometimes need to use an estimator. An estimator infers the states with
which you are working, based on measurements of the outputs and known
states.

Similar to classical control design, the process of designing a controller
begins with one or more control objectives. Typical objectives include
minimizing a cost function and placing the poles and zeros of a system in
specific locations. You use this process to achieve a specific dynamic
response. You then select the architecture of the controller, such as whether
the feedback is based only on outputs or on all the states of the system. With
this information, you can synthesize a controller by selecting an appropriate
set of parameters to satisfy the stated objectives.

This chapter provides information about using the LabVIEW Control
Design and Simulation Module to determine estimator and controller gain
matrix values. This chapter also describes the difference between measured
outputs, known inputs, and adjustable inputs.

@ Note Refer to the labview\examples\Control and Simulation\Control
Design\State-Space Synthesis directory for example VIs that demonstrate the
concepts explained in this chapter.

Calculating Estimator and Controller Gain Matrices

Before you can implement an estimator or a controller, you need to
calculate their respective gain matrices. These gain matrices define the
structure of the estimator or the controller. The Control Design VIs help
you calculate the gain matrix for an estimator or controller.
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The following sections provide information about using the Control Design
and Simulation Module to perform the pole placement technique and
design a linear quadratic regulator. The following sections also describe
how to use the Kalman gain function and how to construct a linear quadratic
Gaussian controller.

Pole Placement Technique

Pole placement is a technique in which you specify the locations of the
closed-loop poles of a system and calculate the gain matrix based on these
locations. You can use the pole placement technique to calculate either the
observer gain matrix L or the controller gain matrix K.

Use the CD Ackermann VI to apply this technique in the following
situations:

* A single-input single-output (SISO) system

e A single-input multiple-output (SIMO) system if you are defining the
controller gain matrix K

* A multiple-input single-output (MISO) system if you are defining the
observer gain matrix L

Use the CD Pole Placement VI in all other situations, for example, a
multiple-input multiple-output (MIMO) system. The computation of the
gain for these systems is more complex and based on a Sylvester matrix
equation. Refer to the LabVIEW Control Design Algorithm Reference
manual for information about the Sylvester matrix equation.

Use the Gain Type parameter of the CD Ackermann VI and the CD Pole
Placement VIto determine which kind of gain matrix these VIs return. This
section uses the controller gain matrix K as an example.

@ Note The Control Design and Simulation Module refers to the pole placement technique
as an observer, because this technique does not estimate measurements given random
noise. This distinction does not affect the interaction between the CD Ackermann VI or the
CD Pole Placement VI and other Vls.
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Consider the following SISO state-space system with u = —Kx as the
control action.

x = Ax+ Bu
Cx + Du

<
]
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Figure 12-1 shows how you apply the gain matrix K to a controller.

+ u ‘)?=Ax+Bu y
Ll Ll '
A y=Cx+Du
b'¢

Figure 12-1. Using K'to Regulate the Input of a State-Feedback System

Given a specification of the closed-loop pole locations, A, A,, ... A,,, you
can calculate the controller gain matrix K that achieves this goal. The
system in question must be controllable.

For example, consider a closed-loop continuous system that has the
following form:

)'c=1:1x
A=A-BK

Because A satisfies the characteristic polynomial equation that the
specified closed-loop pole locations A, A, ... A, define, you can state the
following relationships:

sn+0c1s"71 +o+0, s+tod=(s-A)(s-L)...(s—A,)

o) = A"+, 4"+ o, A+a,l =0

The locations of o, are based on the locations of A,,. s is the Laplace
variable. You can use these equations to calculate Ackermann’s formula,
defined by the following equation:

K = [0 0... 1} [B AB ... A””B}_l¢(;1)

Combine the controller gain matrix K with the CD State-Space Controller
VI to define a controller structure for the system. Refer to Chapter 14,
Defining State-Space Controller Structures, for more information about
defining a controller structure. If you use the pole placement technique to
calculate the estimator gain matrix L, combine L with the CD State
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Estimator VI to define an estimator structure for the system. Refer to
Chapter 13, Defining State Estimator Structures, for more information
about defining an estimator structure.

Linear Quadratic Regulator Technique
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The linear quadratic regulator (LQR) technique calculates the controller
gain matrix K that minimizes a quadratic cost function. Unlike the pole
placement technique, you cannot use the LQR technique to calculate a
estimator gain matrix L.

The design process for LQR requires specifying matrices Q and R, which
specify weights on the states and inputs, respectively. You also can specify
a matrix N that penalizes the cross product between the inputs and states.
Typically, the selection of these gain matrices is an iterative process.

Use the CD Linear Quadratic Regulator VI to apply the LQR technique to
a model with any number of inputs and outputs. Use the Weighting Type
parameter to choose the cost function you want to minimize. You can
choose from the following cost functions:

e State Weighting—This cost function weights the model states.

¢ Output Weighting, Dim[Q] = Ny—This cost function weights the
model outputs y when @ is in terms of y. If you choose this cost
function, the dimensions of Q@ must equal the number of model outputs.

¢ Output Weighting, Dim[Q] = Nx—This cost function weights the
model outputs when @ is in terms of the model states x. If you choose
this cost function, the dimensions of @ must equal the number of
model states.

Refer to the LabVIEW Help, available by selecting Help»Search the
LabVIEW Help, for more information about the cost functions this VI
minimizes and for the equations of each of these cost functions.

This VIreturns the value of K that minimizes the cost functions you choose.
Because calculating K involves solving the continuous or discrete algebraic
Riccati equation, this VI also returns the solution to the appropriate Riccati
equation.

You can use the CD Linear Quadratic Regulator VI with continuous and
discrete models. If you wire a continuous model to the State-Space Model
input of this VI, this VI returns a continuous version of K. If you wire a
discrete model to this input, this VI returns a discrete version of K. You also
can configure the this VI to return a discretized version of K for a
continuous model.
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To calculate this discretized gain matrix, select the Discretized Linear
Quadratic Regulator instance of the CD Linear Quadratic Regulator VI.
This instance automatically converts a continuous model to a discrete
model before calculating K that minimizes the discrete version of the cost
function you specified. This VI first discretizes the A, B, C, and D matrices
using the Zero-Order-Hold method. This VI then calculates the discrete
equivalents of the @, R, and N matrices using the numerical integration
method proposed by Van Loan. You specify the Sampling Time (s) this VI
uses for both conversions.

Refer to the Zero-Order-Hold and First-Order-Hold Methods section of
Chapter 3, Converting Models, for information about the Zero-Order-Hold
conversion method. Refer to IEEE Transactions on Automatic Control, as
listed in the Related Documentation section of this manual, for information
about the numerical integration method proposed by Van Loan.

0 is a symmetric, positive, semi-definite matrix that penalizes the state
vector x in the control objective. R is a positive definite matrix, usually
symmetric, that penalizes the input vector u in the control objective. N is a
matrix that penalizes the cross product between input and state vectors.

Combine the controller gain matrix K with the CD State-Space Controller
VI to define a controller structure for the system. Refer to Chapter 14,
Defining State-Space Controller Structures, for more information about
defining a controller structure.

Kalman Gain

The Kalman gain is the value of L that minimizes the covariance of
estimation error for a given continuous or discrete state-space model
affected by noise. An estimator that uses the Kalman gain is called a
Kalman filter. Kalman filters estimate model states despite the presence of
noise. Use the CD Kalman Gain VI to calculate the optimal steady-state
value of L.

The following sections provide information about calculating the Kalman
gain matrices to apply to continuous and discrete Kalman filters.
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Continuous Models

For continuous models, the Kalman filter estimates the model states at
time ¢. The following equation defines the estimated state vector x(¢) the
Kalman filter calculates.

X(1) = Ax(t) + Bu(t) + L y(1) - y(1)]
y(1) = Cx(t) - Du(r)

In these equations, L is the gain matrix of the Kalman filter. The Kalman
filter estimates the accuracy of the estimated states by calculating the
steady-state covariance of the estimation error. The following equations
define this covariance matrix P and the estimation error e(7).

P = limE{e'(¢)-e(t)}
t— o0
e(1) = x(1) = x(1)
where E{} denotes the expected mean of the enclosed terms.

You calculate the Kalman gain L that minimizes P. Use the CD Kalman
Gain VI to calculate the value of L for a given model affected by noise. If
the noise affecting the model is Gaussian, then L is the optimal gain. If the
noise affecting the model is not Gaussian, L results in the optimal

linear least-square estimates.

Discrete Models

For discrete models, the Kalman filter not only estimates the current state
vector at time k, but also predicts the state vector at time k + 1. The
following sections describe the gain matrices you calculate in these
situations.

Updated State Estimate

The updated state estimate, which is the current state estimate, is given by
)Ac(k| k) . This notation translates as the estimated state vector at time k
given all measurements up to and including k. The following equation
defines the updated state estimate for a discrete Kalman filter.

x(k|k) = x(k|k—1)+M[y(k)-y(k)]
y(k) = Cx(k|k—1) - Du(k)
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In these equations, M is the innovation gain matrix of the Kalman filter. The
Kalman filter estimates the accuracy of the updated states by calculating
the steady-state covariance of the updated estimation error. The following
equations define this covariance matrix Z and the updated estimation error
e(klk).

Z = lim E{e" (k| k) - e(k|k)}
e(klk) = x(k) - x(k| k)

You calculate the innovation gain matrix M that minimizes Z. Use the CD
Kalman Gain VI to calculate the value of M for a given model affected by
noise.

Predicted State Estimate

The discrete Kalman filter also predicts states at time k + 1 given all
measurements up to and including time k. The following equation defines
defines the predicted state estimate.

x(k+1|k) = Ax(k|k— 1)+ Bx(k|k—1) + L[y(k) - y(k)]

y(k) = Cx(k|k—1)—Du(k)
In these equations, L is the Kalman prediction gain matrix of the Kalman
filter. The Kalman filter estimates the accuracy of the updated states by
calculating the steady-state covariance of the predicted estimation error.

The following equations define this covariance matrix P and the predicted
estimation error e(k + 11k).

P = klimE{eT(k+ 1k) - e(k+1]k)}
e(k+1]k) = x(k) —x(k+1|k)

You calculate the Kalman prediction gain L that minimizes P. Use the CD
Kalman Gain VI to calculate the value of L for a given model affected by
noise.

Refer to the LabVIEW Help for more information about the equations this
VI uses to calculate M, Z, L, and P for continuous and discrete models.
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Discretized Kalman Gain

If you wire a continuous model to the CD Kalman Gain VI, the VI returns
a continuous version of L. If you wire a discrete model to the CD Kalman
Gain VI, the VI returns discrete versions of L and M. You also can
configure this VI to calculate discrete versions of L and M for a continuous
model.

To calculate these discretized gain matrices, select one of the
Discretized Kalman Gain instances of the CD Kalman Gain VI. These
instances automatically convert a continuous model to a discrete model
before calculating L and M. This VI first discretizes the A, B, C, and D
matrices using the Zero-Order-Hold method. This VI then calculates the
discrete equivalents of the O, R, and N matrices using the numerical
integration method proposed by Van Loan. You specify the

Sampling Time (s) this VI uses for both conversions.

Refer to the Zero-Order-Hold and First-Order-Hold Methods section of
Chapter 3, Converting Models, for information about the Zero-Order-Hold
conversion method. Refer to IEEE Transactions on Automatic Control, as
listed in the Related Documentation section of this manual, for information
about the numerical integration method proposed by Van Loan.

Defining Kalman Filters

Control Design User Manual

After you use the CD Kalman Gain VI to calculate L and/or M, you can use
those values with the CD State Estimator VI to define a Kalman filter.
Refer to Chapter 13, Defining State Estimator Structures, for more
information about the different estimator configurations.

The Control Design and Simulation Module also includes the Discrete
Kalman Filter function and the CD Continuous Recursive Kalman Filter
function. These functions implement Kalman filters for discrete and
continuous models, respectively. These functions also calculate the
appropriate gain matrices internally. However, you can use these functions
only with stochastic state-space models. Refer to the Using a Kalman Filter
to Estimate Model States section of Chapter 16, Using Stochastic System
Models, for more information about using a Kalman filter with stochastic
state-space models.
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Linear Quadratic Gaussian Controller

A linear quadratic Gaussian (LQG) controller utilizes the LQR technique
to build the controller and the Kalman gain technique to filter out any
system noise. Use the CD Linear Quadratic Regulator VI and the

CD Kalman Gain VI together with the CD State-Space Controller VI

to synthesize a LQG controller.

Using an arbitrary estimator with a design such as LQR might not result in
the most optimal design of the controller. If the estimator starts with the
same initial condition as the unmeasured states, x(0) =x(0), and if the
system satisfies a number of controllability and observability conditions,
the closed-loop system with the observer-based controller has the same
response as the LQR design. This form of state feedback controller, when
combined with a estimator defined with the Kalman gain function, is called
the LQG controller.

Certainty equivalence is the property that enables this combined usage of
optimal estimator and controller. Certainty equivalence is important
because you can synthesize a controller gain matrix K and estimator gain
matrix L independently. You can build a controller assuming all states are
measurable and then estimate unmeasured states using an optimal
estimator. The resulting design is optimal for the specified problem.

@ Note Because an LQG controller uses an estimator, the robustness properties of an LQG
controller are not the same as that of an LQR controller. You have no guarantee that
robustness properties can be established for an estimated state feedback controller. You
only can guarantee robustness by changing the way you measure the states of the system
to remove the need for an estimator.
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Structures

State estimators reconstruct unmeasurable state information. To define
the structure of a state estimator, you need a model of the system and

an estimator gain matrix L. You can calculate L using the CD Pole
Placement VI, the CD Ackermann VI, or the CD Kalman Gain VI. Refer
to Chapter 12, Designing State-Space Controllers, for more information
about these VIs.

You use L to define the structure of an estimator. You can design an
estimator structure to take various factors, such as input noise or input
disturbances, into consideration.

This chapter provides information about using the LabVIEW Control
Design and Simulation Module to define the structure of a state estimator.
This chapter also discusses known inputs and measurable outputs.

@ Note Refer to the labview\examples\Control and Simulation\Control
Design\State-Space Synthesis directory for example VIs that demonstrate the
concepts explained in this chapter.

Measuring and Adjusting Inputs and Outputs

The estimator gain L considers all inputs # and outputs y, which are known
and measured. Also, some inputs and outputs might be unavailable. You
therefore can divide the system into adjustable inputs, measured outputs,
unknown inputs, and unmeasured outputs. You base this division on
diagonal matrices, such as A, and A,.

Diagonal matrices incorporate the effect of known, unknown, measured,
and unmeasured inputs and outputs into the equation. A diagonal element
in these matrices equals unity for the known and measured inputs and
outputs, and zero for the unknown and unmeasured inputs and outputs or
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states. The following equation describes how you incorporate the diagonal
elements for the inputs and outputs in the controller model.

= Ax+B'u+L*(y-y)
y = Cx+D*u

%>

In this equation, B* = BA,, D* = DA,,, and L* = LA,. These substitutions
apply to both estimators and controllers. Controllers have an additional
substitution when inputs are not adjustable. For a controller, the controller
gain K™ is given by K* = KA_, where A_ is a diagonal matrix with the same
characteristics as A, and A,. Therefore, a diagonal element in A, equals
unity for the adjustable input and zero for the nonadjustable or system
disturbances.

By default, matrices A, and A, are identity matrices whose size equals the
number of inputs. A, is an identity matrix whose size equals the number of
outputs.

Adding a State Estimator to a General System

Configuration

Use the CD State Estimator VI to define an estimator structure. This VI
integrates L into a dynamic system so you can analyze and simulate the
estimator performance.

@ Note To simplify the equations in the rest of this chapter, assume that all inputs are known
and all outputs are measurable. This assumption means B* =B, L* =L, and D" = D.

Control Design User Manual

Consider the following equations that represent a continuous state-space
system.

X = Ax+ Bu
y=Cx+Du+r,

Assume that L is based on this system, some estimator performance
specifications, and the output noise r, covariance. You then can calculate
the estimated states x using the following equations for dynamic models:

X = Ax+Bu+L(y-y)
y = Cx+Du
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The state-space system and dynamic model equations share the same
system matrices and input u. The states x and x are different because the
initial conditions of the system might differ from the model and because
of the noise input r,. Without a noise input, hqwever, the model states track
the system states, making the difference x — x converge asymptotically to
zero. The following equation shows how the estimator gain L enhances the
convergence of the error e to zero.

éy=x —% = A(x-x)+L(y-3) = (A-LC)e, +Lr,

Without the noise input, the following equation defines the error
convergence.

é, = (A-LC)e,

L is designed to place the poles of the matrix A — LC in the specified
complex-plane location.

To include the estimator in the composed system model, you append the
original model states x to the estimated model states x. The following
equations show this process:

-l oL
A-ldl-BaLd-l

Given this general system configuration, the following sections provide
information about deriving the possible configurations of a state estimator.
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Configuring State Estimators

Use the Configuration parameter of the CD State Estimator VI to define
the structure of an estimator using one of the following three
configurations:

System Included—Appends the actual states of the system to the

estimated states.

System Included with Noise—Incorporates noise r, into the system
included configuration.

Standalone—Defines a structure of the estimator that analyzes a

system-model mi

smatch.

Table 13-1 summarizes the different state estimator configurations and

their corresponding states, inputs, and outputs.

Table 13-1. State Estimator Configurations

Configuration Type States Inputs Outputs
System Included H u M
X

System Included with Noise

= =

Standalone

The following sections discuss each of these configuration types in detail.

System Included Configuration

You can use the system included configuration to analyze and simulate the
estimated states and the original states at the same time. For example, the
following equation defines the output estimator error in a system included
configuration.
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y-y = C(x-x)
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By substituting the output estimator error in the general system
configuration and removing the sensor noise r,, you obtain the following
equations that describe the system included configuration.

- el
ER IR

Figure 13-1 represents the dynamic system that these equations describe.

u
> System y>
X
e
» Estimator y
X >

Figure 13-1. System Included State Estimator

The states, inputs, and outputs of the estimator are H, u, and [—’j,
respectively. X

System Included with Noise Configuration

The system included with noise configuration incorporates noise ry into the
system included configuration. The following equation defines the output
estimator error.

y-y = C(x—)Ac)+ry
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By substituting the output estimator error in the general system
configuration, you obtain the following equations that describe the system
included with noise configuration.

fredf] o
RIS

Figure 13-2 represents the dynamic system that these equations describe.

> -

=

<

Ty
+ l +
4 »|  System %@y%
x
»| Estimator y
% —

Figure 13-2. System Included with Noise State Estimator

The states, inputs, and outputs of the estimator are H, {u}, and {y},
respectively. ry y

=

Standalone Configuration

In the standalone configuration, the system model detaches from the
estimator. The system outputs y become inputs to the estimator. Unlike the
system included and system included with noise configurations, the

standalone configuration does not account for output noise r,.

The primary purpose of the standalone configuration is to implement the
estimator on a real-time (RT) target. A secondary purpose of the standalone
configuration is to perform offline simulation and analysis of the estimator.
Offline simulation and analysis are useful for testing the estimator with
mismatched models and systems. Mismatched models and systems have
a calculated estimator gain that applies to a model with uncertainties.
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The following equations describe the standalone configuration.

=>-

= (4-LOx+[p_Lp L] H
y

~obd;

This configuration does not include the original system. This configuration
does not generate the system output internally but considers the output as
another input to the estimator. Figure 13-3 represents the dynamic system
that these equations describe.

>

> y
u Estimator ——»
—p )/{\

Figure 13-3. Standalone State Estimator

The states, inputs, and outputs of the estimator are x, {"}, and j},
respectively. y

Example System Configurations

The following equations define an example second-order SISO state-space
model with poles at —0.2 and —0.1.

ok
y=[10]x+[ou

You can implement a full state estimator for this system because this system
is observable. To implement a state estimator for this system, you must
calculate the estimator gain matrix L for the model of the system. Use the
CD Ackermann VI to calculate L by placing the poles of the matrix A — LC
at [-1, —1]. This location is to the left of the original pole location in the
complex plane. You can use this estimator gain matrix L, along with the
CD State Estimator VI, to study the performance of the estimator.
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@ Note Use the CD Observability Matrix VI to verify that this system is observable. Use the
CD Pole-Zero Map VI to determine the initial location of the system poles.

The following sections use this example system model to illustrate the
different state estimator configurations. The examples in these sections use
the CD Ackermann VI to calculate the estimator gain matrix L. You also
can calculate L using the CD Pole Placement VI or the CD Kalman

Gain VI

Example System Included State Estimator

Figure 13-4, shown below, uses the CD Ackermann VI to determine the
estimator gain matrix L of the second-order SISO State-Space Model.
You then use L with the CD State Estimator VI to create the state estimator,
represented by the Estimator Model, for the system.

State—Séace IModel [Carfiquration]
Lo |<>sttem Included +
D Ackermann. vi
e .
T E CD Stot Estinator v ’S:T'__T_TW Model
-1 0 Foles Placement % D Pole-Zero Map.vi] - Fojes in Estimator Model
' ——— = ;
v[l
,m Single Output _QI_IT
[observer Gain (Current) Time Info CELI_‘”itial Response.vi| Brate Trajectory Graph
EIEL [
Tritial Condit =
i
0 olofz g]
Figure 13-4. System Included State Estimator
@ Note You can study the performance of the state estimator with the CD Initial
Response VI.
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This configuration creates an Estimator Model that represents the
original, or actual, states of the system and the estimated states in the same
model. The Estimator Model consists of four states because this
configuration appends the original second-order SISO state-space model to
the state estimator, as shown in the following expression:

eIl - B
-k

@ Note The direct transmission matrix D is not part of the expression because it is null in
this example.

o>

<

The system included configuration monitors the response of the actual
states of the system to a set of initial conditions. The CD Initial

Response VI uses [0, 0, 2, 1] as the initial conditions. These initial
conditions mean that the initial conditions of the actual states are [2, 1],
whereas the initial conditions of the estimated states are [0, 0]. Therefore,
the Initial Conditions vector of the Estimator Model is [0, 0, 2, 1].

The State Trajectory Graph, as shown in Figure 13-5, displays the
response of the system and state estimator to the initial conditions

[0, 0, 2, 1].
State Trajectary Graph
25- #1Model 7
#2Model
2
xlSystem [
L - x25ystem
=
£
£ 1-
S00rm -
0- 1 l 1 1 I 1 1 1 I 1
a z2 4 5] g 10 12 14 16 15 20
Time (5]

Figure 13-5. State Trajectory of System Included State Estimator
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The initial conditions of the actual states are [2, 1]. The response of the
actual states, therefore, starts at 2 and 1. The initial conditions of the
estimated states are [0, 0]. The response of the estimated states, therefore,
starts at the origin. The estimated states promptly begin to track the actual
states as the response of the actual system settles to steady state. This state
estimator takes approximately six seconds to track the response of the
system.

Example System Included with Noise State Estimator
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In theory, you can place the poles of the state estimator as far left of the
complex plane as necessary. This placement leads to very aggressive state
estimators. Noise and system uncertainties, however, prevent you from
configuring such aggressive estimators. To account for noise and system
uncertainties, you can implement a state estimator using the system
included with noise configuration. Consider the following system included

with noise configuration.
- |[A-LCLC||x| , |B|,
0 A||lx| |B

- |COl|x| . |0 r,
y 0C||x 1
The configuration of this system is essentially the same as the system in the
Example System Configurations section of this chapter. The only addition
is the measurement noise r,. Assume that the measurement noise in this

example is a Gaussian noise in the system. The output noise influences the
estimated model dynamics through the estimator gain matrix L.

%>

=-

<
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Figure 13-6 shows how to account for a Gaussian noise of 0.1 standard
deviation in the Estimator Model.

(Configuration
|+ Zstem Included with Noise
Etate-Space Model =D Stake Estimatar vl skimator Model
[E=H = =kt ]
T iﬁ
ME Single Oukput *
=D Ackermann.vi glement D Linear Simulakion, vi
0|1 +ai : o Fogt === -
XpTY O+ e @t‘ﬁ Etf_-t% Trajeckory Graph
samples | |[Saussian White Moise. i 55 v
. 100 el
& Gain Type Py Initial Conditions
i |
Observer Gain {Current) B — A mAR
standard deviation
0.1

Figure 13-6. System Included with Noise State Estimator

The example in Figure 13-6 uses the state-space model and the

CD Ackermann VI to determine the estimator gain matrix L. The CD State
Estimator VI then uses the system included with noise configuration to
implement the state estimator, represented by the Estimator Model. Use
the Gaussian White Noise VI to view the effects of Gaussian noise on the
system and the state estimator.

@ Note The CD Linear Simulation VI provides the response to a Gaussian noise with the
same initial conditions as in Figure 13-4.
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The State Trajectory Graph, as shown in Figure 13-7, displays the
response of the system and state estimator to the same initial conditions
[0, 0, 2, 1] used in the Example System Included State Estimator section of
this chapter.

Skate

Armplitude

Trajectary Graph
2.5 *1Estimated [~

wZEskimated |
x15ystem s

xZ2Syskem

Tine [s)
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Figure 13-7. State Trajectory of System Included with Noise State Estimator

Similar to the graph in the Example System Included State Estimator
section of this chapter, this State Trajectory Graph shows the response of
the actual states starting at 2 and 1. The graph also shows the response of
the estimated states starting at the origin. Notice the effect of the output
noise r, on the state estimation. Without noise, the state estimator took
approximately six seconds to begin tracking the actual system. With noise,
the state estimator takes much longer to track the actual system and the state
estimator cannot track the actual system perfectly.

You can place the estimator poles closer to the origin to reduce the effect of
the noise. However, when you move the estimator poles closer to the origin
on the left side of the complex plane, you diminish the performance of the
estimator in tracking the actual states.

One solution is to use the Kalman gain function to obtain an estimator gain
matrix that effectively tracks the system states with an acceptable level of
noise rejection. Refer to the Kalman Gain section of Chapter 12, Designing
State-Space Controllers, for information about using the Kalman gain
function to find an optimal solution to this state estimator problem.
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Example Standalone State Estimator

Most systems are complex and have many parameters and uncertainties.
You often do not know all the parameters of a system when you create a
model of that system, or you cannot create a model that encompasses all the
uncertainties of the system. Thus, the actual system and the model of the
system do not match.

When you build a state estimator based on a model that does not match the
actual system, the result is a system-model mismatch. In this situation, you
need to use the standalone configuration. This configuration detaches the
system from the model so you can determine the effect of the system-model
mismatch. Consider the following state-space model:

f B
y = [1gfx+[ou

This model is similar to the model in the Example System Configurations
section of this chapter. For this example, however, assume that the actual
system contains uncertainties that cause this state-space model to be an
inaccurate representation of the system. The difference is in the first entry
of the system matrix A, —0.1.

Figure 13-8 shows how the CD State Estimator VI uses the mismatched
model, State-Space Model, to create the standalone estimator. This
configuration connects the actual system, System, and the mismatched
model, State-Space Model, in series so the actual system can provide the
output y to the standalone state estimator.

[==5k
:
4+ Skandalone ] T . D TR 1
N Eries, vi nitial Response, i
e Spate Model (D State Estimator.vi = = B
55, T o tate Trajectory Graph
E D Ackermann, i @ i m (=]
[bokes] Mﬂé* : = 55andss ~ 55 v
0 |l|-1+0i a Single Output ¥
Initial Conditions
§ 0 zlifolo
Observer Gain {Current) ¥

Figure 13-8. Standalone State Estimator
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The example uses the CD Initial Response VI to evaluate the effectiveness
of the state estimator. The State Trajectory Graph in Figure 13-9 shows
the response of the actual and estimated states to the same set of initial
conditions as in the Example System Included State Estimator section of
this chapter.

Figure 13-9. State Trajectory of Standalone State Estimator

Notice that a mismatch in the actual system and the model of the system
greatly impacts the estimation of the second state. After 20 seconds, the
state estimator still cannot track the actual state. Therefore, you must study
the system and model mismatch to determine the effect of the mismatch on
the state estimation.
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Defining State-Space Controller
Structures

State controllers use state information to calculate the control action.

To define the structure of a state controller, you need a model of the system
and a controller gain matrix K. You can calculate K using the CD Pole
Placement VI, the CD Ackermann VI, or the CD Linear Quadratic
Regulator VI. Refer to Chapter 12, Designing State-Space Controllers,
for information about these VIs.

You use K to define the structure of a controller. You can design a controller
structure to take various factors, such as input noise or input disturbances,
into consideration.

The following sections provide information about using the LabVIEW
Control Design and Simulation Module to incorporate the gain matrix K
into the control system. The controllers in the following sections assume
that all inputs are known and all outputs are measurable. Refer to the
Measuring and Adjusting Inputs and Outputs section of Chapter 13,
Defining State Estimator Structures, for information about measuring
inputs and outputs.

@ Note Refer to the labview\examples\Control and Simulation\Control
Design\State-Space Synthesis directory for example VIs that demonstrate the
concepts explained in this chapter.

Configuring State Controllers

Use the CD State-Space Controller VI to define a controller structure. This
VI integrates K into a dynamic system for analyzing and simulating the
controller performance. Use the polymorphic VI selector to define one of
the following three controller types:

*  Compensator—Places a reference on the state. Defines the control
action using # = K(r, — x), where r, is a state reference. If you estimate
any states, u = K(r, — x ) defines the state compensator control action.
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Regulator—Places a reference on the input. Defines the control action
using u =r, — Kx, where r, is an input reference. If you estimate any
states, u =r, — Kx defines the state regulator control action.

Regulator with Integral—Uses the following equation to define the
control action.

X
“e _[K K'] J‘(yref— y)

In this equation, y,.is the output reference, or setpoint.

The difference in these controllers is in how you calculate the control
action u.

You can implement any of these controller types using one of four different
configurations. Use the Configuration parameter of the CD State-Space
Controller VI to define a controller structure using one of the following
four configurations:

Control Design User Manual

System Included—Appends the actual states of the system to the
estimated states. This configuration is useful for analyzing and
simulating the original and estimated states at the same time.

System Included with Noise—Incorporates noise r, into the system
included configuration.

Standalone with Estimator—Defines an estimator structure with the
controller target. This configuration is useful for performing offline
simulations and analyses of the controller. You can use offline
simulations and analyses to test the controller with mismatched models
and systems. Mismatched models and systems have a calculated
estimator and controller gain that applies to the mismatched model, or
to the model with uncertainties. To select this configuration, choose a
standalone configuration and then wire an estimator with output L to
the Estimator Gain (L) input of the CD State-Space Controller VI.

Standalone without Estimator—Bases the control action u on the
actual states x instead of using an estimator to reconstruct the states.
This configuration is useful for analyzing a closed-loop system. To
select this configuration, choose a standalone configuration, but do not
wire anything to the Estimator Gain (L) input of the CD State-Space
Controller VI.
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@ Note Both the system included and system included with noise configurations
automatically include an estimator.

The following sections show the implementation of all four configurations
for all three controller types.

State Compensator

A general system configuration appends the original model states x to the
estimation model states X to represent the compensator with an estimator.
The following equations show this process:

i| - [a-BKo|[4], [Br L]| *,
2| L -Bk 4|« [BKO||y-p

u K ofrq [K o[ 7 |0

J3=C—DK0H+DK0 Tto
X _

y] | -DK* C pk o[ Y|,

Table 14-1 summarizes the different state compensator configurations and
their corresponding states, inputs, and outputs.

Table 14-1. State Compensator Configurations

Configuration Type States Inputs Outputs
<] u
System Included X r, )
x
- M
_A_ _r T u
System Included with Noise X o )
[X] ry
T M
Standalone with Estimator X Ix u
L] L]
Standalone without Estimator x r, "
L]

The following sections show how to define each configuration of a state
compensator.
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System Included Configuration

In the system included configuration, the following equation defines the
output error.

y-y = Cx-x)

By substituting the output error in the general system configuration and
removing the sensor noise r, from the system, you obtain the following
equations that describe the system included configuration.

%| _ |[a-BK-LC LC|[4], [BK],
| | -BK  A]||x |[BK|"
u | -k olrg [k
y| = C—DK0H+ DK\,

X
'y | -pk C DK

The reference vector r, has as many elements as the number of states. Also,
this configuration calculates the control action u internally and then gives
u as an output of the state compensator.

Figure 14-1 represents the dynamic system that these equations describe.

u
—»
r, +
X4>®—> Controller »|  System 4 >
- X

A

=

p| Estimator ——»

.

Figure 14-1. System Included State Compensator

x u
The states, inputs, and outputs of the state compensator are H ,F,and 3, ,
respectively. X y
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System Included with Noise Configuration

The system included configuration with noise incorporates noise r, into the
system included configuration. The following equation defines the output
error.

y-y = C(x-x)+r,

By substituting the output error in the general system configuration, you
obtain the following equations that describe the system included with noise

configuration.
%| _ [a-Br-Lc L[5, [BK L]|r.
X | | -BK A]|x| [BKO]|r,
u | -k olrg [K o0
~ X ry
y| = |C-DK 0 H+ DK 0
x r
Ly | -DK C DK I

The reference vector r, has as many elements as the number of states. Also,
this configuration calculates the control action u internally and then gives
u as an output of the compensator.

Figure 14-2 represents the dynamic system that these equations describe.

u ry
—
5% + + X+ y
—»()—»{ Controller »| System (B>
B X

d
p-| Estimator {—P
X

Figure 14-2. System Included with Noise State Compensator
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The states, inputs, and outputs of the state compensator are {x
X

[

s {r’ﬂ , and
r
v
u
e respectively.

y

Standalone with Estimator Configuration

In the standalone with estimator configuration, the system model detaches
from the controller. The system outputs y become inputs to the estimator.
Unlike the system included and system included with noise configurations,
the standalone with estimator configuration does not account for output
error. You must wire a value to the Estimator Gain (L) input of the CD
State-Space Controller VI to include the estimator in the standalone state
compensator.

The following equations describe the standalone configuration.

% = [A-BK-L(C-DK)IX+ [BK - LDK L] ﬂ
y

u K .. K 0] ry
y C-DK DK 0] | y
This configuration does not include the original system. This configuration

considers the system output y as another input to the estimator.

Figure 14-3 represents the dynamic system that these equations describe.

ry o+ u
—»(X)—» Controller >
» . 4>
y Estimator %

Figure 14-3. Standalone with Estimator State Compensator

The states, inputs, and outputs of state compensator are x, {rﬁ, and {Ef} s
respectively. y y
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Standalone without Estimator Configuration

In the standalone without estimator configuration, you calculate the control
action u using the states. As such, you do not need an estimator. In the
CD State-Space Controller VI, do not wire a value to the Estimator
Gain (L) input to exclude the estimator in the standalone state
compensator.

The following equations describe the standalone configuration.

% = (A-BK)x + BKr,

wo_| Ko | K r,
C-DK D
The states and outputs of the standalone without estimator compensator

correspond to the states and outputs of the actual system.

Figure 14-4 represents the dynamic system that these equations describe.

u
—>
ry * y
H(g)—> Controller > System |——p

t -

Figure 14-4. Standalone without Estimator State Compensator

The states, inputs, and outputs of the state compensator are x, r,, and {u}’
respectively. y
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State Regulator

A general system configuration appends the original model states x to the
estimation model states x to represent the state regulator with an estimator.

Defining State-Space Controller Structures

The following equations show this process:

X

_la-BK 0}

-K O
= |C-DKO

= o= R

| -DK C

$c+BL r,
| -BK A||x| |BO0]|y-
X r
H"‘DO !
X _

Do

Table 14-2 summarizes the different state regulator configurations and their

1o|r

corresponding states, inputs, and outputs.

Table 14-2. State Regulator Configuration Types

Configuration Type States Inputs Outputs
<] u
System Included X r, y
X

Y] n

_A_ _r | u

System Included with Noise X “ ¥y
X r,

L vl |

Standalone with Estimator x " lf

na LY

Standalone without Estimator X [r,] u

Y]

The following sections show how to define each configuration.
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System Included Configuration

In the system included configuration, the following equation defines the
output error.
y-y = Clx-x)

By substituting the output error in the general system configuration and
removing the sensor noise r, from the system, you obtain the following
equations that describe the system included configuration.

%| - [a-Br-LCLd[+] [B],
& ~BK A !

DK ("

u -K 0frx 1
N X

y| = C—DKOH"‘D"M
Vi

The reference vector, or actuator noise, 7, has as many elements as the
number of inputs. Also, this configuration calculates the control action u
internally and then gives u as an output of the state regulator.

Figure 14-5 represents the dynamic system that these equations describe.

ry u
>
_l+ v
Controller —>® p  System >
X
<
| Estimator ——»
X

Figure 14-5. System Included State Regulator

The states, inputs, and outputs of the state regulator are H, r,, and
respectively. X

= = x
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System Included Configuration with Noise

The system included with noise configuration incorporates noise r, into the
system included configuration. The following equation defines the output
error.

y-y = C(x-x)+r,

By substituting the output error in the general system configuration, you
obtain the following equations that describe the system included with noise
configuration.

x| - [a-Br-LCcL [+, [B LI
x | -BK A]|x BO||r

u Kk olrq |10
~ X ru
5l = C—DKOH"‘DO
y)

bk 9 |p gl

The reference vector, or actuator noise, r, has as many elements as the
number of inputs. Also, this configuration calculates the control action u
internally and then gives u as an output of the state regulator.

Figure 14-6 represents the dynamic system that these equations describe.

Controller —>® »  System —>®——>

»| Estimator ——»

Figure 14-6. System Included with Noise State Regulator

X u
. r n
The states, inputs, and outputs of the state regulator are H, “|, and e
respectively. x| |r, )
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Standalone with Estimator Configuration

In the standalone with estimator configuration, the system model detaches
from the controller. The system outputs y become inputs to the estimator.
Unlike the system included and system included with noise configurations,
the standalone with estimator configuration does not account for output
error. You must wire a value to the Estimator Gain (L) input of the

CD State-Space Controller VI to include the estimator in the standalone
state compensator.

The following equations describe the standalone with estimator
configuration.

X = [A-BK-L(C-DK)%+[g_Lp L {r}

y
lf _ -K o I0||r,
y C-DK DOy
This configuration does not include the original system. This configuration

considers the system output y as another input to the estimator.

Figure 14-7 represents the dynamic system that these equations describe.

ry

» Controller

Estimator

Jt

Figure 14-7. Standalone with Estimator State Regulator

The states, inputs, and outputs of the state regulator are X, {r“}, and [ﬂ s
respectively. y
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Standalone without Estimator Configuration

The standalone without estimator configuration uses states to calculate
the control action u. As such, you do not need an estimator. In the

CD State-Space Controller VI, do not wire a value to the Estimator
Gain (L) input to exclude the estimator in the standalone state regulator.

The following equations describe the standalone configuration.
X = (A-BK)x+Br,
y = (C-DK)x+ Dr,

The states and outputs of the standalone without estimator state regulator
correspond to the states and outputs of the actual system.

Figure 14-8 represents the dynamic system that these equations describe.

»  Controller —>® > System

X

=

Figure 14-8. Standalone without Estimator State Regulator

The states, inputs, and outputs of the state regulator are x, r,, and {u}’
respectively. y
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State Regulator with Integral Action

A general system configuration appends the output error integrator z to the
estimation model states x. A general system configuration also augments
the resulting vector (x, z) with the original model states x to represent the
state regulator with integral action and an estimator. The following
equations show this process:

| [ao00l[z] [BoL]l| =

2| = (0T 0|z T[0T O||Ver— ¥

| Loo4ly [Boof| y-p

4] -K, -K; 0| |x 000 u 0
yl=1c o ollz|+|D0O[|y.—»+]|0
vl Lo ol oo y-5 | |

In these equations, K, is the gain, K; is the integral action, y,is the
reference variable that you are tracking, and y is the output variable that you
use to track y,,s. In these equations, I" varies depending on whether the
model describes a continuous or discrete system. If the system is
continuous, I' = 0. If the system is discrete, [’ = 1.

When you define the control action for a state regulator with integral action
using the output error integrator z, you obtain the following control action
equation.

e

Substituting the control action into state dynamics of the general system
configuration defined in the previous equation, you obtain the following
equation that also defines the general system configuration.

* A-BK_0-BK; 0|(x| loL

=1 o 0 0 z+10{y’@"iy}

x -BK, -BK, A||x] |oo/tY77

u K, -K; O||%] |oo 0
y| = |C-DK, -DK; 0||z| + |00 {y"efiy} 0
'y | -pk, -pK, C||x] lootrTV

© National Instruments Corporation 14-13 Control Design User Manual



Chapter 14

Defining State-Space Controller Structures

Table 14-3 summarizes the different state regulator with integral action
configurations and their corresponding states, inputs, and outputs.

Table 14-3. State Regulator with Integral Action Configuration Types

Configuration Type States Inputs Outputs

B u

System Included X Vref y
x

B N

x . u

System Included with Noise z ref y

r

£ - ]

Standalone with Estimator x Yref u

LY ] L

Standalone without Estimator x Vrer "

LY

Control Design User Manual

The following sections show how to derive each configuration.

System Included Configuration

In the system included configuration, the following equations define the
output error and system output.

y-y = C(x-x)
y=-D(Kx+Kz)+Cx

By substituting the output error and system output in the general system
configuration and removing the sensor noise r, from the system, you obtain
the following equations that describe the system included configuration.
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A-BK,-LC -BK, LC|[{] [
DK, T+DK, —C||z| + 1|7
BK,  -BK, Al|lx] [0

K, -K; 0]|% 0

C-DK, -DK, 0||| + (0] y,.s

DK, -DK, C||x] [0

The reference vector y,,rhas as many elements as the number of outputs.
Also, this configuration calculates the control action u internally and then
gives u as an output of the state regulator with integral action.

Figure 14-9 represents the dynamic system that these equations describe.

—»

Yref y
- Controller | System >
> z X

</\
p| Estimator {—b
X

Figure 14-9. System Included Regulator with Integral Action

The states, inputs, and outputs of the state regulator with integral action are

~

X

u

z|» Yrep» and j, , respectively.

X

© National Instruments Corporation
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System Included with Noise Configuration

The system included with noise configuration incorporates noise r, into the
system included configuration. The following equations define the output
error and system output.

y-y = -Cx+Cx+r,
y=-DKx+Kz)+Cz+r,
By substituting the output error and system output in the general system

configuration, you obtain the following equations that describe the system
included with noise configuration.

<1 [a-Bk.-LCc -BK, L] [oL

sl = DK, T+DK;,-C||z|*+|I0 [eﬂ
A Bk,  -BK, 4|lx] [00/l"
4] K. K OlH ool

y| = |C-DK,-DK; 0||z| + [0 0 [rf

Ly DK, -DK,C||x] |01/l

The reference vector y,,rhas as many elements as the number of outputs.
Also, this configuration calculates the control action u internally and then
gives u as an output of the state regulator with integral action.
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Figure 14-10 represents the dynamic system described by these equations.

u ry
—»
Yref +l+ y
_| Controller |  System R
z x

<A
P Estimator {4>

X

Figure 14-10. System Included with Noise State Regulator with Integral Action

The states, inputs, and outputs of the state regulator with integral action are

r

x
zls Yref , and j,respectively.
X y

y

Standalone with Estimator Configuration

In the standalone with estimator configuration, the system model detaches
from the controller. The system outputs y become inputs to the estimator.
Unlike the system included and system included with noise configurations,
the standalone configuration with estimator does not account for output
error. You must wire a value to the Estimator Gain (L) input of the

CD State-Space Controller VI to include the estimator in the standalone
state regulator with integral action.
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The following equations describe the standalone configuration.
%| _ |[A-B-LD)K,~LC (D-B)K, H N {0 L} Vreg =
z L 0 r z 10 y
ul K. K ||x] 00| Y-y
y C-DK,  -DK,| |z 00 y
Use the following substitution to make the input independent.
|i0 L} yref_ y — Ly - |i0 Li| yref
10 y Vier =¥ I-1| y

This process results in the following equations that describe the standalone
configuration.

_ |4-(B-LD) K,~LC(D-B)K, H N {0 L} Vre
2 i 0 r z| U]y

ul _ | Ko K x| 00]| P
|y C-DK, -DK,||z 00| y
This configuration does not include the original system. This configuration
considers the system output y as another input to the estimator.

>

Figure 14-11 represents the dynamic system that these equations describe.

Yref
u
»| Controller >
> Ly
y _ Estimator X
- ]

Figure 14-11. Standalone with Estimator State Regulator with Integral Action
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The states, inputs, and outputs of the state regulator with integral action are

x, {y "ef}, and {i‘}, respectively.
y y

Standalone without Estimator Configuration

The standalone without estimator configuration uses states to calculate of
the control action u. As such, you do not need an estimator. In the

CD State-Space Controller VI, do not wire a value to the

Estimator Gain (L) input to exclude the estimator in the standalone state
regulator with integral action.

The following equations describe the standalone configuration.
X A-BK, -BK;
X = * ! x+ O(yref_y)
z 0 r (|lzg I
K -K.
7= ; A RN
y C-DK, -DK,| |z 0 ‘

Use the following substitution to make the inputs independent.

fouon-| )b

This process results in the following equations that describe the standalone
without estimator configuration.

x — A_BKX _BKi X + 00 yref
z 0 r ||z I-1 y
u - _Kx _K[ X + 00 y,,ef
y C-DK,.-DK,| |z 00]| y
Using this configuration, the states and outputs of the standalone state

regulator with integral action correspond to the states and outputs of the
actual system.
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Figure 14-12 represents the system that these equations describe.

u
—>
Vref Yo
—> >
» Controller > System x
|—> V4 j

Figure 14-12. Standalone without Estimator State Regulator with Integral Action

The states, inputs, and outputs of the state regulator with integral action are

H, {y re{/‘}, and {"}, respectively.
Z y y

Example System Configurations

The following equations define an example second-order SISO state-space
model with poles at —0.2 and —0.1.

o= [ e
= 1 e i

You can implement a full state controller for this system because this
system is controllable. To implement a state controller for this system, you
must calculate the controller gain matrix K for the model of the system. Use
the CD Ackermann VI to calculate K by placing the poles of the matrix

A — BK at [-1, —1]. This location is to the left of the original pole location
in the complex plane. You can use this controller gain matrix K, along with
the CD State-Space Controller VI, to study the performance of the
compensator.

@ Note Use the CD Controllability Matrix VI to verify that this system is observable.
Use the CD Pole-Zero Map VI to determine the initial location of the system poles.
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Figure 14-13 shows the response of the example system to initial
conditions of [2, 1]. This system is unstable because the response increases
exponentially and does not settle at a steady-state value.

Skate Trajectary Graph
4,5 x1Model |
4- ¥2Model |
5=
-
2
E25-
I
2 -
1.5
1 1 1 1 1 1 1 1 1 1 1
1] 1 2 3 4 5 & 7 g 9 10
Time (s}

Figure 14-13. Unstable Open-Loop System

Even though this system is unstable, the system is still controllable.
Because the system is controllable, you can use a state compensator to
place the closed-loop poles in the left-hand side of the complex plane to
make the response stable. You can calculate the controller gain matrix K by
using the CD Ackermann VI to place the poles of the matrix A — BK at
[-1, —1]. You can use K to study the performance of the compensator by
selecting the Compensator instance of the CD State-Space Controller VI.

The following sections use this example system model to illustrate the
different state controller configurations. These examples are state
compensators. You can define a state regulator or state regulator with
integral action by selecting the Regulator or Regulator with Integral
instance of the CD State-Space Controller VI, respectively.

The examples in these sections use the CD Ackermann VI to calculate the
controller gain matrix K. You also can calculate K using the CD Pole
Placement VI or the CD Linear Quadratic Regulator VI.
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Example System Included State Compensator

In theory, you cannot always measure the system states directly for control
purposes. Therefore, you must synthesize a controller using the system
outputs. To calculate the control action based on the estimated states, the
estimator needs to approach the actual states faster than the controller.
Therefore, you can calculate an estimator gain matrix such that A — LC has
eigenvalues at [-5, —5], which is farther to the left of the origin than the
poles of the controller located at [-1, —1].

The system included configuration takes both the estimator gain matrix L
and the controller gain matrix K and uses them to synthesize a state
compensator. Figure 14-14 shows the implementation of a state
compensator using the system included configuration.

Observer Gain (Current) |
D Ackermann, vi
=53
— ——
Estlmator Poles M&
0|5 +ai 0 System Included ¥
-5 400
phate-Space Model CD State-Space Contraller.vi] D Initial Response. vi
== =y ] [
@ : Etate Trajectory Graph
[ 5
CD Ackermann.vi L‘%ﬂ !
= j
=
Controller Poles 1 [nitial Conditions
0|l +ai 0_Jlojolzfi
-1 +0i0
[+ Caontroller Gain ¥|

Figure 14-14. System Included State Compensator

Control Design User Manual 14-22 ni.com



Chapter 14 Defining State-Space Controller Structures

The CD Initial Response VI uses [0, 0, 2, 1] as the initial conditions. As in
the Example System Included State Estimator section of Chapter 13,
Defining State Estimator Structures, these initial conditions mean that the
initial conditions of the actual states are [2, 1], whereas the initial
conditions of the estimated states are [0, 0]. Figure 14-15 shows the
response of the system to those initial conditions.

State Trajectory Graph
B #1Model

#2Model
wlSystem [

x25ystem

armplitude

-t [ I 1 1
1] 1 2 3 4 = <] 7 g
Tine (5]

Figure 14-15. State Trajectory of a System Included State Compensator

Notice that the time the estimator takes to track the actual states is much
shorter than the time the actual states take to reach a steady state. The
estimator takes between 1 and 1.5 seconds to track the actual states,
whereas the actual states take approximately six seconds to reach a steady
state. The estimator tracks the actual states faster than the controller
stabilizes the system because the estimator poles are at [-5, —5] and the
controller poles are at [-1, —1]. Placing the poles of the estimator farther to
the left than the controller poles makes the performance of the estimator
faster than the controller.
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Example System Included with Noise State Compensator

In general, the compensator accepts two inputs, r, and r,. The input r,
represents state references. The input r, represents measurement noise and
is available only in the system included with noise configuration.

Figure 14-16 shows the use of both types of inputs for the compensator.
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Figure 14-16. System Included with Noise State Compensator

The system included with noise configuration analyzes the effect of output
noise on the system. This example has a total of three inputs to the
compensator structure. The first two inputs are setpoints to the controller,
given by r, = [1, 0]. The last input represents the output noise ry, which has
a standard deviation of 0.01. Figure 14-17 shows the response to these
1nputs.
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Figure 14-17. State Trajectory of System Included State Compensator with Noise
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Notice that the state compensator lacks integral action, which originates the
offsets on the state responses with respect to their respective setpoints.
Therefore, the states do not reach the specified setpoints r, = [1, 0].

Example Standalone with Estimator State Compensator

Most systems are complex and have many parameters and uncertainties.
You often do not know all the parameters of a system when you create a
model of that system, or you cannot create a model that encompasses all the
uncertainties of the system. Thus, the actual system and the model of the
system do not match.

When you build a state compensator based on a model that does not match
the actual system, the result is a system-model mismatch. In this situation,
you need to use the standalone with estimator configuration. This
configuration detaches the system from the model so you can determine the
effect of the system-model mismatch. Consider the following state-space

model:
o |02 05|, of,
0.1 -0.2 1
y = [10]x+[o]u

This model is similar to the model in the Example System Configurations
section of this chapter. For this example, however, assume that the actual
system contains uncertainties that cause this state-space model to be an
inaccurate representation of the system. The difference is in the last entry
of the system matrix A, —0.2.

Figure 14-18 shows how this configuration uses the mismatched model,
State-Space Model, to create the standalone with estimator state
compensator. Note that the CD State-Space Controller VI uses the
Compensator instance. This configuration connects the actual system,
System, and the mismatched model, State-Space Model, in series. System
uses this connection to provide the output y to the state compensator.
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Figure 14-18. Standalone with Estimator State Compensator

This example sends the input u, which the compensator calculates, to the
actual system using the CD Feedback VI. The CD Initial Response VI uses
the same initial conditions to test the effectiveness of the controller and
estimator. Figure 14-19 shows the effect of a using a model that does not
match the actual system.
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Figure 14-19. State Trajectory of Standalone with Estimator State Compensator

Notice how Figure 14-15 and Figure 14-19 respond differently even though
both figures represent responses to the same system with the same initial
conditions. The example in Figure 14-15 takes 1 to 1.5 seconds to track the
actual states. The example in Figure 14-19, however, takes approximately
four seconds to track the actual states. The system-model mismatch in the
latter example accounts for this difference.
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This example is similar to real-world applications where you do not know
what the actual system is. Therefore, these tests are important in
determining how sensitive the controller is to the system-model
mismatches. You perform these tests before deploying the controller to a
real-time (RT) target. Using a design method called robust control design,
you can create model-based controllers that take into account possible
modeling errors. Refer to Essentials of Robust Control, as listed in the
Related Documentation section of this manual, for information about
robust control design.

Example Standalone without Estimator State Compensator

This state compensator uses the standalone without estimator
configuration, which indicates that you do not need a state estimator
because the states are directly available for control. The following
equations describe the compensator model.

X = (A-BK)x+ BKr,
y =Cx
@ Note The direct transmission matrix D is not part of this expression because D is null in

this example.

The poles, or the eigenvalues of A — BK, of the closed-loop system are in
the left side of the complex plane. If you set the output noise r, to zero, the
controller gain matrix K immediately drives the states to zero.

Figure 14-20 shows how you use the CD Ackermann VI to calculate the
controller gain matrix K, which you then use to study the performance of
the state compensator.
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Figure 14-20. Standalone without Estimator Compensator

@ Note To view both the original response of the actual system and the response of the
system controlled by the state compensator, you must append the model of the actual
system, State-Space Model, to the model of the state compensator. Therefore, in the
State Trajectory Graph, shown in Figure 14-21, you can see the difference in the system
response due to the effect of the compensator gain K.

By adding a state compensator to the actual system, you create a
closed-loop model of the resulting system. The actual system, without a
state compensator, is an open-loop system. Figure 14-21 shows the
response of the open-loop and closed-loop systems to initial conditions
of [2, 1].
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Figure 14-21. State Trajectory for Standalone without Estimator Compensator
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Notice that despite the instability of the actual system, the state
compensator is able to drive the closed-loop states toward zero. Thus the
addition of a state compensator to the actual system stabilizes the resulting
system.

Because the standalone state compensator stabilizes the actual system,
you must use a state compensator with this system.
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Estimating Model States

Observers estimate the states of state-space system models by using the
model information, any known inputs, and measured outputs. Use an
observer when you cannot measure one or more model states directly. You
can use observers only with state-space models because transfer function
and zero-pole-gain models do not specify state information.

@ Note Observers do not take noise into account when estimating system states. If there is
noise present in the system, that is, if the system is stochastic, you use an estimator instead
of an observer. A Kalman filter is one type of estimator. Refer to Chapter 16, Using
Stochastic System Models, for more information about stochastic systems and Kalman
filters.

The LabVIEW Control Design and Simulation Module includes two types
of observers for discrete models. Predictive observers use only information
from the previous time step to estimate state information. Current observers
use not only information from the previous time step, but also information
from the current time step. This additional information improves the
accuracy of current observers. Use a current observer only when the extra
computation time does not interfere with the next sampling time.

The Control Design and Simulation Module also includes an observer for
continuous models. However, estimating state information of continuous
models requires solving a differential equation over time. Therefore, you
can use a continuous observer only with a Simulation Loop.

@ Note The examples in this chapter compare actual model states with the estimated states.
These comparisons are for example purposes only because in real-world control systems
you rarely have all state information. However, if you are able to measure all state
information, you do not need an observer.

This chapter provides information about using predictive, current, and
continuous observers.

@ Note Refer to the labview\examples\Control and Simulation\Control
Design\Implementation directory for example VIs that demonstrate the concepts
explained in this chapter.
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Predictive Observer

Control Design User Manual

At each time step k, a predictive observer estimates the state information
for the next time step, or k + 1l k. This notation translates as the estimated
states at time step k + 1 given all measurements up to and including time
step k.

Consider an example at time step k = 5. At this time step, the predictive
observer estimates x(k + 1 |k) , or )Ac(6| 5) . Estimating this information
requires 5c(k| k— 1), or the current state estimate given all measurements
up to and including time step k — 1, which is x(5 | 4) . The predictive
observer also uses measured output y(5), estimated output y(5), and
known input u(5).

The following equations show this estimation:
x(k+1]k) = x(6]5) = AX(5|4) + Bx(5]4) + L [y(5) - p(5)]

y(5) = Cx(5|4)-Du(5)

In these equations, the predictive observer applies the observer gain L, to
the difference between the measured output y(k) and the estimated output
y(k) . You can use the CD Ackermann VI or the CD Pole Placement VI
to calculate L, Refer to the Pole Placement Technique section of
Chapter 12, Designing State-Space Controllers, for more information
about using these VIs.

At the next time step k = 6, the state estimate 5c(6| 5) becomes the
predicted state estimate x(k|k — 1), The predictive observer uses this
information to estimate the model states at time k =7, or x(7|6).

Use the Discrete Observer function to implement a predictive observer.
For example, consider the following discrete state-space model:

x(k+1) = {1 T}x(k)
01

y(k) = [1 o]x(h)

where T is a sampling time of 0. 1 seconds.
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Figure 15-1 shows the front panel controls that define this state-space

model.

Figure 15-1. Defining the Discrete State-Space Model

This model has two states x1 and x2. Figure 15-2 shows a block diagram
that implements a predictive observer for this model.
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Figure 15-2. Implementing a Predictive Observer for the State-Space Model
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The example in Figure 15-2 uses the Discrete State-Space function to
calculate the actual states of this model. At each time step, this example
compares the actual State x(k) to the Predicted State Estimate
xhat(klk-1), which is the state this function estimated at the previous time
step. The difference between these two values is the Error e(k). This
example also uses the CD Pole Placement VI to calculate the observer gain
L, such that the Poles of the predictive observer are in a location you define.
In this example, the predictive observer poles are located at 0.4 + 0.41.
Because this example has an Initial State x(0) value of [0, 017, both
model states return a constant value of zero. The Wait Until Next ms
Multiple function determines the speed at which the While Loop executes.

Note This model is adapted from pp. 292-93 of Digital Control of Dynamic Systems,
as listed in the Related Documentation section of this manual.

Control Design User Manual

15-4 ni.com



Chapter 15 Estimating Model States

If you execute this example with an Initial State Estimate xhat(0l-1) of
[0, -117- this example returns the graphs shown in Figure 15-3.

s
L
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-]
1\

Figure 15-3. Actual Model States vs. Estimated Model States
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In Figure 15-3, notice the predictive observer starts estimating both
model states correctly after about one second. To confirm this analysis, you
can look at the Error e(k) graph, defined as x(k) — xhat(klk-1) for each
model state. Figure 15-4 shows the error graph of this example.
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Figure 15-4. Estimation Error of a Predictive Observer

Figure 15-4 confirms the estimation error of this predictive observer
becomes zero after about one second.

Refer to the LabVIEW Help, available by selecting Help»Search the
LabVIEW Help, for information about the general forms of the equations
the Discrete Observer function uses to calculate the outputs.
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Current Observer

The difference between a predictive and current observer is that a
predictive observer uses measured output y(k) to estimate the predicted
state x(k + 1 |k) . However, a current observer uses y(k) to estimate the
current state )Ac(k|k) and uses that information to estimate x(k + 1 |k) .
This extra calculation means that a current observer is more accurate than
a predictive observer.

Consider an example at time step k = 5. At this time step, the Discrete
Observer function estimates x(5 |5) using x(5 |4) , measured output y(5),
estimated output y(5), and known input u(5). The following equations
show this estimation:

x(k|k) = X(5]5) = x(5|4) + L [p(5) - y(5)]
y(5) = Cx(5)-Du(5)

In these equations, the current observer applies the observer gain L to the
difference between the measured output y(k) and the estimated output
y(k) . You can use the CD Ackermann VI or the CD Pole Placement VI to
calculate L.

After estimating x(5 |5), the Discrete Observer function uses u(5) to
estimate the model states for the next time step x(k + 1 |k), or x(6]5).
The following equation shows this estimation:

x(6]5) = Ax(5|5) + Bu(5)
At the next time step k = 6, the state estimate )}(6| 5) becomes )Ac(k| k-1).
The Discrete Observer function corrects X(6|5) to become x(6|6) . The

Discrete Observer function then uses )}(6| 6) information to estimate
x(7]6).
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Figure 15-5 shows a block diagram that implements a current observer for
this model.
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Figure 15-5. Implementing a Current Observer for the State-Space Model
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Figure 15-6 shows the error graph of a current observer for the same model
described in the Predictive Observer section of this chapter.
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Figure 15-6. Estimation Error of a Current Observer

In Figure 15-6, notice the error oscillates less than the error of the
predictive observer shown in Figure 15-4. Also, the current observer error
generally is less than the predictive observer error at a given time step. This
decrease in error occurs because the current observer uses the current
output y(k) to estimate the current states xhat(klk), whereas the predictive
observer uses the current output y(k) to predict the next state estimate
xhat(k+11k).

Refer to the LabVIEW Help for the general forms of the equations the
Discrete Observer function uses to calculate the outputs.

Continuous Observer

Estimating the states of a continuous state-space model requires solving the
following ordinary differential equation:

fc(z) = Ax(t) + Bu(t) + L[y(t) - y(1)]
y(t) = Cx(t) + Du(t)

© National Instruments Corporation 15-9 Control Design User Manual



Chapter 15 Estimating Model States
To estimate the states, you must integrate this equation over time. To
perform this integration, you must use the CD Continuous Observer
function with an ordinary differential equation (ODE) solver. You specify
the ODE solver to use and parameters of the ODE solver by placing the
CD Continuous Observer function inside a Simulation Loop.
For example, consider the following continuous state-space model:
x(0) = | O ey + |Ou)
-10 1
y(0) = [1 o]x(0)
This model has two states x1 and x2. Figure 15-7 shows a LabVIEW block
diagram that implements a continuous observer for this model.
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Figure 15-7. Implementing a Continuous Observer for a State-Space Model

The example in Figure 15-7 uses the State-Space function to calculate the
actual states of this model. At each time step, this example compares the
Actual state x(t) to the Estimated state xhat(t). The difference between
these two values is the Error e(t). This example also uses the CD Pole
Placement VI to calculate the observer gain L such that the Poles of the
continuous observer are in a location you define. In this example, the
observer poles are located at -10 + 01.
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@ Note This model is adapted from Feedback Control of Dynamic Systems, as listed in the
Related Documentation section of this manual.

If you execute this example using an Initial State Estimate xhat(0) of
[0 -1]Tand an input of 0, this function returns the graphs shown in
Figure 15-8.
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Figure 15-8. Actual Model States vs. Estimated Model States
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In Figure 15-8, notice the continuous observer starts estimating both model
states correctly after about one second. To confirm this fact, you can look
at the Error e(t) graph, defined as x(t) — xhat(t) for each model state.
Figure 15-9 shows the error graph of this example.
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Figure 15-9. Estimation Error of a Continuous Observer

Figure 15-9 confirms that the observation error for both states converges to
zero after about one second.

This example uses the Runge-Kutta 23 ODE solver with an initial time
step of 0. 01 seconds. Refer to the LabVIEW Help for information about
this and other ODE solvers.
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Using Stochastic System
Models

The model forms in Chapter 2, Constructing Dynamic System Models,
are deterministic. Deterministic models do not account for random
disturbances, or noise, present in the system. Because noise affects most
real-world systems, deterministic models might not represent these systems
sufficiently.

Stochastic system models are models that represent the effects of noise on
the plant, actuators, and/or sensors. Each stochastic system model has an
associated noise model that characterizes the first- and second-order
statistical behavior of the noise affecting the system. You use stochastic
system models and noise model to test that a controller performs
adequately in the presence of noise.

This chapter provides information about constructing and converting
stochastic state-space models and noise models. This chapter also describes
simulating stochastic models and implementing a Kalman filter to estimate
model states in the presence of noise.

@ Note Refer to the labview\examples\Control and Simulation\Control
Design\Implementation directory for example VIs that demonstrate the concepts
explained in this chapter.

Constructing Stochastic Models

In addition to the state-space matrices A, B, C, and D, stochastic models
contain the following variables:

*  Vectors w and v represent process noise and measurement noise,
respectively. Process noise reflects errors introduced by the model
you defined, disturbances in the system states, and actuator errors.
Measurement noise reflects sensor reading errors and disturbances
directly affecting the sensor readings.

*  Matrices G and H relate w to the states and outputs, respectively.
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The following equations define continuous and discrete stochastic
state-space models.

Continuous Stochastic State-Space Model

x(t) = Ax(t) + Bu(t) + Gw(?)
y(t) = Cx(t) + Du(t) + Hw(t) + v(t)

Discrete Stochastic State-Space Model

x(k+1) = Ax(k) + Bu(k) + Gw(k)
y(k) = Cx(k) + Du(k) + Hw(k) + v(k)

Table 16-1 describes these variables.

Table 16-1. Dimensions and Names of Stochastic State-Space Model Variables

Variable Dimension Name

q — Length of process noise vector w.

r — Number of outputs.

n — Number of states.

w g % 1 vector Process noise vector.

v rx 1 vector Measurement noise vector.

G n X g matrix Weighting matrix relating the
process noise vector w to the
system states.

H r X g matrix Weighting matrix relating the
process noise vector w to the
system outputs.

Refer to the Constructing State-Space Models section of Chapter 2,
Constructing Dynamic System Models, for information about the A, B, C,
D, x, u, and y variables.

Use the CD Construct Stochastic Model VI to construct a stochastic
state-space model. Refer to the LabVIEW Help, available by selecting
Help»Search the LabVIEW Help, for information about this VI.
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Constructing Noise Models

A noise model characterizes the first- and second-order statistical behavior
of the noise vectors w and v. You construct a noise model by specifying the
expected mean and auto-covariance of each noise vector. You also can
specify any cross-covariance between the two vectors.

A noise model is of the following form:

Q = E{w-w'}—E{w} E'{w}
R =E{v v }—E{v}-E'{v}
N = E{w- v —E{w} E'{v}

Table 16-2 describes these variables.

Table 16-2. Dimensions and Names of Noise Model Variables

Variable Dimension Name
0 q X g matrix Auto-covariance matrix of w.
R r X r matrix Auto-covariance matrix of v.
N g X r matrix Cross-covariance between w and v.
E{w} q X 1 vector Mean vector of w.
E{v} rx 1 vector Mean vector of v.

Use the CD Construct Noise Model VI to construct a noise model for a
given stochastic state-space model. Refer to the LabVIEW Help for
information about this VI.

Converting Stochastic Models

A noise model is associated with a particular stochastic model. If the
stochastic model is continuous, the noise model is continuous, whereas if
the stochastic model is discrete, the noise model is discrete.

You can convert continuous stochastic models to discrete models, and
vice-versa. You also can convert stochastic models to deterministic models,
and vice-versa. The following sections provide information about these
conversions.
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Converting between Continuous and Discrete Stochastic Models

Use the CD Convert Continuous Stochastic to Discrete VI to discretize a
continuous stochastic model and the associated noise model. This VI
first converts the deterministic matrices A, B, C, and D using the
Zero-Order-Hold method. Refer to Chapter 3, Converting Models,

for information about this method.

This VI then converts the G, H, Q, R, and N matrices according to the
Method you specify. You can choose either the Numerical Integration
method as proposed by Van Loan or the Truncation of Taylor Series
Expansion (TSE) method. Refer to the LabVIEW Help and to IEEE
Transactions on Automatic Control, as listed in the Related Documentation
section of this manual, for information about the equations these methods
use.

Converting between Stochastic and Deterministic Models

Use the CD Convert Stochastic to Deterministic Model VI to convert a
stochastic state-space model to a deterministic state-space model. This VI
removes G and H from the stochastic model equations.

Use the CD Convert Deterministic to Stochastic Model VI to convert a
deterministic state-space model to a stochastic state-space model. When
you execute this VI, you specify matrices G and H. This VI then
incorporates G and H into the deterministic model equations.

E Note When using either of these VIs, if the model you are converting is discrete, the
resulting model has the same sampling time.

Simulating Stochastic Models

Control Design User Manual

Before you deploy a controller to an RT target, you can test that the
controller performs as expected in the presence of noise. To perform this
test, you can simulate the behavior of a stochastic system model.

Use the Internal Noise instance of the Discrete Stochastic State-Space
function to simulate the behavior of a discrete stochastic state-space model.
This function uses the Second-Order Statistics Noise Model to generate
values of w(k) and v(k).

You also can use the External Noise instance of the Discrete Stochastic

State-Space function and wire values of w(k) and v(k) to the Process Noise
w(k) and Measurement Noise v(K) inputs, respectively. In this situation,
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you can use the CD Correlated Gaussian Random Noise VI to generate
Gaussian-distributed values of w(k) and v(k) that fit a statistical profile you
specify.

In either instance, you test a controller model by wiring the output of the
controller model to the Input u(k) input of the Discrete Stochastic
State-Space function. You also can provide initial state information by
wiring values to the Initial State x(0) input.

This function accepts changes to the stochastic model and the noise model
as long as the dimensions of the A, B, C, D, G, H, O, R, and N matrices
remain the same. Because of this functionality, you can use the Discrete
Stochastic State-Space function to simulate the behavior of linear
time-variant (LTV) models.

Refer to the LabVIEW Help for more information about these functions.

Using a Kalman Filter to Estimate Model States

In the real world, controllers typically receive measurements that are
corrupted by noise. Also, you typically do not or cannot measure all state
values. If you want to calculate state values, the only information you have
is these noisy measurements and the known inputs. In this situation, you
can use a Kalman filter to estimate the state values given noisy sensor
measurements.

Use the Discrete Kalman Filter function to implement a Kalman filter for a
discrete stochastic state-space model. This function calculates the filtered
state estimate using only known inputs and noisy measurements of the
plant. The Discrete Kalman Filter function returns the filtered state
estimate, which is defined as fc(k| k) . This notation translates as the
estimated state vector at time k given all measurements up to and
including k.

Calculating the filtered state estimate involves applying a gain matrix M(k)
to the difference between the measured output and the estimated output.
The Discrete Kalman Filter function calculates and returns the value of
M(k) that minimizes the covariance of the estimation error. This covariance
is a matrix P(klk).

The Discrete Kalman Filter function also calculates the predicted state
estimate x(k + 1| k). Calculating the predicted state estimate involves
applying a gain matrix L(k) to the difference between the measured output
and the estimated output. This function calculates and returns the value of
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L(k) that minimizes the covariance of the prediction estimation error. This
covariance is a matrix P(k+11k).

You can assist the Kalman filter by specifying the Initial State Estimate
xhat(0l-1). This parameter specifies the state values you think the
stochastic model returns at the first time step k = 0. Providing this function
with initial state estimates helps this function converge on the true state
values quicker than if you do not provide an initial estimate. If you do not
wire a value to this parameter, this function sets all initial state values to
Zero.

You also can specify the Initial Estimation Error Covariance P(0l-1).
This parameter defines the covariance of the estimation error at the first
time step. A low value of this parameter indicates you have a high degree
of confidence in any Initial State Estimate xhat(0l-1) you provide,

and vice versa. If you do specify the Initial Estimation Error
Covariance P(0l-1) parameter, this function sets this parameter as the
identity matrix.

Refer to the Discrete Models section of Chapter 12, Designing State-Space
Controllers, for more information about how a Kalman filter uses the gain
and estimation error covariance matrices. Refer to LabVIEW Help for the

equations the Discrete Kalman Filter function uses to calculate the outputs.

The LabVIEW Control Design and Simulation Module also includes the
CD Continuous Recursive Kalman Filter function. Use this function to
implement a Kalman filter for a continuous stochastic model. Because
continuous Kalman filters must solve differential equations over time, you
only can place the CD Continuous Recursive Kalman Filter function inside
a Simulation Loop.
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Noisy RL Circuit Example

This example in this section modifies the RLC circuit from the RLC Circuit
Example section of Chapter 2, Constructing Dynamic System Models, by
removing the capacitor, adding process noise n(#), and adding measurement
noise e(?). Figure 16-1 shows this noisy RL circuit.

i(t)

vi(t)

Figure 16-1. Noisy RL Gircuit

In this example, L is the inductor, i(¢) is the current, v,(f) is the input voltage,
v,(?) is the output voltage, and R is the resistor. n(f) is process noise that
affects the resistor R, and e(f) is measurement noise that affects the sensor
that measures v,(f). The result of this noise is a corrupted measurement

Von(1)-

The process noise n(t) is modeled as a white, Gaussian, stochastic process
with spectral density S,(®) = 2kTR, where k is the Boltzmann constant!,
T is the absolute temperature of the resistor, and R is the nominal resistance
of the noiseless resistor.

The measurement noise e(¢) is modeled as a white, Gaussian, stochastic
process with spectral density S,(®) = s2, where s is the standard deviation
of the measurement noise. In this example, e(?) is uncorrelated with n(7).

The following sections construct a stochastic state-space model and noise
model for this example, simulate the model output, and implement a
Kalman filter to estimate the model states.

! In this example, the Boltzmann constant equals 1.38 x 10723 Joules per Kelvin.
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Constructing the System Model
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Constructing a model for this system involves defining the values of the A,
B, C, D, G, and H matrices. To define these matrices, you can write
equations that describe the system behavior and transform those equations
into stochastic state-space form. After the equations are in this form, you
can derive the values of the necessary matrices.

Applying Kirchoff’s Voltage Law to the example in Figure 16-1 yields the
following equations that represent the system input and output.

vi(f) = Ri(t)+LcLiC%+n(t)

(¢) = Ri(t) +n(t) +e(?)

Vo, n

To obtain the values of the state-space matrices, transform these equations
into the stochastic state-space equations, defined as the following:

x(t) = Ax(t) + Bu(t) + Gw(t)
y(t) = Cx(t) + Du(t) + Hw(t) + v(t)

You can transform these equations by substituting equivalent terms and
then rearranging those terms. Table 16-3 shows the equivalent terms in both
sets of equations.

Table 16-3. Equivalent Terms

Variable Represents Equivalent Term
i(?) State vector x(1)
vi(?) Input vector u(t)
Von(?) Output vector y(?)
n(t) Process noise vector w(t)
e(t) Measurement noise vector V(1)

Substituting variables with equivalent terms yields the following equations:

u(t) = Rx(t) + Lx(t) + w(t)
y(t) = Rx(t) +w(t) +v(2)
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Rearranging the terms in the first equation yields the following equations:

o~ _ R 1 1
x(t) = Lx(t) +Lu(t) Lw(t)
y(t) = Rx(t) +w(t) +v(¢)
From these equations you can obtain the following values of the state-space
matrices:
A= _R B= 1 G= 1
L L L

The next step is constructing the noise model associated with this stochastic
model.

Constructing the Noise Model

Because w(r) and v(¢) are white, these variables have a mean of zero and are
temporally uncorrelated. Therefore, the auto-covariance matrices Q(f) and
R(7) are equivalent to the inverse Fourier transform of the respective
spectral densities S,,(®) and S,(®). Additionally, E{w(#)} = 0 and

E{v(t)} = 0. The following equations show the definition of the noise
model.

E{w()} = 0
E{v()} = 0
0(1) = F'{S,(w)} = 2kTR(1)

F S, (@)} = 5°8(1)
0

R(?)
N(t)

where 8(7) is the Dirac delta function. N(¢) is 0 because w(z) and v(¢) are
uncorrelated with each other.
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Figure 16-2 shows a block diagram that constructs this noise model and the
stochastic system model when R =1 kQ, L =500 uH, s =0.000001, and
T=290K.

Symbolic A - " tochastic State-Space Model
= |CD Construck Stochastic Model.\rl|
e | =
Ho |
Symbolic B 5 ymbalic Ejw " ; d-Order Statistics Noise Model out|
= [0 Construck Noise Model,vi]  BESRMALE
EE. EE. Imw : == =
o . )
Svmbolic Symbolic E4y
D kI~ Ho_| boic 7]
20 _| _ Symbolic &
_ Symbolic D Em
Em D ............ o |
Ho_|
Swrnbialic G Symbolic R
C| BT (T — a[i. .............
g o
Swmbolic H Symbalic 1

i
i
El

I

Figure 16-2. Constructing the Stochastic State-Space Model and a Noise Model for
the Noisy RL Circuit Example
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Converting the Model

Before you can simulate this stochastic model using the Control Design
and Simulation Module, you must discretize the stochastic model and the
associated noise model. Use the CD Convert Continuous Stochastic to
Discrete to discretize these models.

Figure 16-3 shows a block diagram that discretizes both models using a
Sampling Time (s) of 0.000001.

[ Construck Stochastic Model. vi

H CD Convert Conkinuous Skochastic ko Discrete.vi|
= e .

D Construct Moise Model.vi] |

Liscrete Stochastic
[5tate-Space Model

[+ Numerical Integration |

Figure 16-3. Discretizing the Stochastic State-Space Model and the Noise Model

The example in Figure 16-3 uses the conversion Method of Numerical
Integration to discretize the models.
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Simulating The Model

Figure 16-4 shows a block diagram that simulates the discrete Stochastic
State-Space Model defined in the Converting the Model section of this
chapter. The Input u(k) to this model is a sine wave with an
Amplitude of 0.01 volts and a Frequency of 1 KHz.

amplibude (4
—
P HZ
DELH - -
Sine W PEEPE,
=
Output ik I =] B poBL]
] it
WS ale. Mulkiplier W Discrete Stachastic State Space output y(k)|
B foei]
State sl # pmiE
_ e = ol
PitSiale, Multipler [“;t:" gtate x(0 Ee— "
Construct and
Discretize Models.vi it LInkil Plesct ms Multiple
[DELE
Frop]
-------
i

Figure 16-4. Simulating the Discrete Stochastic State-Space Model

In Figure 16-4, the Construct and Discretize Models subVI contains the
block diagram code shown in Figure 16-3. The Wait Until Next ms
Multiple function adjusts the speed of the simulation. Also, this example

uses Property Nodes to adjust the scale of the resulting graphs based on the
Frequency of the sine wave.
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Figure 16-5 shows the Output y(k) and the State x(k) of the model when
you run this example.

wikT) | U

Figure 16-5. Output and State Trajectories of the Discrete Stochastic
State-Space Model

In Figure 16-5, notice the noise present in the graph of Output y(k).
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Implementing a Kalman Filter

As defined in Table 16-3, the state in this example represents the current
flowing through the RL circuit. If this example were a real-world circuit,
you could use an ammeter to measure the current flowing through the
circuit. However, for the purposes of this example, assume you do not have
an ammeter or cannot connect an ammeter to the circuit. In this situation,
you can use a Kalman filter to estimate the current given only the noisy
voltage measurements Output y(k) that Figure 16-5 shows.

Figure 16-6 shows a block diagram that demonstrates a Kalman filter for
this discrete stochastic state-space model.

Hile: Lnné
arnplitude (
=
[DBL K -
||1e.EvVave PEEYPE v
N [E=— #o6L]
[
Discrete Stochastic State Space Putput ()]
»—ﬁ%N [Eea— koEL]
T s 71 f = tfet
b:Scale Mulkiplier H [nitial State x(0

i [T 1 foet]
- Construct and stimation Error efkT
Discretize Models.vi L]

ilkered Stake Estimate xhak(k|k

¥oBL]

finitial State Discrete Falman)Filker
Estimate xhat(0|-1
[oBL e

o)
initial Estimation Errar
(Covariance PLO[-1

[
it zit Lkl Meset s Mulkiple
[oELH b
Feop)
i

Figure 16-6. Implementing a Kalman Filter
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Figure 16-7 compares the actual model State x(k) with the Corrected
State Estimate xhat(kIk) the Discrete Kalman Filter function calculates.

Figure 16-7. Actual Model States vs. Corrected State Estimates
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In Figure 16-7, notice the actual state appears to equal the corrected state at
every time step. To confirm this analysis, you can look at the graph of the
estimation error e(k), defined as x(k) — xhat(klk). Figure 16-8 shows the
graph of e(k) for this example.

Estimation Error e(k)
BT = el | U
1.6E-7 -

1.4E-7 -

1.2E-7 -
1E-7 -
8E-5 -
GE-8 -

armplitude

4E-8 -
2E-3-
0~ [, Pl inhey Mt ol o
-ZE-8 - 1 1 1 1 1 1 |
0,000 0,000 0,001 0,001 0001 0,001 0,002 0,002
Time §{s)

Figure 16-8. Estimation Error of Kalman Filter

In Figure 16-8, notice the estimation error is extremely small. This small
error confirms the ability of the Kalman filter to estimate model states
despite the presence of noise.

Refer to the Example State-Space Controller with Kalman Filter for
Stochastic System Code section of Chapter 17, Deploying a Controller to a
Real-Time Target, for example block diagram code that implements a
Kalman filter on a real-time (RT) target.
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Deploying a Controller to a
Real-Time Target

After you design a controller using the techniques this manual describes,
you then can deploy the block diagram code for that controller to a
real-time (RT) target. The RT target acquires sensor measurements,
executes the controller code, and sends the appropriate output to the
actuators.

The LabVIEW Control Design and Simulation Module includes functions
that you use to deploy discrete linear time-invariant (LTT) system models to
National Instruments RT Series hardware. You can use these functions to
define discrete controller models in transfer function, zero-pole-gain, or
state-space form. To deploy continuous controller models to an RT target,
you must use a Simulation Loop. Refer to the Example Continuous
Controller Model with Kalman Filter Code section of this chapter for more
information about deploying continuous models to an RT target.

@ Note Deploying controller code to an RT target involves the LabVIEW Real-Time
Module. This chapter is not intended to provide a a comprehensive discussion of using the
Real-Time Module. If you installed the Real-Time Module, refer to the LabVIEW Help,
available by selecting Help»Search the LabVIEW Help, for information about deploying
a VI to an RT target, using the Timed Loop, and creating I/O code to and from
RT hardware.
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Figure 17-1 shows where you place a controller in a closed-loop dynamic

system.

Control System

Reference igi
—>©—> Controller ~ [p{ Di9Malt0ANalog | iy oy oiors Fl

+ Converter (DAC)

Analog to Digital | o Sensors <

Physical System
(Plant)

Converter (ADC)

5

Figure 17-1. Closed-Loop Dynamic System

In Figure 17-1, the controller represents an RT target running a VI that

contains the controller code you designed. Because the RT target is digital,

you need a digital-to-analog converter (DAC) to convert the digital

controller output into an analog signal the actuator recognizes. If the sensor
is analog, you also need an analog-to-digital converter (ADC) to convert the

analog sensor measurement into a digital signal the controller hardware
recognizes. You can eliminate the need for a separate ADC by using a

digital sensor, such as a digital multimeter (DMM).

The wire leading to the controller in Figure 17-1 represents block diagram
code that acquires a sensor measurement. The wire leading away from the
controller represents block diagram code that sends the controller output to

the actuator. Depending on the hardware installed in the RT target, these
wires represent different code. For example, if the RT target is using
National Instruments DAQ devices, these wires represent NI-DAQmx

code.

Note National Instruments provides hardware and software to test and implement

controllers, actuators, analog sensors, DMMs, DACs, and ADCs. Refer to the National
Instruments Web site at ni . com for information about these products.

To deploy a controller on an RT target, you must define the controller
model and then write the block diagram code that implements that

controller model on an RT target. This chapter provides information about

both of these steps.
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@ Note Refer to the labview\examples\Control and Simulation\Control
Design\Implementation directory for example VIs that demonstrate the concepts
explained in this chapter.

Defining Controller Models

The Control Design and Simulation Module includes the following three
functions you use to define a controller model.

*  Discrete Transfer Function
»  Discrete State-Space

e Discrete Zero-Pole-Gain

You use these functions to deploy a controller model on an RT target. You
also can use these functions to perform an offline simulation that does not
involve an RT target. Refer to the LabVIEW Help for information about
these functions.

You can define a controller model interactively or programmatically. The
following sections use the Discrete Transfer Function function to provide
information about each of these methods.

Defining a Controller Model Interactively

Place the Discrete Transfer Function function on the block diagram and
double-click the function icon to launch the Discrete Transfer Function
Configuration dialog box. After you launch this dialog box, complete the
following steps to define the controller model.

1. Specify whether the model is single-input single-output (SISO) or
multiple-input multiple-output (MIMO) by selecting the appropriate
option from the Polymorphic instance pull-down menu.

2. Select the Transfer Function parameter from the Parameters listbox.
The Parameter Information section updates to show the
configuration options for the model.

3. Select Configuration Dialog Box from the Parameter source
pull-down menu.

4. If the model is MIMO, define the dimensions of the model using the
Inputs and Outputs text boxes in the Model Dimensions section.
This section is dimmed if you configure a SISO model because SISO
models have only one input and one output.
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5. Enter numerator and denominator coefficients in the Numerator and
Denominator text boxes. Notice the Preview window updates to
display the model equation. For MIMO models, use the Input-Output
Model control to select different input/output pairs. You can enter
unique Numerator and Denominator coefficients for each
input/output pair.

6. Click the OK button to save the model definition and return to the
block diagram. If you defined a SISO model, the function icon updates
to show the model equation. You also can resize the function icon.

Defining a Controller Model Programmatically

Launch the Discrete Transfer Function Configuration dialog box, select
Transfer Function from the Parameters listbox, and select Terminal
from the Parameter source pull-down menu. After you click the OK
button, the Transfer Function input appears on the function icon. You
then can use the CD Construct Transfer Function VI, or a block diagram
constant, to define a transfer function model. Wire this model definition to
the Transfer Function input of the Discrete Transfer Function function.

Writing Controller Code

The examples in this section use a Timed Loop to implement the feedback
configuration Figure 17-1 shows. This structure also ensures the controller
code you write executes in real time. Refer to the LabVIEW Help for
information about configuring and executing a Timed Loop.

@ Note If you designed a continuous controller model, you must convert that model to a
discrete one before deploying that model to an RT target. The sampling time you use in this
conversion must equal the Period of the Timed Loop. Refer to Chapter 3, Converting
Models, for more information about converting models.

The following sections show example transfer function, state-space, and
zero-pole-gain controller code. These examples also define and convert
models in different ways. The following sections also describe how to
implement observers and Kalman filters on an RT target.
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Example Transfer Function Controller Code

The example in Figure 17-2 constructs a continuous transfer function
model in the form of a phase-lead controller. This example then converts
the model to a discrete one using the Zero-Order-Hold Method and
implements that discrete controller model on an RT target. Refer to
Chapter 3, Converting Models, for more information about the
Zero-Order-Hold method.

Input Node Timed Logj [Cukput Hod
-
O [[RAz ] BlError
r N gt BlErrar o b
3z, 100
- S —
0
;
» Lead ~] 4 ¥
Controller Output.vi

» Dcete Transfer Function

Sensor Measuremnent. vi l:

ke

Figure 17-2. Implementing a Discrete Transfer Function Controller on an RT Target

Method
[2era-Crder-Hold =

@ Note In Figure 17-2, and throughout the following sections, the Sensor Measurement
subVlI represents block diagram code that acquires a measurement from a hardware sensor.
The Controller Output subVI represents block diagram code that sends the controller
output to the actuator.

When you click the Run button in this example, LabVIEW downloads the
VI to the RT target and executes the following steps:

1. Acquires a Sensor Measurement from a hardware sensor that
measures the plant output.

2. Subtracts the Sensor Measurement from a Reference Input you
define.

3. Applies the result of step 2 to the controller the Discrete Transfer
Function function defines. This example uses the CD Construct
Lead-Lag Controller VI to define the controller model
programmatically. The Discrete Transfer Function function returns
the Controller Output.

4. Sends the Controller Output to the hardware actuator.

Steps 1 through 4 repeat until you stop the VI.

© National Instruments Corporation 17-5 Control Design User Manual



Chapter 17

Example State Compensator Code

Deploying a Controller to a Real-Time Target

Figure 17-3 shows a block diagram that implements a state compensator.
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Figure 17-3. Implementing a State Compensator on an RT Target

The example in Figure 17-3 uses the CD Construct State-Space Model VI
to construct a model of the system to be controlled. The controller consists
of the block diagram code inside the Timed Loop. The control action is
defined as u = K(xRef — x), where xRef is the reference state you specify,
x is the measured state information, and K is the controller gain matrix.

This example assumes you can measure all state information. If you cannot
measure all state information, you can use a predictive or current observer
to estimate state information. Refer to the Example State-Space Controller
with Predictive Observer Code and Example State-Space Controller with
Current Observer Code sections of this chapter for information on

implementing predictive and current observers.
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Example SISO Zero-Pole-Gain Controller with Saturation Code

Figure 17-4 shows a block diagram that implements a SISO zero-pole-gain
controller and takes saturation into account.

Input Node COutput Mode
Dms | |
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Figure 17-4. Implementing a Discrete Zero-Pole-Gain Controller on an RT Target

The example in Figure 17-4 defines a SISO controller model interactively.
Notice that the model equation appears on the Discrete Zero-Pole-Gain
function icon. Also notice the In Range and Coerce function. You can use
this function to account for saturation effects in the dynamic system.
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Example State-Space Controller with Predictive Observer Code

Figure 17-5 shows a LabVIEW block diagram that implements a
state-space controller that depends on estimated state information.
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Figure 17-5. Implementing a Predictive Observer on an RT Target

The example in Figure 17-5 uses the Discrete Observer function to estimate
state information x(k + 1 | k) during execution. This example also uses the
CD Pole Placement VI to calculate the predictive observer gain Lp such
that the current Observer Poles are in the location you specify. Another
CD Pole Placement VI calculates the controller gain K based on the
Controller Poles you specify.

This example calculates the control action to apply at the next time step, or
u(k + 1), which is defined as —Kx(k + 1 | k) . At the next iteration of the
Timed Loop, u(k + 1) becomes u(k), which the Discrete Observer function
uses to estimate state information for the next time step. The feedback node
transfers this value from one iteration to the next.

Refer to Chapter 15, Estimating Model States, for more information about
observers.
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Example State-Space Controller with Current Observer Code

The example in Figure 17-6 shows a block diagram that implements a
state-space controller that depends on estimated state information.
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Figure 17-6. Implementing a Current Observer with Feedthrough on an RT Target

The example in Figure 17-6 implements a current observer with
feedthrough, that is, when D # 0 . Because this example has feedthrough,
you cannot use the current state estimate, fc( k| k), to calculate the control
action at the current time step, u(k). Instead, you must use the predicted
state estimate, fc( k+ 1|k), to calculate the control action at the next time
step, u(k+1). The Discrete Observer function calculates u(k+1) at the
current time step, k, but applies this control action at the next time step, k+1.
Because this example has feedthrough, you can initialize u(k+1) and ensure
a bumpless start by wiring an initial value to the initializer terminal of the
Feedback Node.
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The example in Figure 17-7 implements a current observer without
feedthrough, that is, when D = 0.
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Figure 17-7. Implementing a Current Observer without Feedthrough on an RT Target

Because the example in Figure 17-7 does not have feedthrough, you must
select the Indirect option in the Feedthrough pull-down menu in the
configuration dialog box of the Discrete Observer function. You then can
use the current state estimate, )Ac( k|k) , to calculate the control action at the
current time step, u(k). The Discrete Observer function calculates u(k) at
the current time step, k, and applies this control action at the current time
step, k.

Refer to Chapter 15, Estimating Model States, for more information about
observers.
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Example State-Space Controller with Kalman Filter for Stochastic
System Code

The example in Figure 17-8 shows a block diagram that implements a
state-space controller that depends on estimated state information. Because
the controller must take noise into account, this example uses a Kalman
filter instead of a predictive or current observer.
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Figure 17-8. Implementing a Kalman Filter with Feedthrough on an RT Target

The example in Figure 17-8 implements a Kalman filter with feedthrough,
thatis, when D # 0 . Because this example has feedthrough, you cannot use
the current state estimate, )Ac( k|k) , to calculate the control action at the
current time step, u(k). Instead, you must use the predicted state estimate,
x(k+1 |k) , to calculate the control action at the next time step, u(k+1).
The Discrete Kalman Filter function calculates u(k+1) at the current time
step, k, but applies this control action at the next time step, k+1. Because
this example has feedthrough, you can initialize u(k+1) and ensure a
bumpless start by wiring an initial value to the initializer terminal of the
Feedback Node.
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The example in Figure 17-9 implements a Kalman filter without
feedthrough, that is, when D = 0.
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Figure 17-9. Implementing a Kalman Filter without Feedthrough on an RT Target

Because the example in Figure 17-9 does not have feedthrough, you must
select the Indirect option in the Feedthrough pull-down menu in the
configuration dialog box of the Discrete Kalman Filter function. You then
can use the current state estimate, fc( k| k) , to calculate the control action at
the current time step, u(k). The Discrete Kalman Filter function calculates
u(k) at the current time step, k, and applies this control action at the current
time step, k.

Refer to the Implementing a Kalman Filter section of Chapter 16, Using
Stochastic System Models, for more information about the Discrete Kalman
Filter function.

Example Continuous Controller Model with Kalman Filter Code

Control Design User Manual

You must use a Simulation Loop to deploy a continuous controller model
to an RT target. The Simulation Loop uses ordinary differential equation
(ODE) solvers to integrate continuous differential equations over time. You
use the Simulation Loop to configure the ODE solver and time step settings
to use.
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Figure 17-10 shows a LabVIEW simulation diagram that uses the
Simulation Loop to deploy a continuous controller model and Kalman filter
to an RT target.
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Figure 17-10. Implementing a Continuous Controller Model and
a Continuous Kalman Filter on an RT Target

In Figure 17-10, the blue D on the Sensor Measurement and Controller
Output subVI icons indicate these subVIs execute as discrete functions.
You can configure the sample period and sample skew, or offset, of these
functions individually. The black C on the A x B VI icon indicates this VI
executes continuously. Also, notice this example does not need feedback
nodes or shift registers to feed the output of the A x B VI back to the
Input u(t) input of the CD Continuous Recursive Kalman Filter function.

Finding Example NI-DAQmx I/0 Code

If you installed NI-DAQmx, refer to the labview\examples\DAQmx\
Control\Control.1llb for examples of writing I/O block diagram code
for National Instruments DAQ devices.
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Creating and Implementing a
Model Predictive Controller

Traditional feedback controllers operate by adjusting control action in
response to a change in the output setpoint of a system, also called a plant.
Model predictive control (MPC) is a technique that focuses on constructing
controllers that can adjust the control action before a change in the output
setpoint actually occurs. This predictive ability, when combined with
traditional feedback operation, enables a controller to make adjustments
that are smoother and closer to the optimal control action values.

For example, consider a cruise control system in a car. This controller
adjusts the amount of gas sent to the engine. The amount of gas is based on
the following two values:

*  The velocity at which you set the cruise control system

*  The velocity of the car

The velocity of the car is based on the slope of the road along which the car
moves. Therefore, a change in slope, or disturbance, affects the velocity of
the car, which affects the amount of gas the controller sends to the engine.

Table 18-1 shows the terms this example uses, where k is discrete time.

Table 18-1. Example Terms and Definitions

Term Physical Component Variable
Controller Cruise control system —
Control action Amount of gas sent to the engine u(k)
Plant Car —
Plant output Velocity of the car y(k)
Plant output Velocity at which you set the r(k)
setpoint cruise control system
Disturbance Slope of the road dk)
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Consider what happens when the slope of the road increases as the car
moves up a hill. This slope increase reduces the velocity of the car. This
decrease in velocity causes the controller to send more gas to the engine.

If the cruise control system is a traditional feedback controller, this
controller reacts to the disturbance only after the velocity of the car drops.
To match the output setpoint, this controller might increase the control
action sharply. This sharp increase can result in oscillation or even
instability.

If the cruise control system has predictive ability, this controller knows in
advance that the velocity of the car will drop soon. The controller might
obtain this information from sensors on the front of the car that measure the
slope of the road ahead. A feedback controller with this predictive ability is
called an MPC controller.

To match this predicted output setpoint, the MPC controller gradually
increases the control action as the car approaches the change in slope. This
increase can be smoother and more stable than the increase a traditional
feedback controller provides.

This chapter provides information about using the LabVIEW Control
Design and Simulation Module to design and implement a predictive
controller.

@ Note Refer to the labview\examples\Control and Simulation\Control
Design\MPC directory for examples that demonstrate the concepts explained in this
chapter. Refer to UKACC Control, 2006. Mini Symposia, as listed in the Related
Documentation section of this manual, for information about the algorithms these VIs use.

Control Design User Manual
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Creating the MPC Controller

You use the CD Create MPC Controller VI to create an MPC controller.
This VI bases the MPC controller on a state-space model of the plant that
you provide.

@ Note If you want to create an MPC controller for a transfer function model or a
zero-pole-gain model, you must first convert the model to a state-space model.

Providing an accurate model improves the performance of the MPC
controller this VI creates. You can specify that the MPC controller
incorporates integral action to compensate for any differences between the
plant model and the actual plant.

You can use the State Estimator Parameters input of this VI to define a
state estimator that is internal to the MPC controller model. You also can
estimate model states by using the Discrete Observer function outside the
MPC controller. Refer to the Current Observer section of Chapter 15,
Estimating Model States, for more information about estimating model
states.

The following sections provide information about other parameters you use
to define the MPC controller.

Defining the Prediction and Control Horizons

When constructing an MPC controller, you must provide the following
information:

¢ Prediction horizon (N,)—The number of samples in the future during
which the MPC controller predicts the plant output. This horizon is
fixed for the duration of the execution of the controller.

e Control horizon (N.,—The number of samples within the prediction
horizon during which the MPC controller can affect the control action.
This horizon is fixed for the duration of the execution of the controller.

@ Note The value you specify for the control horizon must be less than the value you specify
for the prediction horizon.
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Figure 18-1 shows these horizons.
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Figure 18-1. Prediction and Control Horizons

In Figure 18-1, notice that at time k the MPC controller predicts the plant
output for time k + N,,. Also notice that the control action does not change
after the control horizon ends.

At the next sample time k + 1, the prediction and control horizons move
forward in time, and the MPC controller predicts the plant output again.
Figure 18-2 shows how the prediction horizon moves at each sample time k.

Prediction
| Horizon at Time k+1
I |
Prediction
Horizon at Time k

»
|

k k+1 k+Np k+Np+1 Time

Figure 18-2. Moving the Prediction Horizon Forward in Time

@ Note The control horizon moves forward along with the prediction horizon. Before
moving forward, the controller sends the control action u(k) to the plant.

Control Design User Manual

Because you cannot change the length of the prediction or control horizons
while the controller is executing, National Instruments recommends you set
the prediction horizon length according to the needs of the control problem.
In general, a short prediction horizon reduces the length of time during
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which the MPC controller predicts the plant outputs. Therefore, a short
prediction horizon causes the MPC controller to operate more like a
traditional feedback controller.

For example, consider the cruise control system again. If the prediction
horizon is short, the controller receives only a small amount of information
about upcoming changes in the road slope and speed limit. This small
amount of information reduces the ability of the controller to provide the
correct amount of gas to the engine.

A long prediction horizon increases the predictive ability of the MPC
controller. However, a long prediction horizon decreases the performance
of the MPC controller by adding extra calculations to the control algorithm.

Because the control action cannot change after the control horizon ends,

a short control horizon results in a few careful changes in control action.
Consider the cruise control system again. After the control horizon ends,
the flow of gas to the engine remains constant, which means the velocity of
the car keeps changing until the velocity setpoint is reached.

If the control horizon is short, the controller attempts to meet the velocity
setpoint by changing the flow of gas only a few times and in small amounts.
A large control action in a short control horizon might overshoot the
velocity setpoint after the control horizon ends. However, as the controller
continues to execute, the velocity eventually settles around the setpoint.

Conversely, a long control horizon produces more aggressive changes in
control action. These aggressive changes can result in oscillation and/or
wasted energy. For example, if you set the control horizon of the cruise
control system too long, the cruise control system wastes gas due to
constant accelerating and decelerating.

@ Note You can reduce these aggressive changes by using weight matrices in the cost
function. Refer to the Specifying the Cost Function section of this chapter for information
about weight matrices.

You provide horizon information by using the MPC Controller
Parameters parameter of the CD Create MPC Controller VI.

Specifying the Cost Function

The MPC controller calculates a sequence of future control action values
such that a cost function is minimized. You can specify weight matrices in
this cost function. These weight matrices adjust the priorities of the control
action, rate of change in control action, and plant outputs.
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For specified prediction and control horizons N, and N, the MPC controller
attempts to minimize the following cost function J(k):

Np
J(k) = Z [)A/(k+i|k)—r(k+i|k)]T'Q- [y(k+ilk) —r(k+ilk)]+

i=Nw

Nc-1 Np
z [Au’(k+i]k) - R - Au(k +i|k)] + z [u(k +ilk) —s(k +ilk)]" -
i=0 i=Nw

N - Tu(k+ilk) —s(k+i|k)]

where

*  kis discrete time

e iis the index along the prediction horizon

* N, is the number of samples in the prediction horizon
* N, is the beginning of the prediction horizon

* N, is the control horizon

e Q is the output error weight matrix

* R s the rate of change in control action weight matrix
*  Nis the control action error weight matrix

*  9(k+i]k) is the predicted plant output at time k + #, given all
measurements up to and including those at time k

e r(k+i|k) is the output setpoint profile at time k + i, given all
measurements up to and including those at time k

*  Au(k+i]k) is the predicted rate of change in control action at time
k + i, given all measurements up to and including those at time k

* u(k+i|k) is the predicted optimal control action at time k + i, given
all measurements up to and including those at time k

*  s(k+i|k) is the input setpoint profile at time k + i, given all
measurements up to and including those at time k

You specify soft constraints @, R, and N by using the MPC Cost Weights
parameter of the CD Create MPC Controller VI. Refer to the Implementing
the MPC Controller section of this chapter for information about
specifying r(k + i|k) and s(k + i|k) . The CD Implement MPC Controller
VI calculates the values of u(k +i|k), Au(k+i|k), and p(k+i|k).
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Specifying Constraints

In addition to weight matrices in the cost function, you can specify
constraints on the parameters of an MPC controller. Remember that weight
matrices adjust the priorities of the control action, rate of change in control
action, and plant outputs. Constraints are limits on the values of each of
these parameters.

Use the CD Create MPC Controller VI to specify constraints for a
controller. You can specify constraints using either the dual optimization or
the barrier function method. The following sections describe each of these
two methods.

@ Note You also can update the constraints of a controller at run time. Refer to the Modifying
an MPC Controller at Run Time section of this manual for information about updating a
controller at run time.

Dual Optimization Method

Use the Dual instance of the CD Create MPC Controller VI to set
constraints using the dual optimization method. You can specify these
constraints in the MPC Constraints (Dual) parameter of the CD Create
MPC Controller VI.

The dual optimization method specifies initial and final minimum and
maximum value constraints for the control action, the rate of change in
control action, and the plant output. Use these constraints to represent
real-world limitations on the values of these parameters.

For example, consider the cruise control system again. In this example,
the control action, or the amount of gas provided to the engine, is
unconstrained. In reality, however, cars can send only a certain amount of
gas to the engine at once. You can design an MPC controller to take this
constraint into account, which is equivalent to placing a hard constraint on
the maximum value of the control action. Additionally, the road might have
speed limits at certain intervals. If you know these limits in advance, you
can specify that the car cannot exceed the speed limits. This specification
is equivalent to placing hard constraints on the maximum value of the plant
output.

When you use the dual optimization method, all constraints are weighted
equally and above any cost weightings you specify. For example, in the
cruise control system, the MPC algorithm places equal emphasis on trying
not to exceed the specified maximum amount of gas or the specified
maximum velocity. If you also specify an output error weighting, the
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algorithm prioritizes the control action and plant output constraints over the
output error weighting. In other words, the algorithm tries not to exceed the
specified amount of gas or the specified maximum velocity, even if meeting
these constraints results in a large difference between the desired and actual
velocity of the car. When you use the dual optimization method, the MPC
algorithm adjusts the controller such that the specified constraints are never
exceeded.

Because all constraints are weighted equally when you use the dual
optimization method, you cannot reflect differences in cost or importance
for different parameters. For example, suppose you want to build a
controller that maintains the car at a specific velocity. You want to prioritize
minimizing the output error above meeting any other constraints. With the
dual optimization method, you cannot specify this priority. Similarly, if you
have two conflicting constraints, the controller cannot prioritize one over
the other. If you want to prioritize the constraints and cost weightings for a
controller, use the barrier function method instead of the dual optimization
method. Refer to the Barrier Function Method section of this chapter for
more information about the barrier function method.

Refer to the CDEx MPC with Dual Constraints VI, located in the
labview\examples\Control and Simulation\Control
Design\MPC directory, for an example of using the dual optimization
method to set constraints for a controller. Refer to the CDEx MPC Dual vs
Barrier Constraints VI in this same directory for a comparison of the dual
optimization and barrier function methods.

Refer to Nonlinear Programming, as listed in the Related Documentation
section of this manual, for more information about the dual optimization
method.

Barrier Function Method

Use the Barrier instance of the CD Create MPC Controller VI to set
constraints using the barrier function method. You can specify these
constraints in the MPC Constraints (Barrier) parameter of the CD Create
MPC Controller VI.

Like the dual optimization method, the barrier function method specifies
initial and final minimum and maximum value constraints for the control
action, the rate of change in control action, and the plant output. However,
the barrier function method also associates a penalty and a tolerance with
each of these constraints. The penalty on a constraint specifies how much
the MPC algorithm attempts to avoid reaching the constrained value. The
tolerance specifies the distance from the constrained value at which the
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penalty becomes active. By specifying penalties on constraints, you can
prioritize the constraints and cost weightings of a controller.

Relationship Between Penalty, Tolerance, and Parameter
Values

If the distance between a parameter value z and its constrained value z; is
greater than or equal to the tolerance tolj, the penalty P; is 0. The penalty
becomes active when z reaches Zj— tol s if z 1S a maximum constraint,

or z; + tol}, if z; is a minimum constraint. The penalty then increases
quadratically as z approaches z;. When z equals z;, that is, when the
parameter value reaches the constrained value, P; equals the specified
penalty constant p;. If z exceeds the constrained value, the penalty
continues to increase quadratically.

Figure 18-3 illustrates this behavior for a maximum constraint.
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Figure 18-3. Penalty Profile for Parameter z with Maximum Constraint z,,,

For example, consider a plant output y with a maximum constraint y,,,,
tolerance y,,;, and a penalty constant p,,,, of 5. Table 18-2 shows how the
penalty P increases as y approaches y,,,,-

Table 18-2. Increasing Penalty as a Function of Plant Output

Value of y Value of P for p,,,,. =5
y< (ymax_ytol) 0
D max = Yiot) <V <Vmax 0 <P < 5. The value of P
increases quadratically between 0O
and 5.
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Table 18-2. Increasing Penalty as a Function of Plant Output (Continued)

Value of y Value of P for p,,,,. = 5
Y = Vmax 5
V> Yimar P continues increasing
quadratically.

Consider again the cruise control system. Suppose the speed limit in an area
is 70 miles per hour. You therefore specify a maximum constraint of

71 miles per hour on the velocity of the car. Also suppose you impose a
penalty constant of five on this constraint. The penalty specifies the priority
the MPC algorithm places on keeping the velocity below 71 miles per hour.

If you specify a tolerance of five miles per hour on this constraint, the
tolerance range begins at 66 miles per hour. The penalty on the maximum
output constraint therefore becomes active when the velocity of the car
reaches 66 miles per hour. The penalty then increases from O to 5 over a
tolerance range of five miles per hour.

If you reduce the tolerance to two miles per hour, the penalty on the
maximum output constraint becomes active when the car reaches 69 miles
per hour. The penalty then increases from O to 5 in a shorter velocity
interval than before. In this case, the MPC algorithm responds to the
penalty and almost immediately tries to prevent the velocity from
increasing above 69 miles per hour. Because the penalty profile is steeper
than in the previous case when the tolerance was five, the MPC algorithm
has a shorter interval in which to prevent the velocity from exceeding the
constrained value.

Prioritizing Constraints and Cost Weightings

Remember that all constraints you specify using the dual optimization
method are weighted equally and above any cost weightings you specify.
With the barrier function method, you can prioritize the constraints against
each other and against any cost weightings you specify. When an MPC
algorithm recognizes that the penalty on a constraint is active, the algorithm
incorporates the penalty in the cost function and adjusts the control action
accordingly. For each constrained variable, the MPC algorithm must
balance the penalty with any cost weightings.
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The following expression illustrates this behavior in the case of a maximum
constraint.

2 2
pzm“[(zmax - tOlmax) _Z] + (Z _Zsp) q; z ?\Zmax - tOlmax)

where

D is the penalty constant for z,,,,,

*  Zuax 1S the maximum constraint on z

*  tol,,, is the tolerance for z,,,,

*  zis the value of the control action or of the plant output
*  Zgis the setpoint value of z

e g is the cost weighting on z

@ Note Refer to the Specifying Input Setpoint, Output Setpoint, and Disturbance Profiles
section of this chapter for information about providing setpoint information for a
controller.

When z is the control action, this expression becomes:

Pau, [(Btty g = 101,,) = Aul + (Au)’r; AuXAu,,, ~ tol

where
*  pa,  1sthe penalty constant for Au
*  Au

*  tol,,, is the tolerance for Au,, .

max

max 18 the maximum constraint on Au

*  Au is the value of the rate of change in control action

* ris the cost weighting on Au

The first term in the previous expression represents the cumulative effect of
the penalty. The second term represents the cumulative effect of the cost
weightings.

Consider again the cruise control system in which y,,,. is 71 miles per hour,
with a penalty constant of five and a tolerance of five miles per hour.
Suppose the desired plant output is 70 miles per hour, and the output error
weighting is one. If the velocity of the car is 60 miles per hour, the MPC
algorithm attempts to increase the velocity to 70 miles per hour, thereby
reducing the output error. When the velocity of the car reaches 66 miles per
hour, the penalty on y,,,, becomes active. Because the penalty constant is
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significantly greater than the output error weighting, the MPC algorithm
prioritizes the output constraint above the output error. Therefore, the
controller attempts to reduce the velocity of the car to a level above but
close to 66 miles per hour. Suppose instead that the output error weighting
is 100. Because the output error weighting is significantly greater than the
penalty constant, the MPC algorithm prioritizes the output error above the
plant output. Therefore, the controller attempts to increase the velocity of
the car to a level closer to 70 miles per hour, despite the active penalty on
the plant output. Note that the velocity that best balances the penalty and
the output error might even be greater than the constrained maximum
velocity of 71 miles per hour.

The barrier function method also balances constraints against each other.
Consider a situation where you specify a maximum constraint on both the
plant output and the control action of a controller. The penalty you specify
for y,,., 1s relative to the penalty you specify for u,,,,. If you specify a larger
penalty for y,,,, than for u,,,,, the MPC algorithm prioritizes the plant
output constraint above the control action constraint. Therefore, in a
situation where both penalties are active, the MPC algorithm attempts to
minimize the penalty on y,,, before minimizing the penalty on u,,,,. If you
also specify an output error weighting larger than either constraint penalty,
the MPC algorithm prioritizes minimizing the output error above
minimizing either constraint penalty.

The barrier function method is useful when you need to prioritize the
constraints on different parameters in order to reflect a more realistic
system. However, tuning all the necessary constraints, penalties, and
tolerances for the barrier function can become complicated. To reduce this
complexity, use the dual optimization method instead. Refer to the Dual
Optimization Method section of this chapter for more information about the
dual optimization method.

Refer to the CDEx MPC with Barrier Constraints VI, located in the
labview\examples\Control and Simulation\Control
Design\MPC directory, for an example of using the barrier function
method to set constraints for a controller. Refer to the CDEx MPC Dual vs
Barrier Constraints VI in this same directory for a comparison of the dual
optimization and barrier function methods.
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Specifying Input Setpoint, Output Setpoint, and
Disturbance Profiles

MPC controllers operate by comparing plant input and plant output values
to setpoint profiles. These setpoint profiles contain predicted values of the
control action and plant output setpoints at certain points in time. You send
these profiles to the MPC controller, which calculates error by comparing
the predicted plant inputs and outputs to the setpoint profiles. The MPC
controller then attempts to reduce this error by minimizing a cost function
that takes this error into account. Refer to the Specifying the Cost Function
section of this chapter for information about the cost function the MPC
controller attempts to minimize. If you know how disturbances affect the
plant outputs and/or states, you also can provide future profiles of these
disturbances to the MPC controller.

The Control Design and Simulation Module supports creating and using an
MPC controller for multiple-input multiple-output (MIMO) plants.
However, the profiles are one-dimensional arrays, or vectors. If you are
providing profile information for a MIMO plant, the profile vectors are
interleaved.

For example, consider a plant with two inputs. The first element of the input
setpoint profile corresponds to the first input at the first sample time. The
second element of this profile corresponds to the second input at the first
sample time. The third element of this profile corresponds to the first input
at the second sample time. The fourth element of this profile corresponds
to the second input at the second sample time, and so on. The output
setpoint and disturbance profiles also are interleaved.

You can use the Interleave 1D Arrays function to interleave setpoint or
disturbance profiles for a MIMO plant. You can use the Decimate 1D Array
function to divide an interleaved array into the component profiles.
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Implementing the MPC Controller

After you create the MPC controller, you then can implement this
controller either in a simulation or a real-world scenario. You implement
the controller by using the CD Implement MPC Controller VI with a Timed
Loop or Simulation Loop. The examples in this chapter use a Simulation
Loop.

E Note Refer to Chapter 17, Deploying a Controller to a Real-Time Target, for more
information about implementing controllers in real-world scenarios.

You provide the following information to this VI.

*  Profiles of the input setpoints, output setpoints, and/or disturbances.
Refer to the Defining the Prediction and Control Horizons section of
this chapter for information about these profiles.

e The measured output of the plant.

The CD Implement MPC Controller VI then returns the following
information:

*  The control action necessary to react to the change in the output
setpoint profile.

e The predicted output of the plant along the prediction horizon.
e The rate of change in control action.
You can provide setpoint and disturbance profile information either in

advance of controller execution or dynamically as the controller executes.
The following sections describe each of these methods.

@ Note The examples in the following sections use the Simulation Loop. Refer to the
labview\examples\Control and Simulation\Control Design\MPC directory
for examples that use the Timed Loop.

Providing Setpoint and Disturbance Profiles to the MPC Controller

Control Design User Manual

Providing information in advance is useful if you already know the
disturbances that affect the system or if you know certain setpoints for the
controller. You might have this information, for example, if you are
performing an offline simulation of the MPC controller. To provide these
values to the MPC controller, use the CD Update MPC Window VI. This
VI provides the appropriate portion, or window, of the setpoint or
disturbance profile of a signal from time k to time k + Prediction Horizon.
You then can wire the Predicted Profile Window output of this VI to the
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CD Implement MPC Controller VI for the current sample time k. The size
of the window is based on the length of the prediction horizon.

At the next sample time k + 1, the prediction horizon moves forward one
value. The CD Update MPC Window VI then sends the next window to the
CD Implement MPC Controller VI.

Figure 18-4 shows how you use these VIs together.
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Figure 18-4. Providing Profile Information in Advance

The example in Figure 18-4 executes the following steps:

1.

This example sends an Initial Profile Window and an array of
Predicted Values to the Single instance of the CD Update MPC
Window VI. The Initial Profile Window specifies the profile of the
signal for a time period equivalent to the Prediction Horizon prior to
the current time. The Predicted Values input specifies the interleaved
values of the setpoint profile from time & to time k + Prediction
Horizon.

At each sample time k, the CD Update MPC Window VI parses the
Predicted Values and sends the Predicted Profile Window to the
Output Reference Window input of the CD Implement MPC
Controller VL.

The size of the window is based on the length of the prediction horizon.
You specify these lengths when you create the MPC controller.

@ Note This example provides a setpoint profile of plant output values to the MPC
controller. If you also want to provide a disturbance profile or a different setpoint profile to
the MPC controller, use a separate instance of the CD Update MPC Window VI for each
profile and wire the appropriate output of each instance to the corresponding input of the
CD Implement MPC Controller VI.

© National Instruments Corporation
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3. The CD Implement MPC Controller VI predicts the output of the plant
and sends the necessary control action u(k) to the input u(k) input of
the Discrete State-Space function, which represents the plant.

4. The Discrete State-Space function returns the actual output y(k) of the
plant and sends these values to the Measured Output y(k) input of
the CD Implement MPC Controller VI. This VI uses y(k) to estimate
the model states and account for any integral action. Accounting for
integral action involves calculating the error, which is the difference
between y(k) and the output setpoint.

The CD Implement MPC Controller VI uses the estimated model
states, calculated error, and output of the internal controller model to
adjust the control action for the next time step.

5. Because u(k) and y(k) consist of interleaved values, the Index Array
functions separate the interleaved arrays into their component profiles.
After the For Loop finishes executing, this example returns Control
Action Response and Closed Loop Response arrays so you can plot
the data on XY graphs.

At the next sample time k + 1, the CD Update MPC Window VI accepts a
new element corresponding to the setpoint at time k + Prediction
Horizon + 1 from the Predicted Values control. This example then
executes steps 2-5 again. The repetition occurs until the For Loop stops
executing.

@ Note Right-click the VI or function and select Help for detailed information about these
VIs and functions.

Updating Setpoint and Disturbance Information Dynamically

When implementing an MPC controller on a real-time (RT) target, you
typically cannot provide setpoint and/or disturbance profile information in
advance. To address this issue, you can configure the MPC controller to
receive profile information dynamically.

@ Note Updating profile information dynamically also is useful when the MPC controller
might execute for such a long time that a computer cannot handle millions of output
setpoints at once.

Control Design User Manual

To accomplish this task, you use either a LabVIEW queue or a real-time RT
FIFO. The Control Design and Simulation Module provides four VIs for

this purpose: one VI each that creates, reads from, writes to, and deletes the
queue/FIFO. You write to the queue/FIFO in a While Loop that executes in
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parallel with the loop in which the MPC controller reads from the
queue/FIFO. This parallelism enables the MPC controller to receive new
profile information at any time during execution.

Note This VI creates a queue when running on a Windows computer. This VI creates an
RT FIFO when running on a real-time (RT) target.

Use the CD Write MPC FIFO to construct a profile dynamically. Use the
CD Read MPC FIFO to send portions, or windows, of the profile to the
CD Implement MPC Controller VI.

Figure 18-5 shows how you use these VIs together.
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Figure 18-5. Updating Profile Information Dynamically

Note The example in Figure 18-5 is similar to the CDEx MPC with RT
FIFO VI, located in the labview\examples\Control and Simulation\Control
Design\MPC directory.

The example in Figure 18-5 executes the following steps:

1. The CD Create MPC FIFO VI creates a FIFO for the specified MPC
Controller. The Signal Type parameter specifies that this FIFO
contains information about the output setpoint profile. You also can
create a FIFO for input setpoint and disturbance profiles.

2. The CD Write MPC FIFO VI writes values of the Interleaved Profile
to the FIFO. This profile contains output setpoint values you specify.

3. The CD Read MPC FIFO VI reads values from the FIFO, removes
these values from the FIFO, and sends these values to the Output
Reference Window input of the CD Implement MPC Controller VI.
This step occurs in parallel with step 2.
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4. The CD Implement MPC Controller VI predicts the output of the plant
and sends the necessary control action u(k) to the input input of the
Discrete State-Space function, which represents the plant.

5. The Discrete State-Space function returns the actual output y(k) of the
plant and sends these values to the Measured Output y(k) input of the
CD Implement MPC Controller VI. This function also sends the
measured plant states x(k) to this VI. This VI then uses the difference
between the plant output and the output setpoint to adjust the control
action for the next time step.

6. The Collector function builds an array of control action and output
values during the entire simulation. After the Simulation Loop finishes
executing, this function returns the array so you can plot the data on an
XY graph.

7. At the final sample time of the simulation, the CD Delete MPC FIFO
VI deletes the FIFO.

@ Tip Notice that the CD Delete MPC FIFO VI has an F in the top-right corner of the VI
icon. This letter indicates that the VI is configured with Final step only behavior. You
configure this behavior in the SubVI Node Setup dialog box, available by right-clicking a
subVIicon on the block diagram and selecting SubVI Node Setup from the shortcut menu.

Modifying an MPC Controller at Run Time

Control Design User Manual

During the implementation of an MPC controller, the model might become
out of date, or the objectives of the controller might change. For example,
some parameters might become more costly than others, and you therefore
must update the cost weightings of those parameters accordingly. You also
might receive data during implementation that can help you improve your
understanding of the plant model or of other parameters related to the
controller. If you do not want to stop execution to update the controller with
this data, you can modify the controller at run time instead.

Use the CD Set MPC Controller VI to update an MPC controller at run
time. You can update any aspect of the controller, such as the input model,
the prediction and control horizons, or the parameter constraints. When you
click the Reset? button, the controller updates with the changes that you
specify. You can use the Dual or Barrier instances of the CD Set MPC
Controller VI to update a controller whose constraints are determined using
the dual optimization method or the barrier function method, respectively.
Refer to the Specifying Constraints section of this chapter for information
about each of these methods.
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Figure 18-6 illustrates how to use the CD Create MPC Controller VI and
the CD Set MPC Controller VI to create an MPC controller and allow for
controller updates at run time.
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Figure 18-6. Modifying an MPC Controller at Run Time

In the previous figure, the CD Create MPC Controller VI creates an MPC
controller according to the specified MPC controller parameters, input
model, cost weightings, and parameter constraints. The CD Create MPC
Controller VI passes the created controller to a While Loop containing the
CD Set MPC Controller VI. If you do not click the Reset? button, the CD
Set MPC Controller VI does not modify the controller. If you specify
different parameters for the controller and then click the Reset? button, the
VI updates the controller accordingly and passes the updated information
to a shared variable. Another VI can read this shared variable and
implement the controller.

The VI in Figure 18-6 is similar to the CDEx MPC Basic AirHeater VI
located in the labview\examples\Control and
Simulation\Control Design\MPC directory.
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Technical Support and
Professional Services

Visit the following sections of the award-winning National Instruments
Web site at ni . com for technical support and professional services:

© National Instruments Corporation

Support—Technical support resources at ni . com/support include
the following:

Self-Help Technical Resources—For answers and solutions,
visit ni . com/support for software drivers and updates, a
searchable KnowledgeBase, product manuals, step-by-step
troubleshooting wizards, thousands of example programs,
tutorials, application notes, instrument drivers, and so on.
Registered users also receive access to the NI Discussion Forums
at ni.com/forums. NI Applications Engineers make sure every
question submitted online receives an answer.

Standard Service Program Membership—This program
entitles members to direct access to NI Applications Engineers
via phone and email for one-to-one technical support as well as
exclusive access to on demand training modules via the Services
Resource Center. NI offers complementary membership for a full
year after purchase, after which you may renew to continue your
benefits.

For information about other technical support options in your
area, visit ni . com/services, or contact your local office at
ni.com/contact.

Training and Certification—Visit ni . com/training for
self-paced training, eLearning virtual classrooms, interactive CDs,
and Certification program information. You also can register for
instructor-led, hands-on courses at locations around the world.

System Integration—If you have time constraints, limited in-house
technical resources, or other project challenges, National Instruments
Alliance Partner members can help. To learn more, call your local
NI office or visit ni.com/alliance.
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If you searched ni . com and could not find the answers you need, contact
your local office or NI corporate headquarters. Phone numbers for our
worldwide offices are listed at the front of this manual. You also can visit
the Worldwide Offices section of ni . com/niglobal to access the branch
office Web sites, which provide up-to-date contact information, support
phone numbers, email addresses, and current events.
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